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保証

当社では、本製品において、出荷の日から 1 年間、材料およびその仕上がりについて欠陥がないことを保証します。
この保証期間中に製品に欠陥があることが判明した場合、当社では、当社の裁量に基づき、部品および作業の費
用を請求せずに当該欠陥製品を修理するか、あるいは当該欠陥製品の交換品を提供します。保証時に当社が使用
する部品、モジュール、および交換する製品は、新しいパフォーマンスに適応するために、新品の場合、または再生
品の場合もあります。交換したすべての部品、モジュール、および製品は当社で保有されます。

本保証に基づきサービスをお受けいただくため、お客様には、本保証期間の満了前に当該欠陥を当社に通知して
いただき、サービス実施のための適切な措置を講じていただきます。お客様には、当該欠陥製品を梱包していただ
き、送料前払いにて当社指定のサービス・センターに送付していただきます。本製品がお客様に返送される場合に
おいて、返送先が当該サービス・センターの設置されている国内の場所であるときは、当社は、返送費用を負担し
ます。しかし、他の場所に返送される製品については、すべての送料、関税、税金その他の費用をお客様に負担し
ていただきます。

本保証は、不適切な使用または不適切もしくは不十分な保守および取り扱いにより生じたいかなる欠陥、故障または
損傷にも適用されません。当社は、以下の事項については、本保証に基づきサービスを提供する義務を負いません。
a）当社担当者以外の者による本製品のインストール、修理またはサービスの試行から生じた損傷に対する修理。b）不
適切な使用または互換性のない機器への接続から生じた損傷に対する修理。c）当社製ではないサプライ用品の使用
により生じた損傷または機能不全に対する修理。d）本製品が改造または他の製品と統合された場合において、改造
または統合の影響により当該本製品のサービスの時間または難度が増加したときの当該本製品に対するサービス。

この保証は、明示的または黙示的な他のあらゆる保証の代わりに、製品に関して当社がお客様に対して提供するも
のです。当社およびベンダは、商品性または特定目的に対する適合性についての一切の黙示保証を否認します。
欠陥製品を修理または交換する当社の責任は、本保証の不履行についてお客様に提供される唯一の排他的な法
的救済となります。間接損害、特別損害、付随的損害または派生損害については、当社およびそのベンダは、損害
の実現性を事前に通知されていたか否に拘わらず、一切の責任を負いません。
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安全性に関する重要な情報

このマニュアルには、操作を行うユーザの安全を確保し、製品を安全な状態に保つために順守しなければ
ならない情報および警告が記載されています。

このセクションの最後には、製品の修理を安全に行うために必要な詳細な情報が記載されています(vii ペー
ジ 「安全に保守点検していただくために」 参照)。

安全にご使用いただくために
製品は指定された方法でのみご使用ください。人体への損傷を避け、本製品や本製品に接続されている製
品の破損を防止するために、安全性に関する次の注意事項をよくお読みください。すべての指示事項を注
意深くお読みください。必要なときに参照できるように、説明書を安全な場所に保管しておいてください。

該当する地域および国の安全基準に従ってご使用ください。

本製品を正しく安全にご使用になるには、このマニュアルに記載された注意事項に従うだけでなく、一般に
認められている安全対策を徹底しておく必要があります。

本製品は訓練を受けた専門知識のあるユーザによる使用を想定しています。

製品のカバーを取り外して修理や保守、または調整を実施できるのは、あらゆる危険性を認識した専門的
知識のある適格者のみに限定する必要があります。

使用前に、既知の情報源と十分に照らし合わせて、製品が正しく動作していることを常にチェックしてくだ
さい。

本製品は危険電圧の検出用にはご利用になれません。

危険な通電導体が露出している部分では、感電やアーク・フラッシュによってけがをする恐れがありますの
で、保護具を使用してください。

本製品をご使用の際に、より大きな他のシステムにアクセスしなければならない場合があります。システムの
操作に関する警告や注意事項については、他製品のコンポーネントのマニュアルにある安全に関するセク
ションをお読みください。

本機器をシステムの一部としてご使用になる場合には、そのシステムの構築者が安全性に関する責任を果
たさなければなりません。

火災や人体への損傷を避けるには

適切な電源コードを使用してください: 本製品用に指定され、使用される国で認定された電源コードの
みを使用してください。

他の製品に付属していた電源コードは使用しないでください。

本製品を接地してください: 本製品は、電源コードのグランド線を使用して接地します。感電を避けるた
め、グランド線をアースに接続する必要があります。本製品の入出力端子に接続する前に、本製品が正しく
接地されていることを確認してください。

電源の切断: 電源コードの取り外しによって主電源が遮断されます。スイッチの位置については、使用説
明書を参照してください。電源コードの取り扱いが困難な場所には設置しないでください。必要に応じてす
ぐに電源を遮断できるように、ユーザが常にアクセスできる状態にしておく必要があります。
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接続と切断は正しく行ってください: プローブとテスト・リードが電圧源に接続されている間は接続また
は切断しないでください。

絶縁型の電圧プローブ、テスト・リード、およびアダプタは、製品に付属する製品か、または当社により特別
に指定された製品のみを使用してください。

すべての端子の定格に従ってください: 火災や感電の危険を避けるために、本製品のすべての定格と
マーキングに従ってください。本製品に電源を接続する前に、定格の詳細について、製品マニュアルを参
照してください。測定カテゴリ（CAT）の定格および電圧と電流の定格については、製品、プローブ、または
アクセサリのうちで最も低い定格を超えないように使用してください。1:1 のテスト・リードを使用するときは、
プローブ・チップの電圧が直接製品に伝送されるため注意が必要です。

コモン端子を含むいかなる端子にも、その端子の最大定格を超える電圧をかけないでください。

その端子の定格電圧を超えてコモン端子をフローティングしないでください。

MSO/DPO70K および DPO7K では、製品の測定端子を AC 電源、カテゴリ II、 III、および IV 回路に使用
することはできません。

カバーを外した状態で動作させないでください: カバーやパネルを外した状態やケースを開いたまま
動作させないでください。危険性の高い電圧に接触してしまう可能性があります。

露出した回路への接触は避けてください: 電源が投入されているときに、露出した接続部分やコンポー
ネントに触れないでください。

故障の疑いがあるときは動作させないでください: 本製品に故障の疑いがある場合には、資格のある
サービス担当者に検査を依頼してください。

製品が故障している場合には、使用を停止してください。製品が故障している場合や正常に動作していない
場合には、製品を使用しないでください。安全上の問題が疑われる場合には、電源を切って電源コードを取
り外してください。誤って使用されることがないように、問題のある製品を区別できるようにしておいてください。

使用前に、電圧プローブ、テスト・リード、およびアクセサリに機械的損傷がないかを検査し、故障している
場合には交換してください。金属部が露出していたり、摩耗インジケータが見えているなど、損傷が見られる
プローブまたはテスト・リードは使用しないでください。

使用する前に、製品の外観に変化がないかよく注意してください。ひび割れや欠落した部品がないことを確
認してください。

指定された交換部品のみを使用するようにしてください。

湿気の多いところでは動作させないでください: 機器を寒い場所から暖かい場所に移動する際には、
結露にご注意ください。

爆発性のガスがある場所では使用しないでください:

製品の表面を清潔で乾燥した状態に保ってください: 製品の清掃を開始する前に、入力信号を取り
外してください。

適切に通気してください: 適切な通気が得られるように製品を設置できるように、マニュアルの設置手順
を参照してください。

製品には通気用のスロットや開口部があります。その部分を覆ったり、通気が妨げられることがないようにし
てください。開口部には異物を入れないでください。

安全な作業環境を確保してください: 製品は常にディスプレイやインジケータがよく見える場所に設置
してください。
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キーボードやポインタ、ボタン・パッドを不適切に使用したり、長く押しすぎたりしないでください。キーボード
やポインタの使用を誤ると、大怪我につながる可能性があります。

作業場が該当する人間工学規格を満たしていることを確認してください。ストレスに由来する怪我がないよう
に、人間工学の専門家に助言を求めてください。

製品を持ち上げたり運んだりする作業は慎重に行ってください。本製品には持ち運び用のハンドルが取り
付けられています。

警告： 製品は重量があります。怪我をしたり装置が損傷することがないように、製品を持ち運ぶときには誰
かの手を借りてください。

卓上で機器を持ち上げて設置位置を調整するときには、予備ハンドルを使用してください。機器が落下して
怪我をすることがないように、移動させるときには主要ハンドルを使用してください。

本製品には指定された当社のラック取り付け金具のみを使用してください。

安全に保守点検していただくために
「安全に保守点検していただくために」のセクションには、製品の保守点検を安全に行うために必要な詳細
な情報が記載されています。資格のあるサービス担当者以外は、保守点検手順を実行しないでください。
保守点検を行う前には、この「安全に保守点検していただくために」と「安全にご使用いただくために」を読
んでください。

感電を避けてください: 露出した接続部には触れないでください。

保守点検は単独で行わないでください: 応急処置と救急蘇生ができる人の介在がないかぎり、本製品
の内部点検や調整を行わないでください。

電源を切断してください: 保守点検の際にカバーやパネルを外したり、ケースを開く前に、感電を避ける
ため、製品の電源を切り、電源コードを電源コンセントから抜いてください。

電源オン時の保守点検には十分注意してください: 本製品には、危険な電圧や電流が存在している
可能性があります。保護パネルの取り外し、はんだ付け、コンポーネントの交換をする前に、電源の切断、
バッテリの取り外し（可能な場合）、テスト・リードの切断を行ってください。

修理後の安全確認: 修理を行った後には、常にグランド導通と電源の絶縁耐力を再チェックしてください。
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本マニュアル内の用語
このマニュアルでは次の用語を使用します。

警告： 人体や生命に危害をおよぼすおそれのある状態や行為を示します。

注意： 本製品やその他の接続機器に損害を与えるおそれのある状態や行為を示します。

本製品に使用される記号と用語
本製品では、次の用語を使用します。

DANGER：ただちに人体や生命に危険をおよぼす可能性があることを示します。

WARNING：人体や生命に危険をおよぼす可能性があることを示します。

CAUTION：本製品を含む周辺機器に損傷を与える可能性があることを示します。

製品にこの記号が表記されているときは、マニュアルを参照して、想定される危険性とそれを回
避するために必要な行動について確認してください。（マニュアルでは、この記号はユーザに
定格を示すために使用される場合があります）。

本製品では、次の記号を使用します。
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適合性に関する情報

このセクションでは、本製品が適合している EMC 基準、安全基準、および環境基準について説明します。

EMC 適合性

EC 適合宣言 - EMC

指令 2004/108/EC 電磁環境両立性に適合します。『Official Journal of the European Communities』に記載
の以下の基準に準拠します。

EN 61326-1:2006、EN 61326-2-1:2006: 測定、制御、および実験用途の電子機器を対象とする EMC
基準。 1 2 3

CISPR 11:2003：グループ 1、クラス A、放射および伝導エミッション

IEC 61000-4-2:2001：静電気放電イミュニティ

IEC 61000-4-3:2002：RF 電磁界イミュニティ 4

IEC 61000-4-4:2004：ファスト・トランジェント／バースト・イミュニティ

IEC 61000-4-5:2001：電源サージ・イミュニティ

IEC 61000-4-6:2003：伝導 RF イミュニティ 4

IEC 61000-4-11:2004：電圧低下と遮断イミュニティ

EN 61000-3-2:2006: AC 電源ライン高調波エミッション

EN 61000-3-3:1995: 電圧の変化、変動、およびフリッカ

欧州域内連絡先:
Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom

1 本製品は住居区域以外での使用を目的としたものです。住居区域で使用すると、電磁干渉の原因となることがあります。

2 本製品をテスト対象に接続した状態では、この規格が要求するレベルを超えるエミッションが発生する可能性があります。

3 接続ケーブルを使用する場合は、次の当社部品番号番号製品または同等の低 EMI シールド付きケーブルを使用してく
ださい。 012-0991-01、012-0991-02、または 012-0991-03 GPIB ケーブル、012-1213-00（または CA 部品番号 0294-9）
RS-232 ケーブル、012-1214-00 セントロニクス・ケーブル、LCOM 部品番号 CTL3VGAMM-5 VGA ケーブル。 REF OUT
コネクタには 012-0482-00 ケーブルを使用してください。

4 オシロスコープが継続的に電磁界にさらされている場合の性能基準は次のとおりです。MSO70000C/DX シリーズ、
DPO70000C/DX シリーズ、および DPO7000 シリーズ10mV/div～1V/div：0.4 div 以下の波形変位または 0.8 div 以下の
p-p ノイズの増加。MSO5000B シリーズおよび DPO5000B シリーズ:4.0 div 以下の波形変位または 8.0 div 以下の p-p ノ
イズの増加。

オーストラリア／ニュージーランド適合宣言 - EMC

ACMA に従い、次の規格に準拠することで Radiocommunications Act の EMC 条項に適合しています。
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CISPR 11:2003：グループ 1、クラス A、放射および伝導エミッション（EN61326-1:2006 および EN61326-
2-1:2006 に準拠）

オーストラリア／ニュージーランドの連絡先:

Baker & McKenzie
Level 27, AMP Centre
50 Bridge Street
Sydney NSW 2000, Australia

安全性
このセクションでは、製品が適合している安全規格およびその他の基準について説明します。

EC 適合宣言 - 低電圧指令

『Official Journal of the European Union』にリストされている次の仕様に準拠します。

低電圧指令 2006/95/EC

EN 61010-1：測定、制御、および研究用途の電子装置に対する安全基準、第 1 部：一般要件

EN 61010-2-030：測定、制御、および研究用途の電子装置に対する安全基準、第 2-030 部：試験およ
び測定回路の特定要求事項

米国の国家認定試験機関のリスト

UL 61010-1：測定、制御、および研究用途の電子装置に対する安全基準、第 1 部：一般要件

UL 61010-2-030：測定、制御、および研究用途の電子装置に対する安全基準、第 2-030 部：試験およ
び測定回路の特定要求事項

カナダ認証

CAN/CSA-C22.2 No. 61010-1：測定、制御、および実験用途の電子装置に対する安全基準 – 第 1 部:
一般要件

CAN/CSA-C22.2 No. 61010-2-030：測定、制御、および実験用途の電子装置に対する安全基準 – 第
2-030 部:試験および測定回路の特定要求事項

その他の適合性

IEC 61010-1：測定、制御、および研究用途の電子装置に対する安全基準、第 1 部：一般要件

IEC 61010-2-030：測定、制御、および研究用途の電子装置に対する安全基準、第 2-030 部：試験およ
び測定回路の特定要求事項

機器の種類

テスト機器および計測機器
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感電保護クラス

クラス 1 - アース付き製品。

汚染度について

製品内およびその周辺で発生する可能性がある汚染度の測定単位です。通常、製品の内部環境は外部
環境と同じ規定が適用されるものとみなされます。製品は、その製品に指定されている環境でのみ使用して
ください。

汚染度 1：汚染なし、または乾燥した非導電性の汚染のみが発生します。このカテゴリの製品は、通常、
被包性、密封性のあるものか、クリーン・ルームでの使用を想定したものです。

汚染度 2：通常、乾燥した非導電性の汚染のみが発生します。ただし、結露によって一時的な導電性が
発生することもまれにあります。これは、標準的なオフィスや家庭内の環境に相当します。一時的な結露
は製品非動作時のみ発生します。

汚染度 3：伝導性のある汚染、または通常は乾燥して導電性を持たないが結露時に導電性を帯びる汚
染。これらは、温度、湿度のいずれも管理されていない屋内環境に相当します。日光や雨、風には直接
当たることがないように保護されています。

汚染度 4：導電性のある塵、雨、または雪により持続的に導電性が生じている汚染。これは一般的な屋
外環境に相当します。

汚染度

汚染度 2（IEC 61010-1 の定義による）。乾燥した屋内でのみ使用できます。

IP 定格

IP20 (IEC 60529 で定義)。

測定および過電圧カテゴリについて

本製品の測定端子は、測定する電源電圧について次の 1 つまたは複数のカテゴリに評価されます。

カテゴリ II：固定設備の屋内配線に直接接続される回路（壁コンセントおよび類似する設備）。

カテゴリ III：屋内配線および配電系統。

カテゴリ IV：建物に電気を供給する起点部分。

注： 過電圧カテゴリ定格に該当するのは主電源回路のみです。測定カテゴリ定格に該当するのは測定回
路のみです。製品内部のその他の回路にはいずれの定格も該当しません。

主電源過電圧カテゴリ定格

過電圧カテゴリ II（IEC 61010-1 の定義による）。
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環境条件について
このセクションでは本製品が環境におよぼす影響について説明します。

使用済み製品の処理方法

機器またはコンポーネントをリサイクルする際には、次のガイドラインを順守してください。

機器のリサイクル: 本製品の製造には天然資源が使用されています。この製品には、環境または人体
に有害となる可能性のある物質が含まれているため、製品を廃棄する際には適切に処理する必要がありま
す。有害物質の放出を防ぎ、天然資源の使用を減らすため、本製品の部材の再利用とリサイクルの徹底に
ご協力ください。

このマークは、本製品が WEEE（廃棄電気・電子機器）およびバッテリに関する指令 2002/96/EC
および 2006/66/EC に基づき、EU の諸要件に準拠していることを示しています。リサイクル方法
については、当社の Web サイト（www.tektronix.com）のサービス・セクションを参照してください。

水銀に関するお知らせ: 本製品に使用されている LCD バックライト・ランプには、水銀が含まれていま
す。廃棄にあたっては、環境への配慮が必要です。廃棄およびリサイクルに関しては、お住まいの地域の
所轄官庁にお尋ねください 1。

1 この通知は MSO5000B シリーズおよび DPO5000B シリーズの機器には適用されません。MSO5000B シリーズおよび
DPO5000B シリーズの機器は LED バックライトを使用しているため、水銀は含まれていません。

過塩素酸塩の取り扱い: 本製品には CR リチウム電池が搭載されています。CR リチウム電池はカリフォ
ルニア州法により過塩素酸塩材として規定され、特別な取り扱いが求められています。詳細については、
www.dtsc.ca.gov/hazardouswaste/perchlorate を参照してください。

有害物質に関する規制

この製品は産業用監視および制御装置に分類されており、2017 年 7 月 22 日までは、改訂 RoHS Directive
2011/65/EU による含有物質制限への準拠は求められていません。
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このマニュアルでは、MSO/DPO7000DX シリーズ、MSO/DPO70000C シリーズ、DPO7000C シリーズ、およ
び MSO/DPO5000B シリーズの設置および操作について説明します。このマニュアルでは基本的な操作と
概念について説明しています。詳細については、お使いの機器のオンライン・ヘルプを参照してください。
このマニュアルは、次の機器を対象としています。

MSO73304DX 型および DPO73304DX 型

MSO72504DX 型および DPO72504DX 型

MSO72304DX 型および DPO72304DX 型

MSO72004C 型および DPO72004C 型

MSO71604C 型および DPO71604C 型

MSO71254C 型および DPO71254C 型

MSO70804C 型および DPO70804C 型

MSO70604C 型および DPO70604C 型

MSO70404C 型および DPO70404C 型

DPO7354C 型

DPO7254C 型

DPO7104C 型

DPO7054C 型

MSO5204B 型および DPO5204B 型

MSO5104B 型および DPO5104B 型

MSO5054B 型および DPO5054B 型

MSO5034B 型および DPO5034B 型

主要な機能
MSO70000C/DX シリーズ、DPO70000DX シリーズ、DPO70000C シリーズ、DPO7000C シリーズ、MSO5000B
シリーズ、および DPO5000B シリーズは、電子設計の検証、デバッグ、および評価に役立ちます。 主な特
長は次のとおりです。

アナログの 4 チャンネルにおいて、33 GHz の帯域幅および 50 GS/s のリアルタイム・サンプリングレー
ト、アナログの 2 チャンネルにおいて 100 GS/s のリアルタイム・サンプリング・レートを実現（MSO73304DX
型および DPO73304DX 型）

アナログの 4 チャンネルにおいて、25 GHz の帯域幅および 50 GS/s のリアルタイム・サンプリングレー
ト、アナログの 2 チャンネルにおいて 100 GS/s のリアルタイム・サンプリング・レートを実現（MSO72504DX
型および DPO72504DX 型）

アナログの 4 チャンネルにおいて、23 GHz の帯域幅および 50 GS/s のリアルタイム・サンプリングレー
ト、アナログの 2 チャンネルにおいて 100 GS/s のリアルタイム・サンプリング・レートを実現（MSO72304DX
型および DPO72304DX 型）

MSO/DPO70000DX、MSO/DPO70000C、DPO7000C、および MSO/DPO5000B シリーズ・ユーザ・マニュアル xiii
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アナログの 4 チャンネルにおいて、20 GHz の帯域幅および 50 GS/s のリアルタイム・サンプリングレー
ト、アナログの 2 チャンネルにおいて 100 GS/s のリアルタイム・サンプリング・レートを実現（MSO72004C
型および DPO72004C 型）

アナログの 4 チャンネルにおいて、16 GHz の帯域幅および 50 GS/s のリアルタイム・サンプリングレー
ト、アナログの 2 チャンネルにおいて 100 GS/s のリアルタイム・サンプリング・レートを実現（MSO71604C
型および DPO71604C 型）

アナログの 4 チャンネルにおいて、12.5 GHz の帯域幅および 50 GS/s のリアルタイム・サンプリングレー
ト、アナログの 2 チャンネルにおいて 100 GS/s のリアルタイム・サンプリング・レートを実現（MSO71254C
型および DPO71254C 型）

アナログの 4 チャンネルにおいて、8 GHz の帯域幅と 25 GS/s のリアルタイム・サンプリング・レートを実
現（MSO70804C 型および、DPO70804C 型）

アナログの 4 チャンネルにおいて、6 GHz の帯域幅と 25 GS/s のリアルタイム・サンプリング・レートを実
現（MSO70604C 型および、DPO70604C 型）

アナログの 4 チャンネルにおいて、4 GHz の帯域幅と 25 GS/s のリアルタイム・サンプリング・レートを実
現（MSO70404C 型および、DPO70404C 型）

すべてのチャンネルにおいて、3.5 GHz の帯域幅および 10 GS/s のリアルタイム･サンプリング･レート、
1 チャンネルにおいて 40 GS/s のリアルタイム･サンプリング･レートを実現（DPO7354C 型）

すべてのチャンネルにおいて、2.5 GHz の帯域幅および 10 GS/s のリアルタイム･サンプリング･レート、
1 チャンネルにおいて 40 GS/s のリアルタイム･サンプリング･レートを実現（DPO7254C 型）

すべてのチャンネルにおいて、1 GHz の帯域幅および 5 GS/s（オプションで 10 GS/s）のリアルタイム･
サンプリング･レート、1 チャンネルにおいて 20 GS/s（オプションで 40 GS/s）のリアルタイム･サンプリン
グ･レートを実現（DPO7104C 型）

すべてのチャンネルにおいて、500 MHz の帯域幅および 5 GS/s のリアルタイム･サンプリング･レート、1
チャンネルにおいて 20 GS/s のリアルタイム･サンプリング･レートを実現（DPO7054C 型）

アナログの 2 チャンネルにおいて、2 GHz の帯域幅と 10 GS/s のリアルタイム・サンプリング・レートを実
現（MSO5204B 型および DPO5204B 型）

アナログの 2 チャンネルにおいて、1 GHz の帯域幅と 10 GS/s のリアルタイム・サンプリング・レートを実
現（MSO5104B 型および DPO5104B 型）

すべてのアナログ・チャンネルにおいて、500 MHz の帯域幅と 5 GS/s のリアルタイム・サンプリング・レー
トを実現（MSO5054B 型および DPO5054B 型）

すべてのアナログ・チャンネルにおいて、350 MHz の帯域幅と 5 GS/s のリアルタイム・サンプリング・レー
トを実現（MSO5034B 型および DPO5034B 型）

拡張帯域幅機能を有効にすると、帯域幅を広げて、パスバンドを平坦化するデジタル信号プロセッサ
（DSP）フィルタが適用されます。拡張帯域幅では、最高のサンプル・レートにおいて、有効化されたチャ
ンネル間の応答が一致します。S/N 比を改善するために、帯域幅を 500 MHz までに制限することがで
きます。高性能のプローブとチップを使用すると、拡張帯域幅はプローブ・チップまで有効となります。

最大 500,000,000 サンプルのレコード長（モデルとオプションにより異なります）

最大 1.0% の DC 垂直ゲイン確度（モデルに応じて異なります）

アナログ入力 4 チャンネル（ハイレゾ・モードでない場合は、各チャンネル 8 ビットの分解能）、補助トリ
ガ入出力

MSO70000C/DX シリーズおよび MSO5000B シリーズの機器では 16 デジタル・チャンネルが、さらに
MSO70000C/DX シリーズでは 1 チャンネルのクロック・チャンネルが使用可能
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iCapture により、MSO70000C/DX シリーズ機器のデジタル・チャンネルのアナログ特性を解析可能

サンプル、エンベロープ、ピーク検出、ハイレゾ、波形データベース、アベレージ、および高速アクイジ
ションの各アクイジション・モード

広範な GPIB コマンド・セットとメッセージ・ベースのインタフェースによるフル・プログラミング機能

MSO70000C/DX シリーズ、DPO70000C/DX シリーズ、および DPO7000C シリーズでは、フレキシブル
な A/B トリガ・イベントおよびロジック・クオリファイされたトリガによる Pinpoint トリガが可能

MSO5000B シリーズおよび DPO5000B シリーズは各種トリガを完備

選択可能なトリガ位置修正機能によってトリガをより正確に指定し、ジッタを減らすことも可能

モデルまたはオプションによっては、業界標準のシリアル・トリガ、シリアル・パターン・トリガ、およびパ
ターン・ロック・トリガも使用可能

MSO70000C/DX シリーズおよび MSO5000B シリーズではデジタル・チャンネルのトリガ

ビジュアル・トリガ（ディスプレイに表示される波形形状に基づいてトリガする方式）、一部のモデルでは
オプション

強力な測定機能（ヒストグラム、自動測定、アイ・パターン測定、および測定統計）を内蔵

数学的に波形を結合し、データ解析作業をサポートする波形を作成。演算式では、任意のフィルタが使
用できます。スペクトラム解析を使用すると、周波数領域で波形を解析できます。

大型 12.1 インチ（307.3 mm）の高解像度 XGA カラー・ディスプレイ（MSO5000B および DPO5000B シ
リーズでは 10.4 インチ（264 mm））に、波形データのサンプル密度を色階調で表示可能。 垂直／水平
方向とも 10 目盛表示。

MSO5000B シリーズと DPO5000B シリーズでは、レコード長の長いデータにズームとパン、再生と停止、
検索とマークを備えた Wave Inspector コントロールを使用可能

MSO5000B シリーズは MagniVu 60.6 ps 分解能の高速デジタル・サンプリング・レートをサポート

同時に最高 4 箇所までのズーム領域の表示と比較が可能な MultiView Zoom。最大 4 箇所のズーム領
域を固定したり、手動または自動でスクロールしたりできます。ズーム・ウィンドウ内で波形表示をコント
ロールすることもできます。

波形上で注目すべきイベントを自動的に検索してマーク

DDR メモリ・テクノロジ解析オプションを使用した自動 DDR 解析

カスタマイズ可能な MyScope コントロール・ウィンドウ

水平軸スケールとは別に、サンプル・レートとレコード長をコントロール可能

直感的なグラフィック・ユーザ・インタフェース（UI）および内蔵されている、画面上で使用可能なオンラ
イン・ヘルプ

内部リムーバブル・ディスク・ストレージ

さまざまなプロービング・ソリューション

MSO/DPO70000DX、MSO/DPO70000C、DPO7000C、および MSO/DPO5000B シリーズ・ユーザ・マニュアル xv



まえがき

マニュアル
この製品に関する使用可能な各種マニュアルの参照先は次の通りです。

参照する項目 使用するマニュアル

取付け、操作（概要） ユーザ・マニュアル。操作情報の概要を提供します。

詳細な操作とユーザ・インタフェースに
関するヘルプ

オンライン・ヘルプ。機器の機能を使用する際の、詳細な手順に
ついて説明します。画面上のコントロールと要素に関する情報に
ついては、Help ボタンまたは Help メニューからオンライン・ヘル
プにアクセスします。 (28 ページ 「オンライン・ヘルプへのアクセ
ス」 参照)。

プログラマ用のコマンド プログラマ・ガイド（ドキュメンテーション・ブラウザ・ディスクまたは
www.tektronix.com/manuals からオンラインで入手可能）。GPIB コ
マンドの構文を記載。

サービス情報 サービス・マニュアル（ドキュメンテーション・ブラウザ・ディスクに搭
載。www.tektronix.com/manuals からオンラインでも入手可能）。

解析ツールと接続ツール OpenChoice ソリューション入門マニュアル。機器に備えられてい
るさまざまな接続と解析のツールについて説明します。

このマニュアルで使用される表記規則
本マニュアルでは、次のアイコンを使用しています。

順番に行う
手順

前面パネル
の電源

電源の接続 ネットワーク PS2 SVGA USB
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機器の設置

機器を開梱し、スタンダード・アクセサリとして記載されているすべての付属品が含まれていることを確認して
ください。推奨アクセサリ、プローブ、機器のオプション、およびアップグレードについては、オンライン・ヘル
プに記載されています。最新の情報については、当社のホームページ（www.tektronix.com）をご覧ください。

スタンダード・アクセサリ

アクセサリ 当社部品番号

MSO70000C/DX シリーズ、DPO70000C/DX シリーズ、DPO7000C
シリーズ、MSO5000B シリーズ、および DPO5000B シリーズ、デジ
タル・フォスファ・オシロスコープ・ユーザ・マニュアル

071-2980-xx

高性能オシロスコープのベスト・プラクティス・ユーザ・マニュア
ル、MSO70000C/DX シリーズ、DPO70000C/DX シリーズ、および
DPO7000C シリーズ

071-2989-xx

オンライン・ヘルプ（製品ソフトウェアの一部） —

性能検査（ドキュメンテーション・ブラウザ・ディスクに搭載） 077-0063-xx

プログラマ・オンライン・ガイド（ドキュメンテーション・ブラウザ・ディ
スクに搭載）

077-0010-xx

NIST、Z540-1、および ISO9000 の校正証明書 —

TekConnect アダプタ 1 個、MSO/DPO70000C/DX モデルのみ TCA-BNC

TekConnect アダプタ 4 個、MSO/DPO70000C モデルのみ TCA-292MM

TekConnect ア ダプ タ 4 個 、 MSO/DPO73304DX モデル 、
MSO/DPO72504DX モデル、および MSO/DPO72304DX モデル
のみ

TCA-292D

チャンネル当たり受動プローブ 1 本、DPO7354C 型、DPO7254C
型、DPO7104C 型、および DPO7054C 型

P6139B

16 チャンネル・デジタル・プローブ 1 本（アクセサリ・キット付き）、
MSO5000B モデルのみ

P6616

チャンネル当たり受動プローブ 1 本、MSO5204B 型、MSO5104B
型、DPO5204B 型、および DPO5104B 型

TPP1000

チャンネル当たり受動プローブ 1 本、MSO5054B 型、MSO5034B
型、DPO5054B 型、および DPO5034B 型

TPP0500/B

タッチスクリーン・スタイラス、MSO5000B シリーズおよび DPO5000B
シリーズ

119-6107-xx

キーボード、MSO/DPO70000C/DX モデルのみ 119-7083-xx

マウス（オプティカル） 119-7054-xx

DVI-VGA 変換アダプタ、MSO70000C シリーズ、DPO70000C シ
リーズ、および DPO7000C シリーズ

887–4187–00

フロント・カバー、MSO5000B シリーズおよび DPO5000B シリーズ

上記以外のモデル

200-5130-xx

200-4963-xx

リスト・ストラップ、MSO/DPO70000C/DX モデルのみ 006-3415-05
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アクセサリ 当社部品番号

アクセサリ・ポーチ

MSO/DPO70000C/DX モデル

DPO7000C モデル

MSO5000B モデルおよび DPO5000B モデル

016-1441-xx

016-1966-xx

016-2029-xx

17 チャンネル・デジタル・プローブ 1 本（アクセサリ・キット付き）、
MSO70000DX モデルのみ

P6717A 型

アクセサリ 当社部品番号

次のいずれか MSO5000B
モ デ ル お よ
び DPO5000
B モデル

DPO7000C
モデル

MSO70000C/
DX モデルお
よび DPO700
00C/DX モデ
ル

北米（オプション A0） 161-0348-00 161-
0104-00

161-0213-00

ユニバーサル・ユーロ（オプション A1） 161-0343-00 161-
0104-06

161-0209-00

英国（オプション A2） 161-0344-00 161-
0104-07

161-0210-00

オーストラリア（オプション A3） 161-0346-00 161-
0104-14

161-0211-01

北米 240 V（オプション A4） — 161-
0104-08

—

スイス（オプション A5） 161-0347-00 161-
0167-00

161-0212-00

日本（オプション A6) 161-0342-00 161-
A005-00

161-0213-00

注意 : 添付さ
れた電源コー
ドセットは本機
以外の製品に
は転用しない
で下さい。

中国（オプション A10） 161-0341-00 161-
0306-00

161-0352-00

インド（オプション A11） 161-0349-00 161-
0324-00

161-0325-00

ブラジル（オプション A12） 161-0356-00 161-
0356-00

161-0358-00

電源コー
ド

電源コードまたは AC アダプタなし（オプ
ション A99）

— — —
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動作の要件

MSO/DPO70000DX シリーズ、MSO/DPO70000C シリーズ、および DPO7000C シリーズ

1. カートまたはベンチに機器を設置し
ます。機器は底部または後部の脚
を下にして設置します。オプション
のラック・マウント・キットが使用でき
ます。次のスペース要件および寸
法に従ってください。

DPO7000C モデル: MSO/DPO70000C/DX モデ
ル:

上部： 0 mm（0 インチ） 0 mm（0 インチ）

左側および右側： 右側面 0 mm（0 インチ）左側
面 76 mm（3 インチ）

76 mm（3 インチ）

底部： 脚が取り付けられていて、フ
リップ・スタンドを下げている場
合は 0 mm（0 インチ）

脚が取り付けられていて、フ
リップ・スタンドを下げている場
合は 0 mm（0 インチ）

後部： 後部の脚が取り付けられてい
る場合は 0 mm（0 インチ)

後部の脚が取り付けられてい
る場合は 0 mm（0 インチ)

2. 幅： 456 mm（17.96 インチ） 451 mm（17.75 インチ）

3. 高さ： 277 mm（10.9 インチ） 292 mm（11.48 インチ）

4. 装置を操作する前に、周囲温度を
確認してください。

5 ℃ ～ +45 ℃（+41 ℉ ～
+113 ℉）

5 ℃ ～ +45 ℃（+41 ℉ ～
+113 ℉）

5. 動作湿度を確認してください。 相対湿度 8 ～ 80%（+45 ℃
（+113 ℉）以下で最高湿球温
度 +29 ℃（+84 ℉）、結露なし）

+45 ℃（+113 ℉）で相対湿度の
上限が 30% に低下

相対湿度 8% ～ 80% 、 最高
+32 ℃ (+90 ℉)

相対湿度 5 ～ 45%（+32 ℃
(+90 ﾟF) から最高 +45 ℃ (+113
ﾟF)、結露なし）、最高湿球温度
+29.4 ℃ (+85 ﾟF) (相対湿度は
+45 ℃ (+113 ﾟF) で 32% に低
下）

6. 動作高度を確認してください。 DPO7000C モデル：3,000 m
(9,843 フィート)

MSO/DPO70000C/DX モ デ
ル:3,000 m (9,843 フィート)、
高度 1500 メートル (4921.25
フィート) を超えた場合、最
高動作温度は 300 メートル
(984.25 フィート) につき 1 ℃
の割合で低下
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機器の設置

7. 最大入力電圧、DPO7000C モデル:

50 Ω

1 MΩ

5 VRMS、インパルスを含まないこと、ピーク ≤ ±24 V において

150 V、200 KHz を超える帯域では 20 dB/decade の割合で 9
VRMS まで低下。BNC 端子における最大入力電圧（中心導体とグ
ランド間）は 400 V ピーク。RMS 電圧は、DC を含む任意波形に
対して <150 V に制限される。ピークが 150 V を超える場合、イ
ンパルスの最大パルス幅は 50 μs。例：ピークが 0 ～ 400 V で
は、矩形波、デューティ・ファクタは 14%。最大過渡耐電圧は ±
800 V ピーク。

最大入力電圧、4 GHz ～ 20 GHz のモ
デル：

50 Ω <1V/FS の場合は <1 VRMS、≥1 V/FS の場合は < 5.5 VRMS。

最大入力電圧、>20 GHz モデル：

50 Ω ≤1.2 V/FS の場合:

±1.5 V、ターミネーション・バイアスを基準として (最大 30 mA)。
±5 V、絶対最大入力。

>1.2 V/FS の場合:

25 ℃で 10 V、45 ℃では 8.4 V に低下 (アッテネータにより
制限)。

ロジック・プローブの最大非破壊入力
電圧、MSO70000C/DX シリーズ：

±15 V

注意： 正しく冷却するために、オシロスコープの下側と側面には障害物を置かないでください。

MSO5000B シリーズおよび DPO5000B シリーズ

1. カートまたはベンチに機器を設置し
ます。機器は底部または後部の脚
を下にして設置します。オプション
のラック・マウント・キットが使用でき
ます。次のスペース要件および寸
法に従ってください。

後部： 50.8 mm（2 インチ）

左側： 50.8 mm（2 インチ）

2. 幅： 439 mm（17.3 インチ）

3. 高さ： 233 mm（9.2 インチ）、脚を含む

272 mm（10.7 インチ）垂直ハンドルおよび脚を含む

4. 周囲温度： 5 ～ +50 ℃ （+41 ℉ ～ +131 ℉）
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機器の設置

5. 動作湿度： 高温：40 ℃～ 50 ℃（104 ﾟF ～ 122 ﾟF）、相対湿度 10% ～ 60%

低温：0 ℃～ 40 ℃（32 ﾟF ～ 104 ﾟF）、相対湿度 10% ～ 90%

6. 動作高度： 3,000 m（9,843 フィート）

7. 最大入力電圧：

50 Ω 入力インピーダンス

1 MΩ 入力インピーダンス

5 VRMS、ピーク電圧 ≤±20 V (DF ≤6.25%)

300 VRMS、CAT II、BNC 端子でのピーク電圧 ±425 V

<100 mV/div では、100 kHz を超える帯域において 1 MHz
で 30 VRMS まで 20 dB/decade、1 MHz を超える帯域では
10 dB/decade の割合で低下。

<100 mV/div では、3 MHz を超える帯域において 30 MHz
で 30 VRMS まで 20 dB/decade、30 MHz を超える帯域では
10 dB/decade の割合で低下。

ロジック・プローブの最大非破壊入力
電圧：

±42 V

注意： 適切な冷却のために、オシロスコープの背面と左側には障害物がないようにしてください。

ESD の防止

注意： 直接静電気放電は機器の入力に損傷を与える可能性があります。次の説明を参照して、この損傷
を回避してください。
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機器の設置

電子機器を扱う場合は常に、静電気放電（ESD）の対策が必要となります。この機器は ESD 保護機構を備え
ていますが、信号入力部に対して大きな静電気放電が直接発生すると、損傷を受ける可能性があります。
機器の損傷を防ぐため、次の説明に従って機器への静電気放電を回避してください。

1. ケーブルおよび TekConnect アダ
プタを着脱するときは、接地された
帯電防止リスト・ストラップをつけて、
自分の体から静電気を放電します。
このため、本機器は前面パネルか
ら接続できるようになっています。

2. ベンチ上で未接続のままになって
いるケーブルが、大きな静電気の発
生原因となることがあります。テスト
で使用する機器または装置にケー
ブルを接続する前に、ケーブルの
中心導体を一瞬接地するか、片端
に 50 Ωターミネーションを接続し
て、すべてのケーブルから静電電
圧を放電してください。

機器の電源をオンにする

電源の要件

電源電圧と周波数 消費電力

MSO70000C/DXシリーズおよびDPO70000C/DXシ
リーズ:

100 ～ 240 VRMS ±10%、50 ～ 60 Hz または 115 VRMS

±10%、400 Hz。CAT II

≤1100 VA

DPO7000C シリーズ：

100 ～ 240 VRMS ±10%、47 ～ 63 Hz または 115 VRMS

±10%、400 Hz。

最大 550 ワット

MSO5000B シリーズおよび DPO5000B シリーズ：

100 ～ 240 VRMS ±10% 50 ～ 60 Hz115 V 440 Hz 最大 275 ワット
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機器の設置

DPO7000C シリーズ

MSO/DPO70000DX シリーズおよび MSO/DPO70000C シリーズ

MSO5000B シリーズおよび DPO5000B シリーズ
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機器の設置

機器の電源をオフにする

MSO/DPO70000DX シリーズ、MSO/DPO70000C シリーズ、および
DPO7000C シリーズ

MSO5000B シリーズおよび DPO5000B シリーズ
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機器の設置

電源の取り外し

DPO7000C シリーズ

MSO/DPO70000DX シリーズおよび MSO/DPO70000C シリーズ

MSO5000B シリーズおよび DPO5000B シリーズ
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機器の設置

オシロスコープの盗難防止

1. ラップトップ・コンピュータ用のセキュ
リティ・ロックをオシロスコープにも使
用できます。盗難防止にお役立てく
ださい。

MSO5000B シリーズおよび DPO5000B シリーズ

ネットワークへの接続

機器をネットワークに接続して、印刷、
ファイル共有、インターネット・アクセス
などの通信機能を利用できます。ネッ
トワークに対して機器を構成するには、
ネットワーク管理者に問い合わせ、標
準の Windows ユーティリティを使用し
てください。

機器をリモートから制御し表示するに
は Windows のリモート・デスクトップ接
続を使用してください。
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機器の設置

2 台めのモニタの追加
外部モニタで Windows やインストールされたアプリケーションを使用しながら、機器を操作できます。デュア
ル・モニタ構成をセットアップするには、次の手順に従います。

MSO/DPO70000DX シリーズおよび MSO/DPO70000C シリーズ

1. 電源をオフにします。

2. 2 台めのモニタを接続します。
MSO/DPO70000C シリーズで VGA
モニタを使用する場合は、DVI -
VGA 変換アダプタを使用します。

3. キーボードを接続します。

4. マウスを接続します。

5. 機器の電源をオンにします。

6. モニタの電源をオンにします。

MSO/DPO70000DX シリーズおよび MSO/DPO70000C シリーズ
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機器の設置

DPO7000C モデル

1. 電源をオフにします。

2. モニタをもう 1 台接続します。

3. キーボードを接続します。

4. マウスを接続します。

5. 機器の電源をオンにします。

6. モニタの電源をオンにします。

DPO7000C シリーズ
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MSO5000B モデルおよび DPO5000B モデル

1. 電源をオフにします。

2. 追加するモニタを接続します。

3. キーボードを接続します。

4. マウスを接続します。

5. 機器の電源を投入します。

6. モニタの電源を投入します。

MSO5000B モデルおよび DPO5000B モデル
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オペレーティング・システムのリストア
オペレーティング・システムのリストア DVD が機器に同梱されていて、オペレーティング・システムのリストア
が必要になった場合には、DVD 付属の指示書に従ってください。

本機器では、ハード・ドライブの別のパーティションにオペレーティング・システム・リストア用ファイルが含ま
れています。

機器のオペレーティング・システムをリストアする際には、ハード・ディスクのリストア・ファイルを使用するよ
うに推奨します。

注意： リストア・プロセスを実行すると、ハード・ドライブが再フォーマットされ、オペレーティング・システムが
再インストールされます。保存されていたデータはすべて失われます。できるだけ、システムのリストアを実
行する前に、重要なファイルを外部のメディアに保存しておくようにしてください。

1. 機器を再起動します。起動プロセスが実行されている間、画面の上部に次のメッセージが表示されます。
Starting Acronis Loader... press F5 for Acronis Startup Recovery Manager

注： システムのリストアを実行するには、Windows バージョンの Acronis ソフトウェアを使用してください。 汎
用の MAC キーボードを使用すると DOS バージョンの Acronis ソフトウェアが起動します。 MAC キーボード
は使用しないでください。

2. Acronis True Image Tool が開くまで、F5 キーを繰り返し押します。メッセージが表示されてから機器が通
常どおり起動するまでに 15 秒かかります。Acronis アプリケーションが起動しない場合は、機器の電源を
切ってから、もう一度電源を入れてみます。

3. Restore をクリックします。

4. Confirmation ダイアログ・ボックスで、Yes をクリックして機器のオペレーティング・システムをリストアしま
す。リストアせずにプロセスを終了するには、No をクリックします。リストア・プロセスには約 30 分ほどを要
しますが、実際にかかる時間は機器の設定によって異なります。
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MSO5000B シリーズおよび DPO5000B シリーズのハード・ドライブ
のインストール

注意： ハード・ドライブ・アセンブリを逆
さに挿入すると機器が破損することが
あります。

1. 機器の電源が切断されていることを
確認します。

2. ドライブ・アセンブリのシャーシを上
に向けてハード・ドライブを機器に
挿入します。

3. ネジでドライブ・アセンブリを確実に
固定します。

4. カバーを取り付けます。
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機器の概要

機器の概要

前面パネル

MSO/DPO70000DX シリーズ、MSO/DPO70000C シリーズ、および DPO7000C シリーズ

1. DVD/CD-RW ドライブ

2. フロント・パネル・コントロール
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3. USB ポート

4. グランド端子

5. 再生データ出力（DPO7104C 型お
よび DPO7054C 型にはなし）

6. 再生クロック出力（DPO7104C 型お
よび DPO7054C 型にはなし）

7. プローブ補正出力

8. プローブ校正出力

9. チャンネル入力（1 ～ 4）

10.補助トリガ入力

11.高速エッジ出力

12.DC Probe Cal（プローブ校正）出力

13.ロジック・プローブ入力

14.1 MΩ の抵抗を通じたグランド端子

DPO7000C シリーズ

DPO70000C シリーズ

MSO70000C シリーズ

DPO70000DX シリーズ

MSO70000DX シリーズ
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MSO5000B シリーズおよび DPO5000B シリーズ

1. フロント・パネル・コントロール

2. グランド端子

3. プローブ補正出力

4. 補助トリガ入力

5. チャンネル 1 ～ 4 入力

6. ロジック・プローブ入力

7. USB ポート

MSO5000B シリーズおよび DPO5000B シリーズ
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後部および側面パネル

MSO/DPO70000DX シリーズおよび MSO/DPO70000C シリーズ

1. リムーバブル・ハード・ディスク・ドラ
イブ

2. マウス用 PS-2 コネクタ

3. USB ホスト・ポート

4. パッシブ eSATA ポート

5. ネットワーク接続用 RJ-45 LAN コネ
クタ

6. TekLink コネクタ

7. コントローラ接続用 GPIB ポート

8. スピーカ用 Line Out コネクタ

注： 機器によっては、オーディオ・コネ
クタを備えているものもあります。

9. マイクロフォン用 Mic コネクタ

10.DVI-D ビデオ・ポート

11.COM 1 および COM 2 シリアル・
ポート

12.キーボード用 PS-2 コネクタ

13.補助出力

14. リファレンス出力

15.外部リファレンス入力

16.VGA ポート

MSO/DPO70000DX シリーズおよび MSO/DPO70000C シリーズ
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DPO7000C シリーズ

1. キーボード用 PS-2 コネクタ

2. マウス用 PS-2 コネクタ

3. ネットワーク接続用 RJ-45 LAN コネ
クタ

4. スピーカ用 Line Out コネクタ

5. マイクロフォン用 Mic コネクタ

6. USB ホスト・ポート

7. DVI-1 ビデオ・ポート

8. COM 1 および COM 2 シリアル・
ポート

9. プリンタ接続

10.モニタ接続用 XGA ビデオ出力ポー
ト（オシロスコープのみ）

11.取り外し可能なハード・ディスク・ド
ライブ

12.コントローラ接続用 GPIB ポート

13.補助出力

14.チャンネル 3 出力

15.外部リファレンス入力

DPO7000C シリーズ
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MSO5000B シリーズおよび DPO5000B シリーズ

1. Line In コネクタ

2. スピーカ用 Line Out コネクタ

3. マイクロフォン用 Mic コネクタ

4. モニタ接続用ビデオ・ポート

5. キーボード用 PS-2 コネクタ

6. マウス用 PS-2 コネクタ

7. USB ホスト・ポート

8. ネットワーク接続用 RJ-45 LAN コネ
クタ

9. USB デバイス・ポート

10.プローブ電源入力、119-7465-xx 電
源を使用

11.外部リファレンス入力

12.補助出力

13.セキュリティ・ロック入力

14.AC 電源入力

15. リムーバブル・ハード・ディスクのカ
バー

16.グランド接続

MSO5000B シリーズおよび DPO5000B シリーズ

PS-2 デバイスを使用するには、機器の電源投入前にそれらを接続してください。PS-2 デバイスはホット・ス
ワップはできません。
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インタフェースおよびディスプレイ

メニュー・バーのメニューを使用すると、機器のすべての機能を管理するコマンドにアクセスできます。ツール
バー・モードを使用すると、最も頻繁に使用する機能にアクセスできます。

1. メニュー・バー：データ I/O、印刷、
オンライン・ヘルプ、および機器の
諸機能にアクセスします

2. ボタン／メニュー： クリックすると、
ツール・バーとメニュー・バー・モー
ドが切り替わり、ツール・バーをカス
タマイズできます

3. 汎用ノブ・リードアウト：汎用ノブを
使用して制御するパラメータの調整
と表示を行います

4. ディスプレイ： ライブ波形、リファレン
ス波形、演算波形、デジタル波形、
およびバス波形がカーソルと共に表
示されます。

5. 波形ハンドル： クリックおよびドラッ
グして、波形またはバスの垂直位置
を変更します。ハンドルをクリックし、
汎用ノブを使用して位置とスケール
を変更します。

6. コントロール・ステータス：垂直軸の
選択、スケール、オフセット、および
パラメータのクイック・リファレンスで
す。

7. リードアウト：この領域には、カーソ
ルと測定リードアウトが表示されま
す。測定は、メニュー・バーまたは
ツール・バーから選択できます。コ
ントロール・ウィンドウが表示される
と、リードアウトの組み合わせの中
には、目盛領域に移動するものが
あります。

警告： 垂直クリップがある場合、リードアウトでは低電圧を示していても、プローブ・チップには危険な電圧が

かかっていることがあります。垂直クリップの状態が存在している場合、 記号がリードアウトに表示されま
す。振動に関する自動測定では、信号が垂直方向にクリッピングすると測定結果が不正確になります。また、
クリッピングがあると、他のプログラムで使用するためにエクスポートまたは保存される波形の振幅値が不正
確になります。演算波形がクリッピングされている場合、その演算波形の振幅測定には影響を与えません。

8. ステータス：アクイジション・ステータス、モード、およびアクイジション数、トリガ・ステータス、日時、およ
びレコード長と水平軸パラメータのクイック・リファレンスを表示します
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1. ボタン／メニュー：クリックすると、
ツール・バーとメニュー・バー・モー
ドが切り替わり、ツール・バーをカス
タマイズできます

2. カーソルをドラッグして、画面上の
波形を測定します

3. 位置アイコンをドラッグして、波形を
移動します

4. アイコンをクリックして、汎用ノブを
波形の垂直位置およびスケールに
割り当てます

5. 波形領域を斜めにドラッグして、ズー
ム、ヒストグラムの有効／無効、ゲー
ト測定、およびトリガ領域表示の追
加と制御を行うためのボックスを作
成します

6. アイコンをドラッグして、トリガ・レベ
ルを変更します
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機器の概要

コントロール・パネル

MSO/DPO70000DX シリーズ、MSO/DPO70000C シリーズ、および DPO7000C シリーズ

1. 選択されたチャンネルに基づいて、
自動的に垂直、水平、トリガのコント
ロールをセットアップする場合に押
します。

2. 設定をデフォルト値に戻す場合に
押します。

3. ハードコピーを作成するか、または
画面表示を保存する場合に押しま
す。

4. MultiView Zoom をオンにして、画面
に拡大目盛を追加する場合に押し
ます。

5. すべての波形の水平方向のスケー
ル、位置、遅延を調整したり、レコー
ド長（分解能）を設定したりできます。

6. アクイジションの開始と停止、シング
ル・アクイジション・シーケンスの開
始、データのクリア、あるいは高速
アクイジションを開始する場合に使
用します。

7. トリガ・パラメータを設定する場合
に使用します。Advanced を押すと、
追加のトリガ機能が表示できます。
Arm、Ready、および Trig'D ランプ
により、アクイジション・ステータスを
示します。

8. このノブを回して、波形輝度を調整
します。

9. このノブを回して、画面インタフェー
スで選択したパラメータを調整しま
す。標準調整と微調整を切り替える
場合に押します。

10.カーソルのオンとオフを切り替える
場合に押します。
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機器の概要

11.波形の検索とマークに使用します。

12. このボタンはタッチ・スクリーンのオ
ンとオフを切り替える場合に押しま
す。

13.チャンネル表示のオンとオフを切り
替えます。波形の垂直方向のスケー
ル、位置、あるいはオフセット調整
を行います。位置とオフセットが切
り替わります。

MSO70000 シリーズの機器の場合
は、Digital > Digital Setup メニュー
を使用してデジタル・チャンネルを
オンにします。 (51 ページ 「デジタ
ル信号入力のセットアップ」 参照)。
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機器の概要

MSO5000B シリーズおよび DPO5000B シリーズ

1. 画面インタフェースで選択したパラ
メータを調整する場合に回します。
微調整を選択するには Fineを押し、
粗調整を選択するには Coarse を押
します。

2. カーソルのオン/オフを切り替える
場合に押します。

3. 汎用ノブを使用して波形輝度を調
整する際に押します。

4. MultiView Zoom 機能をオンにして、
ディスプレイに拡大目盛を追加する
場合に押します。

5. 自動測定の実行、取り込んだ波形
からユーザ定義のイベント／条件の
検索、高速アクイジションの開始ま
たは停止を行う場合に押します。

6. すべての波形の水平方向のスケー
ル、位置調整、水平パラメータ、ア
クイジション・パラメータの設定を行
います。

7. 内側のズーム・ノブを回してズーム
倍率を調整します。外側のパン･ノ
ブを回すと、ズーム・ウィンドウをスク
ロールして波形内を移動できます。
再生／停止ボタンを押すと、波形の
自動パンを開始または停止できま
す。速度および方向を制御するに
は、パン・ノブを使用します。

8. アクイジションを開始／停止したり、
シングル・アクイジション・シーケン
スを開始する場合に使用します。

9. 波形の検索とマーク、波形マークの
設定と削除、次の波形マークや前
の波形マークへのジャンプに使用
します。

10.選択されたチャンネルに基づいて、
自動的に垂直、水平、トリガのコント
ロールをセットアップする場合に押
します。

11. トリガ・パラメータの設定に使用しま
す。Menu を押して、追加のトリガ機
能を表示します。
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機器の概要

12.チャンネル表示のオン/オフを切り
替えます。垂直方向のスケールや
波形の位置調整を行います。

MSO5000B シリーズの機器の場合
は、D15 ～ D0 ボタンを押すか
Digital > Digital Setup メニューを使
用してデジタル・チャンネルをオン
にします。 (51 ページ 「デジタル信
号入力のセットアップ」 参照)。

13. このボタンはタッチ・スクリーンのオ
ンとオフを切り替える場合に押しま
す。

14.演算、リファレンス、バス、または垂
直軸セットアップのメニューを表示
する場合に押します。

15. メニューを非表示にする場合に押
します。

16.デジタル・セットアップ・メニューを表
示する場合に押します（MSO5000B
シリーズのみ）。

17.データをクリアする場合に押します。

18.設定をデフォルト値に戻す場合に
押します。

19.セットアップ、波形およびスクリーン・
イメージの保存と呼び出しを行う場
合に押します。

20.ハードコピーの印刷またはスクリーン
の取り込みを行う場合に押します。

MSO/DPO70000DX、MSO/DPO70000C、DPO7000C、および MSO/DPO5000B シリーズ・ユーザ・マニュアル 27



機器の概要

オンライン・ヘルプへのアクセス
オンライン・ヘルプでは、機器のすべての機能に関する詳しい情報を参照できます。

アクティブなウィンドウに関する状況に
応じたヘルプにアクセスするには、Help
> Help on Window... を選択するか、ま
たは F1 キーを押します。

1. ヘルプ・システム内の任意のトピッ
クを参照するには、Help > Contents
and Index...を選択します。

2. Contents 、 Index 、 Search 、または
Favorites タブを使用して項目を選
択し、Display をクリックします。

ヘルプ・システム内を移動するには、以
下の操作を行います。

ヘルプ・ウィンドウ内のボタンをクリッ
クすると、概要と個別の項目の表示
を切り換えることができます。

機器を操作できるようにヘルプを非
表示にする場合は、ヘルプ・ウィン
ドウの Minimize ボタンをクリックしま
す。

直前に表示したヘルプ・トピックをも
う 1 度表示するには、Alt キーおよ
び Tab キーを押します。
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機器の概要

メニューおよびコントロール・ウィンドウへのアクセス
次の手順を使用して、メニューやコントロール・ウィンドウにアクセスできます。

メニューをクリックし、コマンドを選択
します。

ショートカット・メニューを表示するに
は、目盛内の任意の場所またはオ
ブジェクトを右クリックします。ショー
トカット・メニューは状況依存である
ため、右クリックした領域またはオブ
ジェクトに応じてメニューが異なりま
す。いくつかの例を右の図に示しま
す。

ツール・バー・モードで、ボタンをク
リックすると、セットアップ・コントロー
ル・ウィンドウにすばやくアクセスで
きます。 (22 ページ参照)。
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機器の検査

機器の検査

機器の機能を確認するには、次の手順を使用します。

内部診断合格の確認

1. 機器の電源をオンにします。

2. Instrument Diagnostics... を選択し
ます。

3. Run をクリックします。診断コントロー
ル・ウィンドウにテスト結果が表示さ
れます。

4. すべてのテストに合格していること
を確認します。診断が失敗した場合
は、当社のサービス担当者にお問
い合わせください。
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アクイジション

アクイジション

このセクションでは、アクイジション・システムを使用する概念とその手順について説明します。

信号パス補正
前回の信号パス補正（SPC）後に温度が 5 ℃（9 ﾟF）以上変化した場合は、この手順を実行します。信号パ
ス補正は、機器の測定精度を最高レベルに維持できるよう、定期的に実行する必要があります。なお、オシ
ロスコープを使用して信号を高感度（10 mV/div 以下）で測定する場合は、前回の補正後の温度シフトや経
過時間にかかわらず、SPC を実行することをお勧めします。SPC を怠ると、機器が保証性能レベルを満たさ
ないことがあります。

1. 必要条件：機器の電源を入れ、20
分間オンのままにし、すべての入力
信号を取り外します。

2. Instrument Calibration を選択しま
す。

3. Temperature Status が Ready になっ
たら、Run SPC をクリックして校正を
開始します。校正には 10 ～ 15 分
かかります。
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アクイジション

4. Pass にならない場合は、機器を再
度校正するか、資格のあるサービス
担当者による機器のサービスを受
けてください。

注： SPC ステータス・アイコンを常時表
示したり、SPC が 1 か月以上実行され
ていない場合に警告を表示するには、
それぞれ該当するチェックボックスをク
リックします。

5. SPC が必要であることを示すアイコ
ンが赤色の場合は、信号パス補正
を実行します。
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アクイジション

アナログ信号入力のセットアップ
信号を取り込むために機器を設定するには、前面パネルのボタンを使用します。

1. プローブを入力信号ソースに接続します。

注意： 機器の損傷を防ぐため、本機器への接続時には必ず帯電防止リスト・ストラップを装着し、入力コネ
クタの最大入力定格電圧を確認してください。

MSO/DPO70000DX シリーズおよび MSO/DPO70000C
シリーズ

DPO7000C シリーズ

MSO5000B シリーズおよび DPO5000B シリーズ

2. 前面パネルのボタンを押し、入力チャンネルを選択して、チャンネルのオンとオフを切り替えます。

MSO5000B シリーズおよび DPO5000B シリーズ

MSO/DPO70000DX シリーズ、MSO/DPO70000C シリー
ズ、および DPO7000C シリーズ

MSO/DPO70000DX、MSO/DPO70000C、DPO7000C、および MSO/DPO5000B シリーズ・ユーザ・マニュアル 33



アクイジション

3. Autoset を押します。

4. フロント・パネルのノブを使用して、垂直位置、スケールおよびオフセットを調整します。

MSO5000B シリーズおよび DPO5000B シリーズ MSO/DPO70000DX シリーズ、MSO/DPO70000C シリー
ズ、および DPO7000C シリーズ

5. 前面パネルのノブを使って、水平位置とスケールを調整します。

水平位置によって、プリトリガとポストトリガのサンプル数が決まります。

MSO5000B シリーズおよび DPO5000B シリーズ MSO/DPO70000DX シリーズ、MSO/DPO70000C シリー
ズ、および DPO7000C シリーズ

6. 入力信号を反転させたい場合は、Invert（反転）
ボタンをクリックして、反転のオンとオフを切り替え
ます。Invert（反転）ボタンは、Vertical Setup（垂
直軸セットアップ）メニューまたは Deskew/At-
tenuation/Invert（デスキュー／減衰／反転）メ
ニューにあります。
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アクイジション

デフォルト設定の使用

1. 設定を出荷時デフォルト設定にすばやく戻すに
は、Default Setup を押します。

MSO/DPO70000DX シリーズ、MSO/DPO70000C シリー
ズ、および DPO7000C シリーズ

MSO5000B シリーズおよび DPO5000B シリーズ
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アクイジション

オートセットの使用
オートセットを使用すると、入力信号の特性に基づいて、機器（アクイジション、水平軸、トリガ、および垂直
軸）をすばやく自動的にセットアップできます。オートセットでは、波形の 2 つまたは 3 つのサイクルと中間レ
ベル付近のトリガ・レベルを表示するように信号が調整されます。

1. プローブを接続してから、入力チャ
ンネルを選択します。(33 ページ 「ア
ナログ信号入力のセットアップ」 参
照)。

2. Autoset ボタンを押して、オートセッ
トを実行します。

MSO/DPO70000DX シリーズ、MSO/DPO70000C シリーズ、および
DPO7000C シリーズ

MSO5000B シリーズおよび DPO5000B シリーズ

3. 直前のオートセットをやり直すには、
Undo をクリックします。オートセット
によって影響されないパラメータの
設定は変更されません。

ヒント

オートセットは、アナログ・チャンネルを自動的にセットアップします。

iCapture 搭載機では、オートセットにより自動的に iCapture チャンネルが設定されます。
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アクイジション

オートセットでは、波形の位置を適切に調整するために垂直軸位置が変更される場合があります。また、
オートセットでは、垂直オフセットが調整される場合もあります。

1 つまたは複数のチャンネルが表示されているときに Autoset（オートセット）を実行すると、機器は最も
数の小さいチャンネルを水平スケールおよびトリガに選択します。各チャンネルの垂直スケーリングは個
別に操作できます。

チャンネルが表示されていないときにオートセットを実行すると、機器はチャンネル 1（Ch 1）をオンにし、
スケーリングします。

X をクリックして、Autoset Undo コントロール・ウィンドウを閉じます。Autoset Undo を閉じても、Edit メ
ニューから Undo Last Autoset コマンドを選択して、直前のオートセットを取り消すことができます。

Utilities メニューの User Preferences を変更すると、自動的に Autoset Undo コントロール・ウィンドウを表
示しないように設定できます。

プローブの補正およびデスキュー
測定確度を最適化するには、機器のオンライン・ヘルプを参照して、次の手順を実行します。

受動プローブの補正

アクティブ・プローブの補正

入力チャンネルのデスキュー

アクイジションの概念

アクイジション・ハードウェア

信号を表示するには、信号が入力チャンネルを通過し、そこでスケーリングおよびデジタル化される必要が
あります。各チャンネルには、専用の入力増幅器とデジタイザが備えられています。各チャンネルはデジタ
ル・データのストリームを生成し、機器はそのデータから波形レコードを抽出します。

サンプリング処理

アクイジションは、アナログ信号をサン
プリングしてデジタル・データに変換し、
それを波形レコードにまとめる処理で
す。作成された波形レコードは、アクイ
ジション・メモリに格納されます。
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アクイジション

リアルタイム ・ サンプリング

リアルタイム・サンプリングでは、1 つ
のトリガ・イベントを使用して取り込んだ
ポイントをすべてデジタル化します。単
発現象や過渡的現象を取り込む場合
は、リアルタイム・サンプリングを使用し
ます。

補間リアルタイム・サンプリング

補間リアルタイム・サンプリングでは、1
つのトリガ・イベントを使用して取り込ん
だポイントをすべてデジタル化します。
機器が最大リアルタイム・サンプル・レー
トで完全な波形を表すのに十分なサン
プルを取得できない場合は、サンプル
が補間されます。単発現象や過渡現象
を取り込む場合は、補間リアルタイム・
サンプリングを使用します。

等価時間サンプリング

機器のリアルタイム・サンプリングの最
大サンプリング・レートよりも速いレート
でサンプリングするには、等価時間サ
ンプリングを使用します。等価時間サ
ンプリングは、Equivalent Time（等価時
間）が選択されていて、リアルタイム・サ
ンプリングを使って波形のレコードを作
成するのに速すぎるサンプリング・レー
トにタイム・ベースが設定されている場
合にのみ使用されます。

機器は、波形を複数回取り込むことで、
完全な波形レコードの作成に必要なサ
ンプル密度を取得します。つまり、等価
時間サンプリングは、繰り返し信号にだ
け使用します。
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波形レコード

本機器は、次のパラメータを使って、波
形レコードを生成します。

サンプル・インターバル：サンプル・
ポイント間の間隔。

レコード長：波形レコードの生成に
必要なサンプル数。

トリガ・ポイント：波形レコード内の時
刻ゼロの基準。

水平位置：水平遅延がオフの場合、
水平位置は、で示される波形レコー
ドの割合（0 ～ 99.9%）です。トリガ・
ポイントと水平基準ポイントは、波形
レコード内の同じ時間になります。
たとえば、水平位置が 50 パーセン
トである場合は、トリガ・ポイントは、
波形レコードの中央になります。水
平遅延がオンの場合は、トリガ・ポイ
ントから水平基準の時間が水平遅
延となります。

補間

本機器では、取り込んだサンプルの間を補間できます。補間は、波形レコードに必要な実際のサンプルが
不足している場合に行われます。直線補間法は、直線を使用して、実際の取り込みサンプルの間のレコー
ド・ポイントを計算します。

Sin(x)/x 補間法は、 取り込まれた実際の値の間の曲線を使って、レコード・ポイントを計算します。Sin(x)/x
補間法はデフォルトの補間モードです。これは、波形を正確に表わすのに必要なサンプル・ポイントが直線
補間法より少ないためです。
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アクイジション・モードの仕組み

Sample モードでは、各アクイジション間
隔から最初にサンプリングされたポイン
トが維持されます。このモードはデフォ
ルトのモードです。

Peak Detect モードでは、連続した 2 つ
のアクイジション間隔に含まれるすべて
のサンプルの最大および最小のサンプ
ルが使用されます。このモードは、補間
のないリアルタイムのサンプリングでの
み使用でき、高周波数のグリッチを捕
捉するのに便利です。

Hi Res モードでは、各アクイジション間
隔にあるすべてのサンプルの平均が計
算されます。ハイレゾは、高分解能で
低帯域幅の波形を表示します。

Envelope モードでは、多くのアクイジ
ションから最大および最小のレコード・
ポイントが特定されます。エンベロープ・
モードでは、各アクイジションにピーク・
ディテクトを使用します。

Average モードでは、多数のアクイジ
ションの各レコード・ポイントの平均値
が計算されます。平均モードでは、各
アクイジションにサンプル・モードを使
用します。平均モードを使用すると、 不
規則ノイズが減少します。

Waveform Database モードは、複数の
アクイジションで取込んだソース波形
データを 3 次元的に累積します。この
データベースには、振幅とタイミングに
関する情報に加えて、特定の波形ポイ
ント（時間および振幅）の取り込み回数
も含まれます。
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拡張有効ビット数をオンにする
Acquisition タブのこのコントロールは、拡張有効ビット数（ENOB）のオン／オフを切り替えて、波形詳細度を
最適化するために使用します。 このコントロールは、MSO/DPO70000DX モデルでのみ利用できます。

1. ENOB のオン／オフを切り替えるには、Enhanced Effective Number of Bits チェック・ボックスをクリックしま
す。 このコントロールは、Horizontal/Acquisition コントロール・ウィンドウの Acquisitions タブにあります。

拡張有効ビット数は、インターリーブ補正 DSP を有効にし、有効ビット数を改善します。 このコントロールは、
一部の機器モデルでのみ使用できます。 このコントロールは、Hi Res モードでは使用できません。

拡張有効ビット数がオンの場合、水平／アクイジション・リードアウトに EB+ が表示されます。
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アクイジション・モードの変更
アクイジション・モードを変更するには、以下の手順を使用します。

1. Horiz/Acq > Acquisition Mode を選
択します。

2. アクイジション・モードを選択するに
は、次のいずれかの手順を実行し
ます。

メニューからアクイジション・モー
ドを直接選択します。

Mode... をクリックし、アクイジショ
ン・モードを選択します。

3. アベレージ・アクイジション・モード
またはエンベロープ・アクイジショ
ン・モードの場合は、# of Wfms コ
ントロールをクリックしてから、汎用
ノブを使用して波形の数を設定し
ます。波形データベース・モードで
は、Samples コントロールをクリックし
てから、汎用ノブを使用してサンプ
ルの数を設定します。

ヒント

キーパッド・アイコンをクリックして、波形またはサンプルの数を設定します。
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アクイジションの開始および停止
取り込みチャンネルを選択したら、次の手順を実行します。

1. 前面パネルの Run/Stop ボタンを押
して、アクイジションを開始します。

2. Run/Stop ボタンをもう一度押して、
アクイジションを停止します。

3. 単発のアクイジションを取得するに
は、Single を押します。 MSO/DPO70000DX シリーズ、MSO/DPO70000C シリーズ、および

DPO7000C シリーズ

MSO5000B シリーズおよび DPO5000B シリーズ

水平モードの選択
この機器には 3 つの水平モードがあります。デフォルトでは、自動が設定されていますので、テスト・セット
アップに最適な水平モードを選択してください。

水平モードを設定するには、Horiz/Acq
> Horizontal/Acquisition Setup を選択
し、水平軸コントロール・ウィンドウを表
示します。次に、以下のモードのいず
れかを選択します。

Automatic モードでは、スケールとサン
プル・レートを設定できます。レコード
長は従属変数です。スケールの値が変
わることによってレコード長がその制限
値を超えると、サンプル・レートは次の
レベルの設定値に下がります。

サンプリング・モードがリアルタイムで、
サンプル・レートがリアルタイム制限値
の場合、サンプル・レートを増やそうと
しても効果はありません。
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レコード長の制限値を設定するには、
Record Length Limit をクリックし、ボタ
ンまたはキーパッドで制限値を設定しま
す。デフォルトの最大制限値は、機器
のモデルとレコード長オプションによっ
て異なります。

Constant Sample Rate モードでは、サ
ンプル・レートとスケールを設定できま
す。デフォルトのサンプル・レートを使
用すれば、帯域幅フィルタの操作を確
実に行うことができます。レコード長は
従属変数です。最大レコード長は、機
器のモデルとレコード長オプションに
よって異なります。

フロント・パネルの分解能ノブを使用する
と、Automatic モードと Constant Sample
Rate モードの両方でサンプル・レート
を調節できます。
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Manual モードでは、サンプル・レートと
レコード長を設定できます。水平スケー
ルは従属変数で、サンプル・レートとレ
コード長から計算されます。

Manual モードでは、水平スケール・ノ
ブを使ってレコード長を調整します。

ここで示すように、3 つのモードはすべ
て、サンプル・レート、スケール、および
レコード長と連動しています。水平ライ
ンは、最大リアルタイム・サンプル・レー
トです。階段状の各ラインは、スケール
を増やすと、サンプル・レートは、最大
レコード長または設定したレコード長
制限値に達したときに小さくなっていか
なければならないことを示しています。
Manual モードは、最大レコード長を使
用します。

Automatic モードと Constant Sample
Rate モードはまったく同じです。ただ
し、Constant Sample Rate モードの場
合、サンプル・レートは、帯域幅拡張
フィルタが確実に使用されるレートに保
たれています。

ヒント

デジタル・サンプル・レートと分解能は従属変数であり、アナログ・サンプル・レートの選択に応じて変化
します。
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高速アクイジションの使用
高速アクイジション・モードは、波形アクイジション間のデッド・タイムを減少させ、グリッチやラント・パルスな
どの過渡的現象を取り込んで、表示できます。また、高速アクイジション・モードでは、発生頻度に応じた輝
度で波形現象を表示できます。

1. FastAcq を押します。

MSO/DPO70000DX シリーズ、MSO/DPO70000C シリーズ、および
DPO7000C シリーズ

MSO5000B シリーズおよび DPO5000B シリーズ

2. グリッチ、過渡的現象、あるいは他
の不規則現象を探します。

異常が特定できたら、トリガ・システ
ムをセットアップして、その異常を観
察します。 (181 ページ 「間欠的に
発生する異常の取り込み」 参照)。

ヒント

FastAcq モードでは、デジタル・チャンネルおよびデジタル・バスは使用できません。

詳細情報または稀にしか発生しないイベントを最も効果的に取り込むには、Horiz/Acq > Horizontal/Ac-
quisition Setup > Acquisition> Fast Acq を選択し、次に、Optimize For Capturing Details または Capturing
rare events を選択します。
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DSP 拡張帯域幅の使用
機器に拡張帯域幅機能が備えられている場合は、より正確な立上り時間測定を実行するために、デジタル
信号処理（DSP）拡張帯域幅を使用して帯域幅を拡大し、最大のサンプル・レートにおけるパスバンドをフ
ラット化します。拡張帯域幅を使用すると、有効チャンネル全体に適合した応答が可能になるため、チャン
ネル間の比較測定および差動測定を行うことができます。

1. Autoset を押して、水平、垂直、お
よびトリガのコントロールを設定する
か、または手動でコントロールを設
定します。

MSO/DPO70000DX シリーズ、MSO/DPO70000C シリーズ、および
DPO7000C シリーズ

MSO5000B シリーズおよび DPO5000B シリーズ

2. Vertical > Bandwidth Enhanced...
を選択します。
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3. Digital Filters (DSP) Enabled をクリッ
クして、拡張帯域幅をオンにします。
DSP を有効にするには、サンプル・
レートを正しく設定する必要があり
ます。

4. DSP フィルタが有効になるよう一定
のサンプル・レートを強制的に確保
するには、Force Constant Sample
Rate チェック・ボックスをオンにしま
す。

注： まだ設定されていない場合に
Constant Sample Rate を選択すると、
一定のサンプル・レートが確保されるよ
う水平モードが設定されます。このサン
プル・レートは DSP が有効になるように
設定され、さらに、DSP 帯域幅が選択
されます。

5. 目的の帯域幅を Bandwidth リストか
ら選択します。

選択できる利用可能な帯域幅は、
機器、プローブ、およびプローブ・
チップによって異なります。

Analog Only を選択すると、ハード
ウェア（HW）帯域幅が選択されま
す。

6. 選択した内容をすべてのチャンネ
ルに適用するには、Apply To All
Channels チェック・ボックスをオンに
します。

プロービングが異なっているため同
じように設定できないチャンネルが
ある場合、各チャンネルの帯域幅
は、選択した内容に一番近い値が
設定されます。

拡張帯域幅がオンになると、垂直
リードアウトに帯域幅インジケータが
表示されます。

ヒント

波形ハンドルを右クリックするとメニューが表示され、チャンネル帯域幅とその他の帯域幅拡張設定を選
択できます。

DSP 拡張帯域幅は、最大のサンプル・レートで発生します。

信号の立上り時間が 50 ps 未満の場合に、DSP 拡張帯域幅が使用できます。
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より高い波形スループットが必要な場合、オーバードライブ信号の場合、Analog Only を選択します。

Vertical > Bandwidth Limit を選択してから帯域幅を選択すると、機器の帯域幅を制限できます。

ターミネーション電圧の設定
ターミネーション電圧の調整は、MSO/DPO70000DX モデルでのみ利用できます。

従来のオシロスコープ入力はグランドに終端されていました。 しかし、測定する信号はグランドを基準として
いない場合がよくあります。 信号をグランドに落とすと測定結果に影響を与えたり、DUT（被測定装置）を破
損する可能性もあります。

本器は ±3.4 V までの可変ターミネーション電圧を DUT に供給し、また幅広いオフセット電圧をサポートす
ることができます。 これにより、DUT の条件や動作をオシロスコープで反映させることができ、DUT の実際
の動作に近い環境で高速信号を測定することができます。

ターミネーション電圧とオフセットを組み合わせて、オシロスコープの基準ポイントを DUT の動作範囲の中央
に合わせることにより、ダイナミック・レンジを最大化し、測定システムのノイズを最小化することができます。

チャンネルのターミネーション電圧を設定するには、次のようにします。

1. Vertical > Vertical Setup を選択し
ます。

2. Termination Voltage フィールド内を
クリックします。 ターミネーション電
圧の設定には、キーパッドまたは汎
用ノブを使用します。
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ロール・モードの使用
ロール・モードでは、低周波信号をストリップ・チャート・レコーダのように表示できます。ロール・モードを使
用すると、完全な波形レコードが取り込まれるのを待たずに、取り込んだデータ・ポイントを表示できます。

1. Horiz/Acq >Horizontal/Acquisition
Setup... を選択します。

2. 選択されていない場合は、Acquisi-
tion タブをクリックします。Auto をク
リックし、ロール・モードをオンにし
ます。

注： ロール・モードでは、サンプル、
ピーク検出、またはハイレゾのアクイジ
ション・モードを使用する必要がありま
す。

3. ロール・モードでのアクイジションを
停止するには

シングル・シーケンスでない場合
は、Run/Stop を押してロール・
モードを停止します。

シングル・シーケンスの場合は、
完全なレコードが取り込まれる
と、ロール・モード・アクイジショ
ンが自動的に停止します。

MSO/DPO70000DX シリーズ、MSO/DPO70000C シリーズ、および
DPO7000C シリーズ

MSO5000B シリーズおよび DPO5000B シリーズ

ヒント

エンベロープ、アベレージ、波形データベース・アクイジション・モードに切り換えても、ロール・モードは
オフになります。

水平スケールを 50 ms/div 以上に設定すると、ロール・モードは無効になります。
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デジタル信号入力のセットアップ
Digital セットアップ・メニューを使用して、信号を取り込むデジタル・チャンネル設定します。 デジタル・チャ
ンネルは、MSO70000C/DX シリーズと MSO5000B シリーズ、オプション MSOE 型を装備した DPO5000B シ
リーズ、およびオプション MSOU 型を装備した DPO70000DX シリーズでのみ使用できます。

1. ロジック・プローブを機器に接続し
ます。

2. プローブを入力信号ソースに接続
します。

注意： 機器の損傷を防ぐため、機器へ
の接続作業の際には必ず帯電防止リ
スト・ストラップを着用し、入力コネクタ
に対する最大入力電圧の定格を順守
してください。

MSO70000C/DX シリーズおよび DPO70000C/DX シリーズ

MSO5000B シリーズおよび DPO5000B シリーズ

3. Digital メニューを使用して、デジタ
ル・チャンネルおよびデジタル・バ
スをセットアップします。

(52 ページ 「デジタル・チャンネルの
セットアップ」 参照)。 および (53 ペー
ジ 「バスのセットアップ」 参照)。
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デジタル・チャンネルのセットアップ
MSO70000C/DX シリーズと MSO5000B シリーズ、オプション MSOE 型を装備した DPO5000B シリーズ、お
よびオプション MSOU 型を装備した DPO70000DX シリーズでは、デジタル・チャンネルのスレッショルド、
サイズ、位置およびラベルを設定できます。

1. Digital > Digital Setup を選択しま
す。

2. 設定するデジタル・チャンネルの D7
- D0 タブまたは D15 - D8 タブを選
択します。

3. デジタル・チャンネル・ボタンをクリッ
クして、デジタル・チャンネルの表示
をオンまたはオフに切り替えます。

4. Threshold または Position をクリック
し、キーボードまたは汎用ノブで調
節します。または、全 16 チャンネル
共通のGlobal Threshold 値を入力
し、Apply をクリックします。
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5. すべてのデジタル・チャンネルの垂
直方向の表示サイズを変更するに
は、Size をクリックし、リストから表示
サイズを選択します。

6. デジタル・チャンネル・ラベルを変更
するには、ラベルをクリックし、キー
ボードで新しいラベルを入力しま
す。

バスのセットアップ
シリアル・バス（オプション）およびパラレル・バスのセットアップが行えます。

1. Vertical > Bus Setup を選択するか、
機器によっては Digital > Bus Setup
を選択します。

2. Config タブを選択します。
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3. スクロールして、セットアップするバ
スを選択します。

4. バスの表示をオンまたはオフに切り
替えるには、Bus ボタンをクリックし
ます。

5. バスのデフォルトのラベルを変更す
るには、Label をクリックし、キーボー
ドで新しいラベルを入力します。

6. バスの表示位置を変更するには、
Bus Position をクリックし、キーボー
ドまたは汎用ノブで新しいバスの位
置を入力します。

7. バス・タイプを選択するには、Bus
Type の Serial または Parallel をク
リックします。

いずれのバス・タイプも設定できます。

(54 ページ 「シリアル・バスのセットアッ
プ」 参照)。 または (56 ページ 「パラレ
ル・バスのセットアップ」 参照)。

ヒント

バス・ハンドルまたは波形ハンドル上でクリックし、そのハンドルを目的の位置にドラッグすることで、バ
スまたは波形を配置できます。

シリアル・バスのセットアップ

シリアル・バス（オプション）のパラメータの設定は次のように行います。デジタル・チャンネルを使用してバ
スを定義できるのは MSO シリーズの機器のみです。
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1. シリアル・バスをセットアップするに
は、Bus Type の Serial を選択し、ド
ロップダウン・リストからシリアル・バ
スのタイプを選択します。
バスのタイプによって設定できるパ
ラメータが異なります。選択したバス
に従って、適切な他のバス・タイプ
をセットアップします。

バスのセットアップの詳細については、
オンライン・ヘルプを参照してください。

2. 表示されたバスのコンポーネントに
対する入力を選択するには、コン
ポーネントの Input フィールドをク
リックし、表示されたリストから選択
します。

3. 入力のスレッショルドを設定するに
は、Threshold フィールドをダブルク
リックし、キーパッドでスレッショルド
を入力します。

注： 現在共通になっているスレッショ
ルドを個別に設定する場合は、Trig >
A Event (Main) Trigger Setup に移動
して、Settings を Independent に変えま
す。

4. 表示されたバスのコンポーネントに
対する極性を選択するには、コン
ポーネントの Polarity フィールドを
クリックし、表示されたリストから選択
します。
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ヒント

カスタム・シリアル・デコーダを使用するには、オンライン・ヘルプを参照してください。

パラレル・バスのセットアップ

パラレル・バスのパラメータの設定は次のように行います。デジタル・チャンネルを使用してバスを定義でき
るのは MSO シリーズの機器のみです。

1. パラレル・バスを設定するには、Bus
Type で Parallel を選択します。

バスのセットアップの詳細について
は、オンライン・ヘルプを参照してく
ださい。

2. バスのソースを追加するには、Add
Sources の Select ボタンをクリックし
ます。

3. バスに含める各チャンネルのボタン
をクリックします。パラレル・バスの順
序はチャンネルを選択した順で決ま
ります。デジタル・チャンネルはソー
スとして MSO70000 シリーズの機器
でのみ使用できます。

4. OK ボタンをクリックします。
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5. バス内のチャンネルを移動するに
は、移動するチャンネルまでスクロー
ルして選択し、上矢印または下矢印
ボタンをクリックします。

6. バス内のチャンネルを削除するに
は、削除するチャンネルまでスクロー
ルして選択し、Remove ボタンをクリッ
クします。

7. チャンネルのスレッショルドを設定
するには、Thresholds の Setup ボタ
ンをクリックします。

8. 設定するスレッショルドごとに、チャ
ンネルの Threshold をダブルクリッ
クし、キーパッドまたは汎用ノブでス
レッショルドを入力します。

9. 目的のスレッショルドを設定したら、
OK ボタンをクリックします。

10. すべてのチャンネルに同一のス
レッショルドを設定するには、Digital
Threshold をダブルクリックし、キー
パッドでスレッショルドを入力します。
次に Apply をクリックします。

11.MSO70000C/DX シリーズの機器で
クロック・ソースと極性を設定するに
は、項目をダブルクリックして、表示
されるリストから選択します。クロッ
クのレベルを設定するには、Clock
Level をダブルクリックし、キーパッ
ドか汎用ノブを使用してレベルを入
力します。

バスの表示のセットアップ

バス・スタイルおよびデコーディングの設定が行えます。デジタル・チャンネルを使用してバスを定義できる
のは MSO シリーズの機器のみです。
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1. Digital > Bus Setup を選択します。

2. Display タブを選択します。

3. バスを選択するには、スクロールし
てバスを表示し、バスを選択します。

4. バス・デコーディングのリストからデ
コーディングを選択します。

Results Table の詳細についてはオンラ
イン・ヘルプを参照してください。

5. + ボックスをクリックしてビューを展開
するか (下位項目を表示する) 、ま
たは - ボックスをクリックしてビュー
を折り畳みます (下位項目を表示し
ない) 。
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6. ディスプレイの + ボックスまたは -
ボックスをクリックすることによって、
バス・ビューを追加したり削除するこ
ともできます。使用可能なビューとし
ては、トランザクション／トランスポー
ト、リンク／フレーミング／パケット、
物理／バイト／シンボル、およびビッ
ト・レベルがあります。

7. シンボル・テーブルを使用する場合
は、Use Symbol File チェックボック
スをオンにします。Browse をクリック
して、シンボル・テーブル・ファイル
を選択します。

バスによっては他の設定ができるも
のもあります。バスに応じて他の設
定も行います。

バスのセットアップの詳細について
は、オンライン・ヘルプを参照してく
ださい。
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MagniVu をオンにする場合とその目的
MSO5000B シリーズで MagniVu を使用すると、エッジの位置を高分解能で正確に判断することができます。
これによって、デジタル・エッジの正確なタイミング測定が可能になります。 通常のデジタル・チャンネル・サ
ンプリングの場合と比べて、最大 32 倍の詳細度で表示できます。

MagniVu レコードは、メインのデジタル・アクイジションと並行して取り込まれ、動作時でも停止時でも任意の
時点で利用できます。MagniVu は、トリガを中心として 10,000 個のポイントについて、最大分解能 60.6 ps で
サンプリングされたデータの超高分解能表示を可能にします。

注： MagniVu は、トリガ・ポイントを中心にして表示されます。長いレコード長で MagniVu をオンにすると、トリ
ガ・ポイント以外の場所を見たい場合、その部分が画面から外れてしまうことがあります。多くの場合、上側の
全体表示でデジタル信号を探し、状況に応じてパンすることで、デジタル・レコードを見つけることができます。

MagniVu の使用

1. D15 – D0 を押します。

2. Digital > MagniVu を選択して MagniVu
をオンにします。

ヒント

タイミング分解能が不十分と思われる場合は、MagniVu をオンにして分解能を高めてください。

MagniVu は常に取り込まれています。オシロスコープが停止している場合、MagniVu をオンにすると、別
のアクイジションを行わなくとも高分解能のデータが得られます。
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デジタル波形のアナログ特性の表示
iCapture では、デジタル・チャンネル信号のアナログ特性を表示することができます。波形のアナログ特性を
表示しながら測定を行う追加機能もあります。iCapture は MSO70000C/DX シリーズとオプション MSOU 型
を装備した DPO70000DX シリーズでのみ使用できます。

1. Vertical > Vertical Setup を選択し
ます。

2. Digital input の iCapture ボタンを押
します。

3. Digital Source をクリックし、アナログ
入力で渡すデジタル・チャンネルを
1 つ選択します。
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4. バスに取り込むアナログ波形のデジ
タル変換にチャンネルのスレッショル
ドを設定するには、Logic Properties
ボタンをクリックします。

5. チャンネル間で同じスレッショルド設
定を共有するか、チャンネルごとに
スレッショルドを設定するかを選択
します。これには、Channel Settings
をクリックし、リストから Shared また
は Independent を選択します。

6. 設定するスレッショルドごとに、チャ
ンネル・スレッショルドをクリックしま
す。スレッショルドの設定には、キー
パッドまたは汎用ノブを使用します。

7. 必要なスレッショルドを設定したら、
OK ボタンをクリックします。

ヒント

MSO70000DX シリーズで iCapture を使用する場合、トリガ信号としてデジタル・ソースを選択できます。
MSO70000C シリーズでは、iCapture でそのチャンネルがデジタル・チャンネルに選択されても、引き続
きアナログ・チャンネルでトリガします。

FastFrame モードの使用
FastFrame を使用すると、多くのトリガ・イベントを単一のレコードとして大きなレコードに取り込み、各レコー
ドを個別に表示して測定できます。タイム・スタンプを使用すると、特定のフレームの絶対トリガ時間や特定
の 2 つのフレームのトリガ間の相対時間を表示できます。
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1. Autoset を押して、水平、垂直、お
よびトリガのコントロールを設定する
か、または手動でコントロールを設
定します。

MSO/DPO70000DX シリーズ、MSO/DPO70000C シリーズ、および
DPO7000C シリーズ

MSO5000B シリーズおよび DPO5000B シリーズ

2. Horiz/Acq > FastFrame Setup... を
選択します
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3. FastFrame を押してオンにします。

4. Frame Size および # of Events
Frames を選択します。 次に汎用
ノブを使用して、それぞれを設定し
ます。 フレーム数は、取り込まれる
トリガ・イベントの数を表します。 フ
レーム・サイズは、各トリガ・イベント
（またはフレーム）で保存されるサン
プルの数です。 メモリ不足ですべて
のレコードを保存できない場合は、
フレーム数が減少します。 フレーム
長が短いほど、取り込めるフレーム
の数が増えます。

5. Frame Viewing コントロールを使用
して、表示するフレームを選択しま
す。

6. 複数のフレームを重ねて表示する
場合は、Overlay を選択します。

7. Time Stamps コントロールを使用し
て、基準フレームのソースとフレー
ム番号を選択します。基準フレーム
は、2 つのフレーム間の相対時間を
測定する際の開始ポイントとなりま
す。

ヒント

FastFrame モードでは、デジタル・チャンネルおよびデジタル・バスは使用できません。

FastFrame は、各トリガ・イベントに関連したデータを保持して、詳細な解析や視覚的な検証を行う場合
に使用します。

FastFrame は、イベント間に不要な長いデッド・タイムがあるような複数のイベントを取り込む場合に使用
します。
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Temp または Spectral を使用する場合、選択されたフレームが濃い青色で表示されて見にくい場合があ
ります。Normal、Green、あるいは Gray のカラー・パレットを使用すると、複数のフレームが最も見やすく
なります。

Average Summary Frame を選択すると、演算機能（アベレージング）を All Frames に適用するか、また
は Only Summary Frame に適用するかを設定できます。 サマリ・データに注目すればよい場合は、Only
Summary Frame を選択するとシステム・スループットが大幅に改善します。
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FastFrame フレーム・ファインダの使用
フレーム・ファインダでは、他のフレームとは異なる FastFrame のフレームを見つけることができます。

1. FastFrame フレームのソースを選択
します。

2. From Frame # および To Frame #
を入力して、検索範囲を設定しま
す。

3. Run/Stop を押して、アクイジション
を停止します。

MSO/DPO70000DX シリーズ、MSO/DPO70000C シリーズ、および
DPO7000C シリーズ

MSO5000B シリーズおよび DPO5000B シリーズ

4. Start をクリックして、検索を開始し
ます。
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フレーム・ファインダは異なるフレーム
を探し出して表示します。

5. 検索している異常が表示フレーム
内にない場合、No をクリックします。
フレーム・ファインダは別の異なる
フレームを検索します。

6. 検索している異常が表示フレーム
内にある場合は、Yes をクリックしま
す。

7. 検索を終了する場合は、Stop をク
リックします。

8. Run/Stop を押して、アクイジション
を再開します。

MSO/DPO70000DX シリーズ、MSO/DPO70000C シリーズ、および
DPO7000C シリーズ

MSO5000B シリーズおよび DPO5000B シリーズ
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TekLink および MultiScope トリガの使用
単一トリガ・イベントに 4 チャンネル以上を関連付けたり、4 チャンネル以上使用して 1 チャンネル上の問題
を観察したり、4 入力以上の大きな AND ゲートを構築する場合は TekLink を使用します。

注： MultiScope トリガを使用する場合、B トリガは使用できません。TekLink と MultiScope トリガは、DPO7000
シリーズ、MSO5000B シリーズ、および DPO5000B シリーズの機器では使用できません。

2 つの機器の接続

1. TekLink ケーブルを使用して 2 つ
の機器を接続します。

2. TekLink の接続ステータスは水平
リードアウトに表示されます。

3. Trig > A Event (Main) Trigger
Setup... を選択します。
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4. MultiScope Trigger タブを選択しま
す。

5. Enable MultiScope Triggering (with
TekLink) を選択して、MultiScope ト
リガを有効にします。

6. 機器間の設定で Sends Trigger を
選択し、この機器により両方の機器
をトリガできるようにします。もう一方
の機器は、トリガを受け取るように自
動的に設定されます。

ハブを使用しない場合、トリガを送
る機器ではすべてのトリガ・タイプを
使用できます。

7. MultiScope トリガを校正するには、
Align ボタンをクリックします。

複数機器の接続

TekLink ハブを使用すると、複数の機器を接続できます。

1. TekLink ハブおよびケーブルを使
用して 2 つ以上の機器を接続しま
す。

2. TekLink の接続ステータスは水平
リードアウトに表示されます。
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3. Trig > A Event (Main) Trigger
Setup... を選択します。

4. MultiScope Trigger タブを選択しま
す。

5. Enable MultiScope Triggering (with
TekLink) を選択して、MultiScope ト
リガを有効にします。

6. TekLink の設定で Contribute を選
択し、この機器がトリガを供給する
ようにします。他の機器は、トリガを
受け取るように自動的に設定されま
す。

7. TekLink の設定で、すべての機器
をトリガする前に、提供されたトリガ
を組み合わせるには、AND または
OR を選択します。

ハブを使った AND トリガでは、エッ
ジ・トリガとパターン・トリガを使用で
きます。

ハブを使った OR トリガでは、すべ
てのトリガ・タイプを使用できます。

8. MultiScope トリガのアライメントを行
うには、Align ボタンを押します。
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9. TekLink ネットワークをスキャンして、
TekLink ネットワークに接続されて
いる機器を確認するには、Refresh
ボタンを押します。

10.MultiScope トリガが有効になってい
る場合は、トリガ・リードアウトに表示
されます。
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ピンポイント・トリガ

ピンポイント・トリガ・システムは、A および B トリガの両方で使用できる拡張トリガ・タイプを備えており、特定
の数のイベントや一定の時間の後で B イベントが発生しない場合に、トリガ・シーケンスをリセットすることが
できます。ピンポイント・トリガは、最も複雑なトリガ・イベントや連続したトリガ・イベントを基にしたイベントの
取り込みをサポートしています。
MSO5000B シリーズおよび DPO5000B シリーズの機器では Pinpoint トリガの一部の機能しか使用できませ
ん。

このセクションでは、トリガ・システムを使用する概念と手順について説明します。詳細については、オンライ
ン・ヘルプを参照してください。

トリガの概念

トリガ・イベント

トリガ・イベントは、波形レコードに時刻ゼロ・ポイントを設定します。すべての波形レコード・データは、その
ポイントを基準にして時間順に並べられます。機器は、波形レコードのプリトリガ部分が一杯になるまで、サ
ンプル・ポイントを連続的に取り込んで保持します。トリガ・イベントが発生すると、機器はサンプルの取り込
みを開始して、波形レコードのポストトリガ部分（トリガ・イベントの後、つまり右側に表示される部分）を作成
します。トリガが認識されると、アクイジションが完了し、ホールドオフ時間が切れるまで、機器は次のトリガを
受け入れません。

トリガ・モード

トリガ・モードは、トリガ・イベントがない場合に機器の動作を決定します。

ノーマル・トリガ・モードは、トリガされた場合にだけ機器が波形を取り込むことができるようにします。トリ
ガが発生しない場合は、直前に取り込まれた波形レコードが表示されたままになります。直前の波形が
存在しない場合は、波形は表示されません。

オート・トリガ・モードは、トリガが発生しない場合でも、機器が波形を取り込むことができるようにします。
オート・モードは、トリガ・イベントの発生後に開始されるタイマを使用します。タイマーのタイムアウトまで
に別のトリガ・イベントが検出されないと、機器は、強制的にトリガを実行します。トリガ・イベントを待機す
る時間は、タイムベース設定に基づきます。

オート・モードでは、有効なトリガ・イベントがなくてもトリガが強制され、ディスプレイ上の波形が同期しませ
ん。波形は、画面全体に波打って表示されます。有効なトリガが発生すると、表示は安定します。

エッジ・トリガ・モードでは、Trigger Setup コントロール・ウィンドウで Force Trigger ボタンをクリックし、強制
的にトリガを実行することができます。

Trig > Mode メニューで、トリガ・モードを選択します。詳細については、機器のオンライン・ヘルプを参照し
てください。

トリガ・ホールドオフ

アクイジションを開始した後、それ以降にトリガを認識させない期間を延長することで、トリガ・ホールドオフは
トリガを安定させるのに役立ちます。そのように延長することで、システムが繰り返しバーストの残りのイベント
をスキップするのに役立ち、各バーストでは必ず最初のイベントでトリガが行われるようになります。機器が好
ましくないトリガ・イベントでトリガしている場合は、ホールドオフを調整すると、安定したトリガが得られます。
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Trig > Holdoff メニューで、トリガ・ホールドオフを設定します。詳細については、機器のオンライン・ヘルプ
を参照してください。

トリガ・カップリング

トリガ・カップリングにより、トリガ回路に渡す信号の部分を指定します。エッジ・トリガでは、有効なすべての
カップリング・タイプ（AC、DC、低周波除去、高周波除去、ノイズ除去）を使用できます。その他のトリガ・タイ
プでは、DC カップリングのみを使用します。機器によっては、使用できないカップリング・タイプもあります。

Trig > A Event (Main) Trigger Setup メニューで、トリガ・カップリングを選択します。詳細については、機器の
オンライン・ヘルプを参照してください。

水平位置

水平位置により、波形レコード上でトリガが発生する位置を定義します。この操作により、機器がトリガ・イベ
ントの前後に取り込みを行う数を選択できます。トリガの前にあるレコードは、プリトリガ部分です。トリガの後
にあるレコードは、ポストトリガ部分です。

プリトリガ・データはトラブルシューティングに役立ちます。たとえば、テスト回路にある不要なグリッチの原因
を調査する場合は、プリトリガ期間を十分に長くしてグリッチでトリガすることで、グリッチの前のデータを取り
込みます。グリッチの前に発生する事象を解析することにより、グリッチの原因の調査に役立つ情報を入手
できる可能性があります。または、トリガ・イベントの結果としてシステムで発生している事象を観察する場合
は、ポストトリガ期間を十分に長くして、トリガ後のデータを取込みます。

スロープおよびレベル

スロープ・コントロールは、信号の立上りエッジと立下りエッジのどちらでトリガ・ポイントを検出するかを決定
します。レベル・コントロールは、トリガ・ポイントがあるエッジ上の場所を決定します。

遅延トリガ・システム

A（メイン）トリガ・システムだけを使用してトリガすることも、A（メイン）トリガと B（遅延）トリガを併用して連続的
なイベントをトリガすることもできます。連続的なトリガを使用する場合は、A トリガ・イベントによりトリガ・シス
テムが動作可能になり、B トリガ条件が満たされると、B トリガ・イベントにより機器がトリガされます。A トリガと
B トリガには、個別のソースを設定できます（通常はこのようにします）。B トリガ条件は、時間遅延や特定の
イベント数に基づいて設定します (79 ページ 「A（メイン）トリガおよび B（遅延）トリガの使用」 参照)。
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トリガ・タイプの選択

本機器では、前面パネルで基本的なトリガ・パラメータを変更したり、Trigger Setup コントロール・ウィンドウ
でより高度なトリガをセットアップしたりすることができます。

注： 機器によっては選択できないトリガ・タイプもあります。

1. Trig > Edge Setup を選択します。

2. セットアップのメニューからソース、
スロープ、カップリング、およびモー
ドを設定します。
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3. 他のトリガ・タイプを選択するには、
Trig メニューから直接トリガ・タイプ
を選択します。

4. トリガ・タイプに表示されるコントロー
ルを使用して、トリガの設定を完了
します。トリガを設定するためのコン
トロールは、トリガ・タイプ、機器のモ
デル、またオプションにより異なりま
す。
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トリガ一覧

トリガ・タイプ トリガの設定できる場合

エッジ スロープ・コントロールの定義に従い、立上がりエッジまたは立下りエッジ
にトリガさせます。カップリングとして、DC、AC、LF 除去、HF 除去、およ
びノイズ除去を選択できます。

グリッチ 指定した幅よりも狭い（または広い）パルスの場合にトリガさせるか、指定
した幅よりも狭いグリッチを無視します。

パルス幅 指定した時間範囲内または範囲外のパルスでトリガさせます。正のパル
スまたは負のパルスでトリガできます。

ラント 2 つのしきい値の一方を通過してから他方を通過する前に、最初のしき
い値を再度通過するパルス振幅でトリガします。正または負のラント、また
は指定した幅より広いラントを検出できます。これらのパルスは、他のチャ
ンネルのロジック・ステートでもクオリファイできます。

ウィンドウ 入力信号が上限しきい値レベルを超えた場合、または下限しきい値レベ
ルを下回った場合にオシロスコープをトリガさせます。信号がしきい値ウィ
ンドウに入ったときまたは出たときに機器をトリガさせます。Trigger When
Wider オプションを使用して時間により、または Trigger When Logic オプ
ションを使用して他のチャンネルのロジカル・ステートにより、トリガ・イベ
ントをクオリファイします。

タイムアウト 指定した時間内に パルスが検出されない場合にトリガします。

トランジション 指定した時間より高速または低速に 2 つのしきい値の間を遷移するパル
ス・エッジを検出してトリガさせる。パルス・エッジは正または負です。

シリアル 64 ビットの NRZ シリアル・パターンでは最大 1.25 Gb/s のデータ・レート、
4 つの 8b/10b シンボルでは最大 6.25 Gb/s のデータレートでトリガします
(MSO70000C/DX シリーズおよび DPO70000C/DX シリーズのみ)。オプ
ション ST1G 型 (DPO7000C シリーズ) または ST6G 型 (MSO70000C/DX
シリーズおよび DPO70000C/DX) が必要です。クロック・リカバリが含まれ
ます。クロック・リカバリを再度初期化するには、Push to Set 50% コントロー
ルを押します。

位置・ロック機能は、長い期間にわたって繰り返される擬似ランダム・ビッ
ト・シーケンス（PRBS）を自動検出し、追従します。追従とは、機器が擬似
ランダム・ビット・シーケンスのビット長を認識していて、どのタイミングでサ
イクルが繰り返されるかを予測できる、ということを意味します。位置・ロッ
クを使用すると、優れたタイム・ベース確度でデータ・パターンの特定の
場所から機器にサンプルを取り込むことが可能です。オプション ST1G 型
または ST6G 型が必要です。

パターン ロジック入力信号によって選択した関数が True または False になる場合
にトリガします。指定した時間だけ論理条件を満たしてからトリガするよう
に指定することもできます。

複数のソースまたは外部トリガを使用する場合は iCapture 入力はお勧め
できません。

ステート クロック入力の状態が変化したときに、選択した論理関数へのすべてのロ
ジック入力によって関数が True または False になるときにトリガします。

複数のソースまたは外部トリガを使用する場合は iCapture 入力はお勧め
できません。
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トリガ・タイプ トリガの設定できる場合

セットアップ /
ホールド

クロックを基準にしてセットアップ時間内およびホールド時間内にロジック
入力の状態が変化した場合にトリガします。このモードは、セットアップ違
反およびホールド違反をトリガします。

複数のソースまたは外部トリガを使用する場合は iCapture 入力はお勧め
できません。

コミュニケー
ション

通信コードおよび通信スタンダードに基づいたマスク・テストでトリガしま
す（アナログ・チャンネルのみ）。トリガ・イベントのパラメータは、コントロー
ルを使用して指定できます（一部の機器でオプション MTM 型またはオ
プション MTH 型で利用可能）。このモードにはクロック・リカバリが含まれ
ています。クロック・リカバリを再度初期化するには、Push to Set 50% ノブ
を押します。

バス 定義したバスのコンポーネント（指定したアドレスなど）でトリガします。一
部の機器とオプションによりパラレル、 SPI、RS-232、USB、および I2C の
トリガが可能です。

複数のソースまたは外部トリガを使用する場合は iCapture 入力はお勧め
できません。

ビデオ コンポジット・ビデオ信号の指定したフィールド、またはラインでトリガしま
す（DPO7000C シリーズ、MSO5000B シリーズ、および DPO5000B シリー
ズのみ）。 コンポジット信号フォーマットのみがサポートされています。

CAN CAN バス信号でトリガします。

複数のソースまたは外部トリガを使用する場合は iCapture 入力はお勧め
できません。

RS-232 RS-232 信号でトリガします（DPO7000 シリーズのみ）。

複数のソースまたは外部トリガを使用する場合は iCapture 入力はお勧め
できません。

I2C 開始（Start）、停止（Stop）、繰り返し開始（Repeated Start）、ACK なし
（Missing Ack）、アドレス（Address）、データ（Data）、アドレスとデータ
（Address/Data）などの Inter-IC 制御（I2C）信号でトリガします。

複数のソースまたは外部トリガを使用する場合は iCapture 入力はお勧め
できません。

SPI シリアル・ペリフェラル・インタフェース（SPI）信号でトリガします。

複数のソースまたは外部トリガを使用する場合は iCapture 入力はお勧め
できません。
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トリガ・ステータスのチェック
トリガ・ステータスは、前面パネルのステータス・ランプまたはリードアウトでチェックできます。

Arm、Ready、Trig'd の各コントロールを
チェックして、トリガのステータスを確認
します。

Trig’d がオンの場合、機器は有効
なトリガを取り込み、波形のポストト
リガ部分の処理を実行しています。

Ready がオンの場合、機器は、有効
なトリガの発生を受け入れることが
でき、トリガを待機しています。プリ
トリガのデータは取り込まれていま
す。

Arm がオンの場合、トリガ回路は、
波形レコードのプリトリガ部分を処
理しています。

Trig'd と Ready がオンの場合は、
有効な A イベント・トリガが認識さ
れ、機器は遅延トリガを待機してい
ます。遅延トリガが認識されると、遅
延波形のポストトリガ部分が処理さ
れます。

Arm、Trig'd、Ready がオフの場合、
アクイジションは停止しています。

MSO/DPO70000DX シリーズ、MSO/DPO70000C シリーズ、DPO7000C
シリーズ

いくつかの主要なトリガ・パラメータの
設定をすばやく確認するには、表示の
下部でトリガ・リードアウトをチェックしま
す。リードアウトは、エッジ・トリガと拡張
トリガで異なります。

1. A トリガ・ソース = Ch1

2. トリガ・スロープ = 立上りエッジ

3. トリガ・レベル

4. 時間軸

5. ARM（動作可能）、READY（準備完
了）、TRIG'D（トリガ済み）の各リード
アウトをチェックして、トリガのステー
タスを確認します。

6. Auto/Normal のリードアウトをチェッ
クしてトリガ・モードを確認します。
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A（メイン）トリガおよび B（遅延）トリガの使用
単純な信号に対して A イベント（メイン）トリガを使用し、より複雑な信号を取り込むために B イベント（遅延）
トリガと組み合わせて使用することができます。トリガ・システムは、A イベントの発生後に、B イベントを検出
してからトリガして波形を表示します。

A トリガ

1. Trig > A Event (Main) Trigger
Setup... を選択します。

2. A Event タブで A トリガ・タイプとソー
スを設定します。

B トリガ（遅延）

注： MultiScope トリガが有効になって
いる場合、B トリガは使用できません。

3. A →B Seq（A → B シーケンス）で
関数を選択します。

4. トリガ遅延時間または B イベント数
を設定します。

MSO/DPO70000DX、MSO/DPO70000C、DPO7000C、および MSO/DPO5000B シリーズ・ユーザ・マニュアル 79



ピンポイント・トリガ

5. B Event（遅延）タブで、B トリガの特
性を設定します。

6. Mode タブで、Trigger Mode の Nor-
mal および Holdoff の Auto 選択し
ます。

B イベントに対するトリガ

A トリガが機器を動作可能にします。ポ
ストトリガ・アクイジションが、n 番目の B
イベントから開始されます。

遅延時間を使用した B トリガ

A トリガが機器を動作可能にします。ポ
ストトリガ・アクイジションは、トリガ遅延
時間が経過した直後の B エッジで開
始されます。
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リセットによるトリガ

B トリガ・イベントが発生した場合に、ト
リガ・システムをリセットする条件を指定
できます。リセット・イベントが発生した
場合に、トリガ・システムは、B イベント
の待機を停止し、A イベントの待機に
戻ります。

トリガのリセットは、MSO5000B シリーズ
および DPO5000B シリーズの機器では
使用できません。

ヒント

B トリガ遅延時間と水平遅延時間は、別々の機能です。A トリガのみを使用して、または A トリガと B ト
リガの両方を併用してトリガ設定を行う場合、水平遅延を併用すればアクイジションをさらに遅延させる
ことができます。

トリガ位置の修正

トリガ位置修正機能は、データ・パスおよびトリガ・パスにおける誤差を修正し、表示されている波形にトリガ
をより正確に配置します。また、このトリガ位置修正機能では、アベレージングを使用して、ノイズの多い信
号へのトリガ配置を正確に行うこともできます。エッジ・トリガをより正確に波形に配置するには、次の手順を
実行します。

1. 波形にトリガをより正確に配置するに
は、Enhanced Triggering チェック・
ボックスをオンにします。ノイズの多
い信号にトリガをより正確に配置す
るには、さらに、Optimized for Noisy
Signals チェック・ボックスをオンにし
ます。

Optimized for Noisy Signals は、
Enhanced Triggering をオンにした
場合にのみ選択できます。
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B イベント・スキャンを使用するトリガ
A トリガ・イベントにより同期または開始されたオーバーラップするアイ・ダイアグラムを作成するには、A->B
Seq タブで B Event Scan を On に設定します。

B イベント・スキャンは、MSO5000B シリーズおよび DPO5000B シリーズの機器では使用できません。

Trig on nth Event を設定すると、アクイジション全体の中で A イベント後に発生する n 番目の B イベントが
取り込まれます。B Event Scan を設定すると、B イベント値に増分が自動的に加えられ、そのたびに信号の
異なる領域が取り込まれます。

1. A Event タブで A トリガのタイプと
ソースを設定します。

2. B Event タブで B トリガのタイプと
ソースを設定します。

3. 波形にトリガをより正確に配置するに
は、Enhanced Triggering チェック・
ボックスをオンにします。ノイズの多
い信号にトリガをより正確に配置す
るには、さらに、Optimized for Noisy
Signals チェック・ボックスをオンにし
ます。
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4. A>B Seq タブで、Trig on nth Event
と B Event Scan を選択します。

5. B Event Scan > Setup を押して、B
Event Scan Setup ウィンドウを表示
します。

6. B イベントの開始値を設定します。

7. B イベントの終了値を設定します。

8. B イベント値に増分を加えるまでの
アクイジション回数を設定します。

9. 指定回数のアクイジション発生後の
B イベント値の増分方法を選択しま
す。

Sequential Scan： 終了値に達す
るまで 1 ずつ加えます。終了値
に達した後は、B イベント値を開
始値にリセットしてプロセスを再
開します。

Random Scan ： Advance After
ボックスで指定した回数のアク
イジションごとに、B イベント値を
開始値と終了値の間のランダム
な値に設定します。

Toggle Between Events ： Ad-
vance After ボックスで指定した
回数のアクイジションごとに、B
イベント値を開始値と終了値に
交互に切り替えます。
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10. ここに示す図では、DDR3 の DQS
信号が Ch 1、DQ 信号が Ch 2 で
す。この機器は Run Mode であり、
Display Mode は Infinite Persistence
に設定されています。この機器のト
リガ設定は以下のとおりです。

A Event タブで、Trigger Type を
Window、Source を Ch 1 に設定
し、DDR3 DQS 書き込み状況を
検出します。

B Event タブで、Trigger Type を
Edge に、Source を Ch 2 に設定
し、DQ（クロック）のエッジをトリ
ガします。

A->B Seq タブで、Trig on nth
Event を選択します。

B Event Scan Setup ウィンドウ
で、Start Event = 1、End Event
= 8 に設定し、Sequential Scan
モードを選択します。

データのアイは Ch 2 の DQ 信
号により形成されます。
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パラレル・バスでのトリガ
パラレル・バスでトリガして問題を調べることができます。MSO 機器はデジタル・チャンネルをパラレル・バス
のコンポーネントとして使用できます。

1. Trig > A Event (Main) Trigger
Setup... を選択します。

2. A Event タブを選択します。
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3. Bus トリガ・タイプを選択します。

4. トリガをオンにするバスを選択しま
す。

注： クロック同期バスは、クロック・ソー
スが Ch4 にセットされている場合のみ、
ドロップダウン・リストに表示されます。

5. Edit ボタンをクリックして、トリガする
パターンおよびフォーマットを設定
します。
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6. データ・フォーマットの選択

7. キーパッドを使用して、トリガするパ
ターンを設定します。

8. 波形を解析します。
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シリアル・バスでのトリガ

シリアル・バスでトリガして問題を特定します。シリアル・バスは MSO/DPO70000DX シリーズ、MSO/DPO70000C
シリーズ、DPO7000C シリーズ、MSO5000B シリーズ、および DPO5000B モデルでのみ使用できます。 デジタ
ル・チャンネルは MSO 機器のバス定義に使用できます。

シリアル・バスをセットアップします(53 ページ 「バスのセットアップ」 参照)。

1. Trig > A Event (Main) Trigger
Setup... を選択します。

2. A Event タブを選択します。

3. Bus トリガ・タイプを選択します。
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4. バスを選択します。

5. トリガするバス信号を選択します。

6. Trigger On の選択とバスのタイプに
従って、必要なバスの選択を行いま
す。

バスのセットアップの詳細について
は、オンライン・ヘルプを参照してく
ださい。

ビジュアル・トリガによるトリガ
ビジュアル・トリガ機能により、トリガ条件をディスプレイ・スクリーンで直接設定することができます （ビジュア
ル・トリガは、一部のモデルではオプションです）。

1. ビジュアル・トリガ領域を作成する
には、まず画面を左クリックしてその
ままドラッグし、任意の四角形を作
成します。次に、メニューから Add
Visual Trig Area を選択します。

注： 同じメニューから、すべてのビジュ
アル・トリガ領域の表示と非表示を切り
替えたり、ビジュアル・トリガ機能自体の
オン・オフを切り替えることができます。
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2. 領域をクリックすると、そのハンドル
が有効になります。領域をクリックし
て、希望の位置にドラッグすることが
できます。枠のハンドルをクリック、
ドラッグすると、垂直方向および水
平方向に領域の大きさを調整でき
ます。

3. ビジュアル・トリガ領域を右クリック
し、メニューから Visual Trigger Area
を選択します。

このメニューで、トリガ領域を編集した
り、ビジュアル・トリガの条件を設定する
ことができます。

ビジュアル・トリガを作成し、編集する
方法の詳細についてはオンライン・ヘ
ルプを参照してください。

4. Trig メニューから Visual Trigger
Setup を選択し 、 Visual Trigger
equation をダブルクリックします。

Qualification Expression Editor の使用
方法の詳細についてはオンライン・ヘ
ルプを参照してください。
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Action on Event の設定
Action on Event 機能により、例えばトリガ・イベントやマスク・エラー、リミット・テストのエラーなど、特定の条
件に合致する状況が発生したときにさまざまなファイルを自動的に保存するよう、オシロスコープを設定する
ことができます。

1. File > Action on Event を選択しま
す。

2. 使用するイベントを選択します。

3. イベントが発生したときに取るアク
ションを選択します。セーブ、電子
メールの送信、あるいはその両方が
選択できます。

保存の詳細を設定するには、Setup ボ
タン （Save ボタンの隣）を使用します。

電子メールの詳細を設定するには、
Setup ボタン （Save E-mail ボタンの隣）
を使用します。 (93 ページ 「イベント時
の電子メールの設定」 参照)。

4. ファイルを保存する場所を選択しま
す。

5. 保存の条件となるイベントを選択し
ます。

6. イベント発生時に保存するファイル
の形式を選択します。

7. ファイルの命名規則を設定します。

8. 保存するイベントの数を指定します。
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トリガ時の電子メールの送信
以下の手順を実行する前に、イベント時の電子メールを設定する必要があります。(93 ページ 「イベント時
の電子メールの設定」 参照)。

1. Trig > A Event (Main) Trigger
Setup... を選択します。

2. Mode タブを選択します。

3. E-mail on Trigger で On をクリック
してから、Setup をクリックします。
(93 ページ 「イベント時の電子メー
ルの設定」 参照)。
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イベント時の電子メールの設定

1. Utilities > E-mail on Event >
Setup... を選択します。

2. 受信者の電子メール・アドレス（1 つ
または複数）を入力します。エントリ
が複数ある場合は、カンマで区切り
ます。電子メール・アドレス・ボックス
に入力できる文字数は 252 文字ま
でです。

3. Config をクリックして、次に SMTP
サーバー・アドレスを入力します。ア
ドレスについては、ネットワーク管理
者に問い合わせてください。
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4. 電子メール送信の必要なイベント（1
つまたは複数）を選択します。

5. 添付ファイルを含めるには、添付
ファイルのタイプを選択してから、
Settingsをクリックしてフォーマットを
指定します。

6. メッセージ数の上限および電子メー
ルの最大サイズを設定しますメッ
セージ数が上限に達した場合、引
き続きイベント通知のメールが送信
されるようにするには、Reset をクリッ
クする必要があります。

7. 設定した電子メール･アドレスが正し
いことを確認するには、Send をクリッ
クしてテスト・メールを送信します。

8. 必要な場合はConfig をクリックして、
電子メールの構成ダイアログボック
スで構成を調整します。
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水平遅延の使用

トリガの場所から時間が大きく離れてい
るエリアで波形の詳細を取り込む場合
は、水平遅延を使用します。

1. Horiz/Acq（水平軸／アクイジショ
ン）> Horizontal/Acquisition Setup
（水平 / アクイジションの設定）を選
択します。

2. Delay Mode ボタンを押して遅延
モードをオンにします。

3. 水平方向の Position コントロールで
遅延時間を調整するか、コントロー
ル・ウィンドウで遅延時間を入力し
ます。

4. 水平方向の Scale を調整し、遅延
拡張ポイントの周辺で必要な詳細
を取り込みます。

ヒント

遅延アクイジションの拡大には、MultiView Zoom と Horizontal Delay を併用します。

水平遅延の ON と OFF を切り替えると、トリガ位置近くの領域と遅延時間を中心とした領域の 2 つの対
象領域の信号詳細を素早く比較できます。
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波形の表示

このセクションでは、波形の表示の概念と手順について説明します。詳細については、オンライン・ヘルプ
を参照してください。

表示スタイルの選択

表示スタイルを設定するには、Display
> Display Style をクリックしてから、次の
いずれかのスタイルを選択します。

レコード・ポイント間が
線で結ばれた波形を
表示します。

波形のレコード・ポイ
ントを画面上にドットで
表示します。

実際のサンプルを表
示します。補間された
ポイントは表示されま
せん。
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表示パーシスタンスの設定

Display > Display Persistence を選択し
てから、パーシスタンスのタイプを選択
します。

No persistence は、現在のアクイジ
ションの波形レコード・ポイントだけ
を表示します。新しいそれぞれの
波形レコードは、前に取り込まれた
チャンネルのレコードを置き換えま
す。

Infinite persistence は、アクイジショ
ン・ディスプレイ設定の 1 つを変更
するまで、連続的にレコード・ポイン
トを累積します。ノーマル・アクイジ
ション・エンベロープの外側にある
ポイントの表示に使用します。

Variable persistence では、指定され
た時間インターバルの間、レコード・
ポイントを蓄積します。各レコード・
ポイントは、タイム・インターバルに
従って個別に減衰します。

Reset persistence は、パーシスタン
スをクリアします。

1. 可変パーシスタンスの時間を設定
するには、Display > Display Persis-
tence > Persistence Controls... を
選択します。

2. Persist Time をクリックしてから、汎
用ノブを使って、残光時間を設定し
ます。
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表示フォーマットの設定
機器は、3 つの異なるフォーマットで波形を表示できます。目的に最もよく合うフォーマットを選択してくだ
さい。

Display > Display Formatを選択します。

時間の経過とともに変化する信号振
幅を表示するには、YT フォーマッ
トを選択します。

XY フォーマットを選択すると、波形
レコードの振幅をポイントごとに比
較できます。

次のチャンネルが比較されます。

Ch 1（X）と Ch 2（Y）、

Ch 3（X）と Ch 4（Y）、

Ref 1（X）と Ref 2（Y）、

Ref 3（X）と Ref 4（Y）

CH1 （X）および CH2 （Y）波形レ
コードの電圧レベルを XY フォー
マットと同様にポイントごとに比較す
るには、XYZ フォーマットを選択し
ます。表示される波形輝度は、CH
3（Z）の波形レコードによって変調さ
れます。XYZ フォーマットはトリガさ
れます。CH3 の -5 目盛の信号（位
置とオフセットを含む）では、画面に
何も表示されません。また、+5 目盛
の信号は、最高の輝度で表示され
ます。

ヒント

XY フォーマットは、リサージュ・パターンなどの位相の関係を調べる場合に特に便利です。

XY フォーマットはドットだけの表示ですが、パーシスタンスを設定できます。XY フォーマットを選択した
場合は、Vector スタイルを選択しても無効になります。
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波形補間の選択

Display > Waveform Interpolation を選
択してから、次のいずれかを選択しま
す。

Sin(X)/X 補間法は、取り込んだ実
際のサンプル間の曲線適合を使用
してレコード・ポイントを計算します。

直線補間法は、直線を使用して、
実際の取り込みサンプルの間のレ
コード・ポイントを計算します。
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ヒント

Sin(X)/X 補間法は、デフォルトの補間モードです。このモードでは、直線補間法の場合よりサンプル・ポ
イントの数が少なくても、波形を正確に表現できます。

スクリーン・テキストの追加

1. Display > Screen Text を選択しま
す。

2. 最大 8 つの独立したテキスト行を入
力できます。

3. Text の Off または On をクリックす
ると、テキスト表示のオン／オフを切
り替えることができます。

4. Font または Color をクリックすると、
画面テキストのフォントと色を選択
できます。

5. Controls を ク リックすると、 Text
Properties コントロール・ウィンドウ
が開きます。ここでは、ディスプレ
イ上のテキストの配置を指定できま
す。

6. Clear をクリックして、選択した行の
テキスト全体を消去します。

ヒント

画面のテキストをクリックしてドラッグすると、画面上の位置を変更できます。

波形やバスにもラベルを付けることができます。 (52 ページ 「デジタル・チャンネルのセットアップ」 参
照)。 (53 ページ 「バスのセットアップ」 参照)。

100 MSO/DPO70000DX、MSO/DPO70000C、DPO7000C、および MSO/DPO5000B シリーズ・ユーザ・マニュアル



波形の表示

目盛スタイルの選択

目盛スタイルを設定するには、 Display
> Graticule Style を選択し、以下のいず
れかのスタイルを選択します。

波形パラメータをすば
やく測定するために使
用します。

クロスヘアが不要な場
合に、カーソルや自動
リードアウトによる全画
面測定に使用します。

このスタイルは、自動
リードアウトなどのデー
タを表示する領域を
残したまま、波形パラ
メータをすばやく測定
するために使用しま
す。

ディスプレイ機能が不
要な場合に、自動リー
ドアウトなどのスクリー
ン・テキストと共に使用
します。

ディスプレイ機能が不
要な場合に、自動リー
ドアウトなどのスクリー
ン・テキストと共に使用
します。

ディスプレイ機能が不
要な場合に、自動リー
ドアウトなどのスクリー
ン・テキストと共に使用
します。

Solid は Full に似てい
ますが、グリッド、クロ
スヘア、および枠を実
線で描画します。
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トリガ・レベル・マーカの設定

1. Display > Objects... を選択します。

2. 以下のいずれかを選択します。

Short は、目盛の片側に短い矢
印を表示します。

Long は、目盛全体にわたる水平
線を表示します。

Off は、トリガ・レベル・マーカを
オフにします。

日付と時刻の表示

1. Display > Objects... を選択します。

2. 目盛にある日時の表示を切り換え
ます。Utilities メニューを使って、日
時を設定します。
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カラー・パレットの使用

Display > Record View Paletteまたは
FastAcq/WfmDB Palette を選択してか
ら、次に示す波形および目盛のカラー・
スキームのいずれかを選択します。

Normal は、全体的に最適な色調と
明るさのレベルで表示します。各
チャンネル波形の色は、前面パネ
ルにあるそれぞれの垂直ノブの色
に対応しています。

Temperature Grading は、サンプル
密度の最も高い波形エリアを赤の
影で表示します。サンプル密度の
最も低いエリアは、青の影で表示さ
れます。

Monochrome Green は、サンプル密
度の最も高い波形エリアを明るい緑
の影で表示します。サンプル密度の
最も低いエリアは、暗い緑の影で表
示されます。アナログ・オシロスコー
プのディスプレイに最も近いモード
です。

Spectral Grading は、サンプル密度
の最も高い波形エリアを青の影で表
示します。サンプル密度の最も低い
エリアは、赤の影で表示されます。

Monochrome Gray は、サンプル密
度が最も高い波形エリアを明るいグ
レーの影で表示します。サンプル密
度が最も低いエリアは、暗いグレー
の影で表示されます。

User は、ユーザが定義した色で波
形を表示します。

ヒント

Display > Colors コントロール・ウィンドウのカラー・グレーディング・パレットの 1 つを選択すると、サンプ
ル密度により色分けされた表示になります。

Record View 用と FastAcq/WfmDB 用の 2 つのカラー・パレットがあります。
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リファレンス波形色の設定

Display > Colors... を選択してから、次
のいずれかを選択します。

Default は、リファレンス波形にデ
フォルトのシステム・カラーを使用し
ます。

Inherit は、リファレンス波形に元の
波形と同じカラーを使用します。

演算波形色の設定

Display > Colors... を選択してから、次
のいずれかを選択します。

Default は、演算波形にデフォルト
のシステム・カラーを使用します。

Inherit は、演算波形に対して演算
関数の基になる 1 番小さい番号の
チャンネル波形と同じ色を使用しま
す。

ヒント

演算およびリファレンス波形のデフォルト・カラーは、各波形で異なります。

MultiView ズームの使用
取り込んだ波形を垂直方向、水平方向、または両方向に拡大する場合は、MultiView ズーム機能を使用し
ます。ズームした波形は、整列またはロックさせたり、自動的にスクロールさせること もできます。スケーリン
グと位置は、表示のみに影響し、実際の波形データには影響しません。

1. MultiView ズームがオフの場合は、
MultiView ズームを押して画面を分
割し、ズーム目盛を追加します。
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2. Horiz または Vertを押して、ズーム
の目盛で拡大する軸を選択します。
ズーム波形のスケールと位置を調整
するには、汎用ノブを使用します。

この例では、メイン目盛が目盛の上
半分に、ズーム目盛が目盛の下半
分になっています。

注： ズーム波形の表示/非表示を切り
替えるには、Show/Hide Waveforms を
押して、表示するズーム波形を指定し
ます。

3. ズーム目盛のサイズを調整する
には、Vertical または Horiz/Acq メ
ニューから Zoom Graticule Size を
選択します。

4. MultiView ズームがオンでリードアウ
トがズーム・コントロールに連結して
いない場合は、MultiView ズーム・
ボタンを押して、リードアウトをズー
ム・コントロールに連結します。 ズー
ムをオフにするには MultiView ズー
ム・ボタンを再び押します。

ヒント

Zoom Setup メニューを使用して、ズームされる波形の目盛サイズを変更することもできます。

長いレコード長の波形を管理するには Wave Inspector を使用します (110 ページ 「Wave Inspector を使
用して長いレコード長の波形を管理する」 参照)。
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複数エリアのズーム
1 つのレコード内の複数の領域を同時に表示し、比較する場合は、次の手順を使用します。

1. ズームする波形領域の周りをクリッ
クし、四角にドラッグします。

2. Zoom 1 On を選択します。

3. ズームするもう一つの波形領域の
周りをクリックし、四角にドラッグして
から、 Zoom 2 On を選択します。

4. ズームしたエリアを水平方向に調整
するには、Zoom ボックスの下にある
水平マーカをクリックし、ズームした
エリアを選択します。

5. 汎用ノブを使って、選択したズーム・
エリアの水平位置と倍率を調整しま
す。
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6. ズームした領域を垂直方向に調整
するには、Vertical > Zoom Setup...
を選択して、垂直フィールドをクリッ
クし、汎用ノブを使用して Vertical
Position と Factor を調整します。

ヒント

ズーム・エリアをクリアするには、Zoom Setup コントロール・ウィンドウから、Position Factor Reset をクリッ
クします。

Zoom Setup コントロール・ウィンドウから、各ズーム表示をオンまたはオフにできます。

MultiView ズーム・ボタンを 1、2 回押して、すべてのズーム表示のオンとオフを切り替えます。

ズームしたエリアを水平方向に移動するには、Zoom ボックスの下にある水平マーカをクリックし、ドラッ
グします。

長いレコード長の波形を管理するには Wave Inspector を使用します (110 ページ 「Wave Inspector を使
用して長いレコード長の波形を管理する」 参照)。

ズームした波形のロックおよびスクロール

1. Lock and Scroll を使用するには、
Vertical または Horiz/Acq メニュー
のいずれかで Zoom Setup... を選
択してから、Lock and Scroll タブを
選択します。
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2. 単一のズームした領域をスクロール
するには、Zoom 1-4 チェック・ボッ
クスを選択してから、Auto Scroll ボ
タンをクリックします。

3. 複数のズームした領域を同時にス
クロールするには、Lock をクリック
してから、スクロールする Zoom 1-4
チェック・ボックスを選択します。

ズームした領域をロックすると、そ
の相対的な水平位置がロックされま
す。1 つのロックおよびズームした
領域の水平位置を変更すると、す
べての水平位置が変わります。
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ヒント

複数のズーム・エリアが選択され、ロックされていない場合、一番上の番号のズーム・エリアがオートスク
ロールされ、その他のエリアは静止したままになります。

ズームされたウィンドウでの波形の非表示

1. 波形を非表示にしたり表示した
りするには、Vertical メニューまた
は Horiz/Acq メニューから Zoom
Setup... を選択します。

2. Zoom タ ブ を 選 択 し 、 次 に
Show/Hide Waveforms を押します。

3. 表示または非表示にする波形が含
まれるズーム領域を選択します。

4. 非表示にするチャンネル波形、演
算波形、リファレンス波形、または
デジタル波形のチェック・ボックスを
オフにします。

デジタル・チャンネルは MSO シリーズ
の機器でのみ使用できます。
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Wave Inspector を使用して長いレコード長の波形を管理する
Wave Inspector のコントロール（ズーム／パン、再生／停止、マーク、検索）を使用すると、長いレコード長の
波形を効率的に操作できます。波形を水平方向に拡大するには、Zoom（ズーム）ノブを回します。ズームさ
れた波形をスクロールするには、パン・ノブを回します。

Wave Inspector は MSO5000B シリーズ、および DPO5000B シリーズの機器で使用できます。

Pan-Zoom（パン - ズーム）コントロー
ルは、次の部分から構成されます。

1. 外側のパン・ノブ

2. 内側のズーム・ノブ

波形のズーム

ズームを使用するには、次の手順を実行します。

1. Pan-Zoom（パン - ズーム）コントロー
ルの内側ノブを時計回りに回すと、
波形の選択した部分にズーム・イン
します。ノブを反時計回りに回すと、
ズーム・アウトします。

2. ズーム・ボタンを 1、2回押して、ズー
ム・モードの有効または無効を切り
替えます。

(104 ページ 「MultiView ズームの使用」
参照)。
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3. 画面の下の大きな部分で大きくズー
ム表示された波形を観察することが
できます。表示の上部には、全体の
レコード内で、波形のズームされた
部分の位置とサイズが表示されま
す。

波形のパン

ズーム機能がオンの間は、パン機能を使用して、波形をすばやくスクロールできます。パンを使用するには、次
の手順を実行します。

1. パン - ズーム・コントロールのパン
（外側）ノブを回して、波形をパン
します。

ノブを時計回りに回すと、前方に
パンします。反時計回りに回すと、
後方にパンします。さらにノブを回
し続けると、ズーム・ウィンドウのパ
ンの速度が上がります。

波形の再生と停止

再生／停止機能を使用すると、自動的に波形レコードをパンできます。使用するには、次の手順を実行します。

1. 再生／停止ボタンを押して、再生
／停止モードを有効にします。

2. さらにパン（外側）ノブを回して、
再生速度を調整します。ノブを回
すほど、速度は上がります。
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3. パン・ノブを回す方向を逆にする
と、再生方向が反対になります。

4. 再生中、外側のノブを回すほど、
波形が一定の限度まで加速され
ます。外側のノブをできる限り速く
回すと、再生速度は変化せずに、
その方向にズーム・ボックスがす
ばやく移動します。この最速回転
機能を使用すると、以前観察した
波形を再度見たい場合に、そこを
再生することができます。

5. 再生／停止ボタンを再度押して、
再生／停止機能を停止します。

波形の検索とマーク
取り込んだ波形に対して、目的の位置をマークすることができます。このマークは、波形の解析を特定の領
域に限定して行いたいときに便利です。波形がある特別な条件を満たしたときにその領域を自動的にマー
クするように設定したり、項目ごとに手動でマークしたりすることができます。マークからマーク（目的の領域
から目的の領域）に移動することも可能です。トリガに使用する同じパラメータの多くを、自動的に検索して
マークできます。多くの検索パラメータには、トリガとしてのタイム・リミットはありません。演算波形およびリファ
レンス波形上で検索したり、取り込まれた特定の種類のイベントすべてを検索したりできます。

検索マークは、リファレンスに対して波形領域をマークする 1 つの方法です。検索条件を使用して、自動的
にマークするよう設定できます。特定のエッジ、パルス幅、ラント、ロジック・ステート、立上り／立下り時間、
セットアップ／ホールド違反、およびバス検索の種類を使用して、領域を検索およびマークできます。

この検索とマークの連係機能は、デジタル波形には対応していません。
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マークを手動で設定およびクリア（削除）するには

1. MultiView ズームをオンにします。
Zoom 1 が使用され、マークが表示
されます。

(104 ページ 「MultiView ズームの使用」
参照)。

2. Analyze > Search を選択します。

3. 汎用ノブを回して、検索マークを設
定（またはクリア）する波形の領域に
（ズーム・ボックスを）移動します。

Next ( →) または Prev (←) 矢印ボ
タンを押すと、次のマークにジャン
プすることができます。

4. Set Clr ボタンまたはフロント・パネ
ルのSet/Clear ボタンを押します。

画面中央に検索マークがない場合
は、マークが追加されます。

マーク作成時に、水平ズーム倍率が
保存されます。ズーム倍率は、Next
または Prev を使用してマーク間を
移動するときにリストアされます。
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5. 検索マーク間を移動して波形を調
べます。Next （→）または Prev （←）
の矢印ボタンを使用すると、他のコ
ントロールを調整せずに、マークさ
れた場所の間を移動できます。

6. マークを削除します。Next （→）ま
たは Prev （←）の矢印ボタンを押し
て、削除するマークに移動します。
中央位置のマークを削除するには、
Set Clr ボタンまたはフロント・パネ
ルのSet/Clear ボタンを押します。
これにより、手動または自動のどち
らで作成されたマークも削除できま
す。
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検索マークを自動で設定およびクリア（削除）するには

1. Search を押すか、Analyze > Search
を選択します。

2. メニューから、目的の検索の種類を
選択します。

検索メニューは、トリガ・メニューに
類似しています。

シリアル・バスの検索はオプション
です。

3. Configure タブで検索を設定します。
トリガ・セットアップまたは検索セッ
トアップをコピーするには、Settings
Copy を押します。

4. Copy Settings ウィンドウで、設定の
コピー元とコピー先を選択します。
Copy、Close の順に押します。
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5. 現在のセットアップを変更するには、
表示されているコントロールの設定
を調整します。表示されているコン
トロールは、選択した検索の種類に
よって異なります。

6. 検索が On になっていない場合は、
Search を押して検索をオンに切り替
えます。

7. 画面上で、緑の三角形は自動マー
クの位置を示し、白の三角形はカス
タム（ユーザ定義）マークの位置を
示します。この三角形とラインは、標
準の波形画面およびズームした波
形画面の両方で表示されます。
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8. Next ( →) と Prev (←) の矢印ボタン
を使用してマーク間を移動し、素早
く波形を観察することができます。
他の調整は不要です。

9. 検索イベント・カウントまたはマーク時
間の表示を切り替えるには、Results
タブを選択し、View の Count を押
します。

10.テーブルのマークをすべてクリアす
るには、All Marks の Clear を押しま
す。

11.マーク・テーブルをファイルにエクス
ポートするには、All Marks の Export
を押します。

12.1 つまたはすべてのマークをユー
ザ・マークに変換するには、Search
Marks の Save または Save All を押
します。

13.現在ハイライトされている行をマー
ク・テーブルから削除するには、
Search Marks の Clear を押します。

14.エンジニアリング表記または高確度
フォームでマーク位置を切り替える
には、Digits を押します。
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15.マークを示す三角形表示のオンと
オフを切り替えるには、View タブを
選択し、Show Marks を押します。

16. 一致するイベントが見つかった
場合にアクイジションを停止する
には、Mode タブを選択し、Stop
Acquisition if event found チェック・
ボックスをオンにします。

ヒント

検索は、取り込まれたデータに対してのみ実行されます。検索するデータを取り込むよう機器をセット
アップしてください。

検索イベントを認識できるようサンプル・レートを設定してください。複数のサンプル・インターバルよりも
広いグリッチを検索できます。

トリガ設定をコピーして、取り込んだ波形内で、トリガ条件を満たす位置を検索できます。検索設定をトリ
ガにコピーすることもできます。

エッジ検索マークは、ズーム倍率なしで作成されます。他の種類の検索については、適切なズーム倍率
でマークが作成されます。

Bring Zoom to Mark の Zoom 2 または Zoom 3 を押すと、対応するズーム・ビューが Zoom 1 と同じズー
ム・パラメータで表示されます。

カスタム（ユーザ）マークは、波形が保存されるとき、および設定が保存されるときに、波形とともに保存
されます。

波形を保存しても、自動検索マークはその波形と共には保存されません。しかし、検索条件は保存され
たセットアップに格納されているので、その検索条件を使用して簡単にマークを再度取り込むことができ
ます。

利用できる検索の種類を以下に示します。

検索 説明

エッジ ユーザ定義のしきい値レベルによってエッジ（立上りまたは立下り）を検索しま
す。

グリッチ 指定した幅よりも狭い（または広い）パルスを検索するか、指定した幅よりも狭い
グリッチを無視します。
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検索 説明

幅 ユーザ指定のパルス幅よりも大きい（>）、小さい（<）、あるいはユーザ指定のパ
ルス幅と等しい（=）、または等しくない（≠）正パルス幅または負パルス幅を検
索します。

セットアップ／ホールド ユーザ指定のセットアップおよびホールド時間違反を検索します。

ラント 一方の振幅しきい値と交差し、もう一方のしきい値とは交差せずに最初のしき
い値と再び交差する正パルスまたは負パルスを検索します。すべてのラント・
パルス、またはユーザ指定の時間よりも大きい（>）、小さい（<）、あるいはユー
ザ指定の時間と等しい（=）、または等しくない（≠）時間を持つラント・パルスを
検索します。

ウィンドウ しきい値ウィンドウに入る信号、またはしきい値ウィンドウから出る信号を検索し
ます。Trigger When Wider オプションを使用して時間によって、または Trigger
When Logic オプションを使用して他のチャンネルのロジカル・ステートによっ
て、検索をクオリファイします。

パターン High、Low、Don't Care のいずれかに設定された各入力によって、複数の波形
でロジック・パターン（AND、OR、NAND、または NOR）を検索します。イベント
が True になったとき、False になったとき、またはユーザ指定の時間よりも大き
い（>）、小さい（<）、あるいはユーザ指定の時間と等しい（=）、または等しくない
（≠）ないときに、そのイベントを検索します。さらに、入力の 1 つを同期（ステー
ト）検索のクロックとして定義する必要があります。

トランジション ユーザ指定の時間よりも大きい（>）、小さい（<）、あるいはユーザ指定の時間と
等しい（=）、または等しくない（≠）立上り／立下りエッジを検索します。

タイムアウト 指定された時間にパルスがない場合、それを検索します。

ステート クロック入力の状態が変化し、選択した論理関数へのすべてのロジック入力に
よって関数が True または False になるとき、それを検索します。

DDR リード DDR リード・パルスを検索します。オプション DDRA 型が必要です。

DDR ライト DDR ライト・パルスを検索します。オプション DDRA 型が必要です。
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検索 説明

DDR リードおよびライト DDR リード・パルスおよび DDR ライト・パルスを検索します。オプション DDRA
型が必要です。

バス パラレル： 2 進値または 16 進値を検索します。

I2C：開始（Start）、停止（Stop）、繰り返し開始（Repeated Start）、ACKなし（Missing
Ack）、アドレス（Address）、データ（Data）、アドレスとデータ（Address/Data）を
検索します。

SPI：SS Active、MOSI、MISO、または MOSI & MISO を検索します。

CAN：フレームの開始、フレーム・タイプ（データ、リモート、エラー、オーバー
ロード）、識別子（標準または拡張）、データ、識別子とデータ、フレームの終了、
欠落 Ack、またはビット・スタッフ・エラーを検索します。

RS-232、RS-422、RS-485、UART：Tx 開始ビット、Rx 開始ビット、Tx パケットの
末尾、Rx パケットの末尾、Tx データ、Rx データ、Tx パリティ・エラー、Rx パリ
ティ・エラーを検索します。

LIN：同期、識別子、データ、ID & データ、ウェイクアップ・フレーム、スリープ・
フレーム、エラーを検索します。

FlexRay：フレームの開始、フレーム・タイプ、識別子、サイクル数、ヘッダ、デー
タ、ID & データ、フレームの終了、エラーを検索します。

イーサネット:フレームの開始、MAC アドレス、Q タグ制御情報、MAC 長さ／タ
イプ／データ、IPv4 ヘッダ、TCP ヘッダ、TCP/IPv4 クライアント・データ、パケッ
トの末尾、および FCS エラーを検索します。

PCIe:パターン、文字／シンボル、Long Ordered Set エラー、および任意の制
御文字を検索します。

8b/10b:パターン、文字／シンボル、エラー、および任意の制御文字を検索しま
す。

MIPI:停止、トランスミッションの開始／終了、バス・ターン・アラウンド、エスケー
プ・モード、警告、エラー、およびショート・パケット／ロング・パケットを検索しま
す。

MIL-STD-1553:同期、コマンド・ワード／ステータス・ワード、データ、RT/IMG
時間、エラーを検索します。

Custom：カスタム・デコーダの使用を検索します。

USB：Sync、Reset、 Suspend、Resume、End of Packet、トークン（アドレス）パケッ
ト、データ・パケット、ハンドシェーク・パケット、特殊パケット、エラー、パターン、
文字／シンボル、Long Ordered Set、LFPS、または任意の制御文字を検索しま
す。
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DDR 波形を解析するには

1. Analyze > DDR Analysis を選択し
ます。ほとんどの設定は、Search メ
ニューからでも実行できます。

2. 使用している DDR の規格を選択し
ます。

注： このウィンドウに表示されるコント
ロールは、機器のオプションによって異
なることがあります。ここに示すものとは
別のコントロールが表示されている場
合は、ご使用の機器のオプションに関
するマニュアルをご覧ください。

3. 必要に応じて、データ・レートとリファ
レンス・レベルを選択します。デフォ
ルトの AUTO を選択すると、印加し
た信号からデータ・レートとリファレ
ンス・レベルが自動的に計算されま
す。

4. ストローブとデータのソースをリスト
から選択します。
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5. 必要に応じて、チップ･セレクトとチッ
プ・セレクトのアクティブ･レベルを選
択します。チップ･セレクトは、DDR
測定をゲート制御します。

リストから、チップ･セレクトのソースとア
クティブ･レベルを選択します。

6. 必要に応じて、Advanced Settings
を押してチップ･セレクトのモードと
レベル、エッジ検出ヒステリシス、終
端ロジック・マージンを設定します。

Auto：チップ･セレクトのソースのミッド
レベルが自動計算されます。Manual
モードでは、チップ･セレクトのミッド
レベルを手動で設定します。

Hysteresis：波形にノイズが見られる
場合は、この値を変更して false マー
クが表示されないようにします。

Margin：信号にノイズが見られる場
合は、この値を増やして、バックツー
バック書き込みのマーク領域を終端
します。

7. チップ･セレクトのソースを選択す
ると、Min CAS コントロールと Max
CAS コントロールが表示されます。
最小値と最大値を入力して、チップ･
セレクトが発生する領域を設定して
ください。

これらのパラメータにより、チップセレク
ト・パルスの探索距離がクロック単位で
マーク開始の左に設定されます。
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8. 識別する DDR 信号のタイプを選択
します。

9. View Results Table Next を押して、
探索結果を表示します。

10.画面上では、目盛の上部に表示さ
れた灰色の三角形とラインで自動
DDR マークの位置がわかります。こ
の三角形とラインは、標準の波形画
面およびズームした波形画面の両
方で表示されます。

11.DDR 信号を詳しく解析するには、
Select Measurements Next を押して
DPOJET に移動します。

高度な測定パッケージである DPO-
JET のジッタおよびアイ・ダイアグラ
ム解析ツールで、DDR 信号を測定
できます。
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波形の表示

12.測定を選択します。

13.Configure > Global の順に選択し、
ズーム機能やカーソル機能による
評価やゲート選択を実行します。

14.ロジックによる評価を実行する場合
は Configure を選択し、ロジックの
ソースを選択します。

15.OK を押します。

16.Single または Run を押して測定を
実行します。
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17.測定結果が表示されます。

DPOJET の詳細については、そのオン
ライン・ヘルプを参照してください。

ビジュアル検索の使用
ビジュアル検索は、メイン・トリガと同じ設定で実行します。 ビジュアル検索の結果は、解析検索と区別でき
る色のマークで表示されます。 次の手順でビジュアル検索を設定します。

1. ピンポイント・トリガを設定します
(74 ページ 「トリガ・タイプの選択」
参照)。

2. ビジュアル・トリガを設定します
(89 ページ 「ビジュアル・トリガに
よるトリガ」 参照)。

3. Mark All Trigger Events in Record
をクリックします。

4. ビジュアル・トリガ領域は青色で表
示されます。

5. ビジュアル検索領域は緑色で表示
されます。
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波形の表示

6. アクティブなビジュアル検索領域の
みが表示されます。 他のビジュア
ル検索領域に移動するには、Mark
Next ボタンまたは Mark Prev ボタ
ンを押します（移動先の領域がアク
ティブになります）。

ビジュアル検索の結果を操作したり表
示するには、他の Analyze Search コン
トロール･ウィンドウを使用します。
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波形の解析

この機器は、波形解析に役立つ機能（カーソル、自動測定、統計、ヒストグラム、演算、スペクトラム解析、
および詳細な合否テスト）を備えています。ここでは、波形解析の概念および手順について説明します。詳
細についてはオンライン・ヘルプを参照してください。

自動測定の実行

1. Measure > Measurement Setup... を
選択します。

2. 測定するチャンネル波形、演算波
形、またはリファレンス波形を選択
します。

3. タブを使用して、5 つの異なるカテ
ゴリの測定を選択します。
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波形の解析

4. すべての測定を削除するには、
Clear All をクリックします。

5. 複数の測定を削除するには、クリッ
クおよびドラッグして測定を選択し、
Clear Selected をクリックします。

Measure メニューで波形の測定方
法を直接選択することもできます。
(129 ページ 「自動測定一覧」 参
照)。

ヒント

DPOJET を使用することにより、デジタル・チャンネル波形で自動測定を実行できます。デジタル波形に
適合する測定のみを実行できます。MSO70000C/DX シリーズでデジタル・チャンネルの波形測定を行う
には、まず iCapture を使用してデジタル・チャンネルをアナログ・チャンネルに送ります (61 ページ 「デ
ジタル波形のアナログ特性の表示」 参照)。

ロール・モードでは、アクイジションを停止するまで測定値を利用できません。

警告： 垂直方向にクリッピングされた場合、リードアウトに電圧が低く表示されていても、プローブ・チップに

は危険な電圧がかかっていることがあります。垂直方向にクリッピングされた場合は、 記号がリードアウ
トに表示されます。振幅関連の自動測定で、信号が垂直方向にクリッピングされた場合は測定結果が不正
確になります。またクリッピングされると、他のプログラムで使用するためにエクスポートしたり保存したりした
波形の振幅値が不正確になります。演算波形がクリッピングされている場合、その演算波形の振幅測定に
は影響を与えません。
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波形の解析

自動測定一覧
次の表は、振幅、時間、詳細、ヒストグラム、コミュニケーションのカテゴリ別に各自動測定の一覧を示したも
のです (127 ページ 「自動測定の実行」 参照)。

振幅測定

測定 説明

Amplitude 波形全体またはゲート範囲で測定されるハイ値とロー値の差です。

High この値は、立下り時間や立上り時間の測定などで、高基準、中間基準、低基準値が
必要な場合に 100% として使用されます。この値の計算には、最小／最大方式または
ヒストグラム方式を使用します。最小／最大方式では、検出された最大値を使用しま
す。ヒストグラム方式では、中点より上で最も頻繁に出現する値を使用します。この値
は、波形全体またはゲート領域全体について測定されます。

Low この値は、立下り時間や立上り時間の測定などで、高基準、中間基準、低基準値が必
要な場合に 0% として使用されます。この値の計算には、最小／最大方式またはヒス
トグラム方式を使用します。最小／最大方式では、検出された最小値を使用します。
ヒストグラム方式では、中点より下で最も頻繁に発生する値を使用します。この値は、
波形全体またはゲート領域全体について測定されます。

RMS 波形全体またはゲート範囲の電圧の二乗平均値（RMS）です。

AC RMS 測定領域全体で電圧を自乗平均した値。

Max 通常は、正の最大ピークの電圧です。最大値は、波形全体またはゲート領域全体に
ついて測定されます。

Min 通常は、負の最大ピークの電圧です。最小値は、波形全体またはゲート領域全体に
ついて測定されます。

Pk-Pk 波形全体またはゲート範囲における最大振幅と最小振幅の絶対差です。

Cycle RMS 波形の最初のサイクルまたはゲート範囲の最初のサイクルの電圧の二乗平均値（RMS）
です。

+Overshoot この値は、波形全体またはゲート領域全体について測定され、次の式で表されます。
正のオーバシュート =（（最大値 － ハイ値）／振幅） × 100%。

-Overshoot この値は、波形全体またはゲート領域全体について測定され、次の式で表されます。
負のオーバシュート =（（ロー値 - 最小値）／振幅） x 100%。

Mean 波形全体またはゲート範囲の相加平均です。

Cycle Mean 波形の最初のサイクルまたはゲート範囲の最初のサイクルの相加平均です。

時間測定

測定 説明

Rise Time 波形またはゲート領域の最初のパルスの立上りエッジで、低基準値（デフォルト = 10%）
から最終値の高基準値（デフォルト = 90%）まで上昇するのに要する時間です。

Fall Time 波形またはゲート領域の最初のパルスの立下りエッジで、高基準値（デフォルト = 90%）
から最終値の低基準値（デフォルト = 10%）まで下降するのに要する時間です。

Pos Width 正パルスの中基準（デフォルトは 50%）振幅ポイント間の距離（時間）です。波形または
ゲート領域の最初のパルスで測定されます。

Neg Width 負パルスの中基準（デフォルトは 50%）振幅ポイント間の距離（時間）です。波形または
ゲート領域の最初のパルスで測定されます。
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時間測定 （続き）

測定 説明

+ Duty Cyc 信号周期に対する正のパルス幅の比率をパーセンテージで表します。デューティ・サ
イクルは、波形またはゲート領域の最初のサイクルで測定されます。

- Duty Cyc 信号周期に対する負のパルス幅の比率をパーセンテージで表します。デューティ・サ
イクルは、波形またはゲート領域の最初のサイクルで測定されます。

Period 波形またはゲート領域の最初のサイクルを完了するのに要する時間です。Period は
周波数の逆数で、単位は秒です。

Freq 波形領域またはゲート領域にある最初のサイクルの周波数。周波数は周期の逆数で
す。単位はヘルツ（Hz）で、1 Hz は 1 サイクル／秒です。

Delay 2 つの異なる波形にある中基準（デフォルトは 50%）振幅ポイント間の時間です。

詳細測定

測定 説明

Area 波形全体またはゲート範囲の領域を電圧 - 秒で表します。グランドより上の測定領域
は正、グランドより下の測定領域は負です。

Cycle area 波形の最初のサイクルまたはゲート範囲の最初のサイクルの領域を電圧 - 秒で表し
ます。共通基準ポイントより上の領域は正、下の領域は負となります。

Phase 波形の一方が他方よりも先行または遅延する時間量を角度で表します。360°が 1 波
形サイクルに相当します。

Burst Width 波形全体またはゲート領域全体について測定されたバースト（一連の過渡的現象）の
継続時間です。

ヒストグラム測定

測定 説明

Wfm Ct ヒストグラムに含まれる波形数。

Hits in Box ヒストグラム・ボックス内またはボックス上のポイント数。

ピーク・ヒット数
（Peak Hits）

ヒストグラムの最大ビンに含まれるポイント数。

Median ヒストグラム・ボックスの中点を表示します。ヒストグラム・ボックス内またはボックス上で
取り込んだすべてのポイントの半分はこの値より下、半分はこの値より上になります。

Max 垂直ヒストグラムにはゼロ以外の最も高いビンの電圧、水平ヒストグラムにはゼロ以外
の最も右側にあるビンの時間が表示されます。

Min 垂直ヒストグラムにはゼロ以外の最も低いビンの電圧、水平ヒストグラムにはゼロ以外
の最も左側にあるビンの時間が表示されます。

Pk-Pk （ ピーク ・
ツー・ピーク）

ヒストグラムのピークからピークまでの値。垂直ヒストグラムには、ゼロ以外の最高ビン
の電圧からゼロ以外の最低ビンの電圧を引いた値が表示されます。水平ヒストグラム
には、ゼロ以外の最も右側にあるビンの時間からゼロ以外の最も左側にあるビンの時
間を引いた値が表示されます。

Mean ヒストグラム・ボックス内またはボックス上のすべてのポイントを取り込み、平均を測定
します。
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ヒストグラム測定 （続き）

測定 説明

Std Dev ヒストグラム・ボックス内またはボックス上で取り込んだすべてのポイントの標準偏差（実
効値（RMS）偏差）を測定します。

Mean ± 1 Std
Dev

ヒストグラム内で、ヒストグラム平均から 1 標準偏差内にあるポイントのパーセンテージ
を表示します。

Mean ± 2 Std
Dev

ヒストグラム内で、ヒストグラム平均から 2 標準偏差内にあるポイントのパーセンテージ
を表示します。

Mean ± 3 Std
Dev

ヒストグラム内で、ヒストグラム平均から 3 標準偏差内にあるポイントのパーセンテージ
を表示します。

コミュニケーション測定

測定 説明

Ext Ratio アイ・トップからアイ・ベースまでの比率。この測定は、波形データベースまたは波形
データベース・モードで保存されたリファレンス波形に対してのみ有効です。

Ext Ratio % アイ・ベースに対するアイ・トップの比率をパーセンテージで表します。この測定は、波
形データベースまたは波形データベース・モードで保存されたリファレンス波形に対
してのみ有効です。

Ext Ratio（dB） アイ・ベースに対するアイ・トップの比率をデシベル数で表します。この測定は、波形
データベースまたは波形データベース・モードで保存されたリファレンス波形に対して
のみ有効です。

Eye Height アイ高さの測定値（ボルト）です。

Eye Width アイ幅の測定値（秒）です。

Eye Top 消光比の測定に使用される最高値です。

Eye Base 消光比の測定に使用される最低値です。

Crossing % アイ交差ポイントをアイ高さのパーセンテージとして表します。

Jitter P-P エッジ・ジッタのピークからピークまでの値を現在の水平軸の単位で表したものです。

Jitter RMS エッジ・ジッタの RMS 値を現在の水平軸の単位で表したものです。

Jitter 6 Sigma エッジ・ジッタの RMS 値の 6 倍を現在の水平軸の単位で表したものです。

Noise P-P ユーザが指定した信号のトップまたはベースのノイズのピーク・ピーク値。

Noise RMS ユーザが指定した信号のトップまたはベースのノイズの RMS 値。

S/N Ratio ユーザが指定した信号のトップまたはベースのノイズに対する信号振幅の比率。

Cyc Distortion 最初のアイ交差のピーク・ツー・ピークの時間変動を、アイ周期のパーセントとして中
基準で測定したものです。

Q-Factor ノイズに対するアイ・サイズの比率です。
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自動測定のカスタマイズ
ゲートの使用、測定統計の修正、または測定基準レベルの調整により、自動測定をカスタマイズできます。

ゲート

ゲートを使用して、測定を波形の特定
部分に限定します。

1. Measure > Gating > Gating ... を選
択します。

2. ゲートの位置を設定するには、次の
いずれかの操作を行います。

Cursor をクリックして、カーソルと
カーソルの間の領域をゲート領
域に設定します。

Zoom (1-4) を ク リ ッ ク して 、
Zoom （1～4）目盛に対するゲー
ト領域を設定します。
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統計

統計は測定時に自動的にオンになりま
す。統計により測定の安定性を評価す
ることができます。

1. 表示されている統計を変更するに
は、Measure > Statistics を選択して
から、Mean または All を選択しま
す。（All には、最小値、最大値、平
均値、標準偏差、および母集団が
含まれます。）

2. 統計を削除するには、Off を選択し
ます。

注： カーソルを測定値の上に置くと、
高分解能の測定値が表示されます。

スナップショット

ある一時点における有効なすべての測
定の状態を確認するには、Measure >
Snapshot を選択します。

注： 測定のセットアップが無効の場合
は、測定結果として 3 つの疑問符が表
示されます。

一般的な測定のスナップショットを取
得するには General を、通信測定のス
ナップショットを取得するには Comm を
選択します。
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測定のコメント

1. 測定にコメントを付けるには、Mea-
surements Setup コントロール・ウィン
ドウで、Annotation を選択します。
ドロップダウン・リストから、コメントを
付ける測定を選択します。

2. 測定コメントの記述量を選択す
るには、Measure > Annotation >
Standard または Detailed を選択し
ます。
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基準レベル

基準レベルによって、時間関連の測定
の取り込み方法が決定されます。

1. Measure > Reference Levels... を選
択します。

2. 測定基準レベルを別の相対値また
は絶対値に調整します。

立上り時間や立下り時間の計算
には、High 基準および Low 基
準が使用されます。デフォルト
の High 基準は 90%、Low 基準
は 10% です。

Mid基準は、主にパルス幅などの
エッジ間の測定に使用します。
デフォルトのレベルは 50% です。

Mid2 基準は、遅延または位相
の測定で指定された 2 番目の
波形に使用されます。デフォル
トのレベルは 50% です。

ヒント

アイ信号の測定時にノイズ値を正確に測定するには、Reference Levels Setup メニューに移動して、信号
タイプを必ず Eye（アイ）に設定してください。
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カーソル測定の実行
取り込まれた波形について、手動で測定するにはカーソルを使用します。

1. Cursors を押します。

注： カーソルがオンで汎用ノブ・リード
アウトが位置コントロールに連結してい
ない場合は、Cursors ボタンを押してコ
ントロールをリードアウトに連結します。
カーソルをオフにするには Cursors ボ
タンをもう一度押します。

MSO/DPO70000DX シリーズ、MSO/DPO70000C シリーズ、および
DPO7000C シリーズ

MSO5000B シリーズおよび DPO5000B シリーズ

2. Cursor Source を選択します。

3. 次の中からカーソル・タイプを 1 つ
選択します。

H Bar は、振幅（一般的にはボ
ルトまたはアンペア単位）を測定
します。

V Bar は、水平軸パラメータ（一
般的には時間）を測定します。

Waveform カーソルおよび Screen
カーソルは、垂直軸パラメータと
水平軸パラメータを同時に測定
します。Waveform カーソルは波
形に接触し、Screen カーソルは
波形に接触せずに浮かんだ状
態になります。
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4. 2 つの波形間の測定を行うには、
Waveform を選択して、各カーソル
に対する波形ソースを選択します。

5. Cursors > Cursor Position... を選
択し、汎用ノブを使用してカーソル
位置を調整します。

6. 表示されるカーソル測定結果を確
認します。

ヒント

複数のカーソルが並んで移動するように設定するには、Cursor Track Mode を使用します。各カーソル
を別々に移動するには、独立カーソル・モードを使用します。

ズーム目盛を使用すると、カーソルを波形の特定ポイントに直接配置し、精密な測定を行うことができま
す。

また、カーソルをクリックおよびドラッグして、別の位置へ移動することもできます。

Move Cursors to Center を押して、ディスプレイの中央にカーソルを移動することもできます。

実線または点線のカーソルを選択できます。

トリガ・ポイントから垂直カーソルまでの時間は、垂直カーソルで測定されます。
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ヒストグラムの設定
垂直（電圧）または水平（時間）のいずれか一方のヒストグラムを表示できます。1 つの軸に沿って波形の統
計的測定データを取得するには、ヒストグラム測定を使用します。

1. ヒストグラムの対象になる波形セグメ
ントを横切るようにポインタをクリック
し、ドラッグします。たとえば、水平ヒ
ストグラムの高さより高いボックスを
作成します。

2. ショートカット・メニューから、His-
togram Vertical またはHistogram
Horizontal を選択します。

3. 目盛の上部（水平ヒストグラムの場
合）または左端（垂直ヒストグラムの
場合）にヒストグラムを表示されます。
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4. ヒストグラムのスケール、またはヒ
ストグラム・ボックスのサイズおよび
位置を調整するには、Measure >
Waveform Histograms を選択して、
Histogram Setup コントロール・ウィ
ンドウを使用します。

5. また、ヒストグラム・データを自動測
定することもできます。(127 ページ
「自動測定の実行」 参照)。

ヒント

垂直ヒストグラムは信号ノイズの測定、水平ヒストグラムは信号ジッタの測定に使用します。

ショートカット・メニューをアクティブにして、ヒストグラムの表示をオフにする場合は、クリックおよびドラッ
グの手順を使用します。
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演算波形の使用
チャンネル波形やリファレンス波形の解析をサポートするには、演算波形を作成します。ソース波形などの
データの組み合わせや変換により、アプリケーションに必要なデータ表示を導き出すことができます。

あらかじめ定義されている演算式の場合は、次の手順を使用します。

1. Math > Math Setup... を選択しま
す。

2. あらかじめ定義されている数値式の
1 つを選択します。

高度な演算波形式を作成するには、次の手順を使用します。

1. Math > Math Setup... を選択しま
す。

2. Editor をクリックします。
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3. ソース、演算子、定数、測定、変数、
および関数を使用して高度な演算
波形式を作成します。

4. 条件に合った式が定義されたら、
Apply をクリックします。

5. 独自のフィルタを追加するには、
Filter タブをクリックします。Load を
クリックします。

6. 使用するフィルタのフォルダをダブ
ルクリックします。使用するフィルタ
をダブルクリックします。
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7. 選択したフィルタを使用して、演算
式を作成します。

8. 条件に合った式が定義されたら、
Apply をクリックします。

ヒント

演算式をダブルクリックすると、Math Equation Editor が開きます。

ソースが無効の場合、演算定義は作成されません。

演算波形は、アナログ・チャンネル波形、リファレンス波形、演算ソース波形および測定値を基に作成し
ます。

演算波形ではデジタル・チャンネルは無効ですが、iCapture 波形は有効です。

アナログ・チャンネルのデジタル・スレッショルドを設定するには、Digital Properties を使用します。

演算波形に対する測定は、チャンネル波形と同じ方法で行います。

演算波形の水平スケールおよび位置は、演算式のソースから導き出されます。ソース波形のこれらのコ
ントロールを調整すると、演算波形も調整されます。

Autoscale がチェックされていなければ、演算波形をオンにしたり演算式を変更した際に、垂直軸方向の
スケールや位置は計算されません。

演算波形を拡大するには、MultiView Zoom を使用します。ズーム領域の位置を調整するには、マウスを
使用します。

任意の演算フィルタの詳細については、オンライン・ヘルプを参照してください。
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スペクトラム解析の使用
定義済みスペクトラム演算式には、次の手順を使用します。

1. Math > Math Setup... を選択しま
す。

2. あらかじめ定義されているスペクトラ
ム演算式の 1 つを選択します。

3. Basic をクリックします。

4. Resolution BW または Frequency
Span をクリックし、キーパッドあるい
は汎用ノブを使用して、スペクトラム
の表示を調整します。

注： Resolution BW と Frequency Span
は、手動水平モードの場合にのみ調整
可能です。
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高度なスペクトラム演算式を作成するには、次の手順を使用します。

1. Math > Advanced Spectral... を選
択します。

2. 定義する演算波形を選択します。

3. 作成するスペクトラム波形のタイプ
をクリックします。波形を定義しなお
すには、Clear をクリックします。

4. ソース波形を選択します。

5. Spectral Setup コントロール・ウィンド
ウのコントロールを使用してスペクト
ラムの波形を調整し、汎用ノブを使
用します。

MSO/DPO70000DX シリーズ、MSO/DPO70000C シリーズ、および
DPO7000C シリーズ
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MSO5000B シリーズおよび DPO5000B シリーズ

6. 時間領域と周波数領域の波形を同
時に表示できます。

Gating を使用して、スペクトラム解
析の対象として時間領域波形の一
部分のみを選択します。 (132 ペー
ジ 「ゲート」 参照)。

ヒント

スペクトラム演算波形のソースは、チャンネル波形または他の演算波形である必要があります。

短いレコード長を使用すると、機器の応答が速くなります。

長いレコード長を使用すると、信号に対してノイズが低減するため、周波数分解能が向上します。

ウィンドウ関数が異なると、スペクトラムのフィルタ・レスポンスの形状が異なり、分解能帯域幅も異なる結
果になります。詳細についてはオンライン・ヘルプを参照してください。

ゲート幅は分解能帯域幅（RBW）により直接制御されます。このため、コントロールを調整すると、時間領
域ゲート・マーカも移動します。

スペクトラムの実数データまたは虚数データの線形振幅を表示できます。これは、スペクトラムをオフライ
ンで処理し、時間領域トレースに変換する場合に便利です。
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シリアル・エラー・ディテクタの使用
シリアル・エラー・ディテクタにはオプション ERRDT が必要です。 オシロスコープのエラー・ディテクタは、
BERT と同様にビット、フレーム、シンボル、およびキャラクタのテストを実行します。 エラーをカウントしてエ
ラー・レートを計算するだけでなく、エラー・ディテクタには、信号内のエラーの発生位置を明らかにし、さら
にオシロスコープにプローブをつないでクロストークなど、エラー元をデバッグできるというメリットがあります。

エラー・ディテクタは、しばしば TekExpress ソフトウェア・アプリケーションと共に使用して、レシーバのテス
トとマージン･テストに使用されます。

エラー・ディテクタには、一般的なケースでの使用に適したプリセット設定が組み込まれています。 また、こ
れらに修正を加えて、後日使用できるようにカスタム設定ファイルとして保存できます。 各種 SATA Gen3 信
号および USB3 信号を想定した、任意波形ゼネレータ（AWG）用のサンプル設定ファイルも含まれていま
す。 これらのファイルは、エラー・ディテクタの動作検証に便利です。また、被測定装置（DUT）のテストに使
用できるケースもあります。

シリアル・エラー・ディテクタを使用するには、次の手順に従います。

1. Analyze > Serial Error Detector を
選択し、エラー・ディテクタのコント
ロール･ウィンドウを表示します。

2. Preset Setting ドロップダウン・リスト
から設定を選択し、Apply を押しま
す。
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カスタム・セットアップが不要な場合は、手順 13 に進みます。

3. Custom_Setup を選択すると、ディス
プレイに追加のコントロールが表示
され、セットアップ・ファイルに移動
できるようになります。 通常は、目
的に近いセットアップ・ファイルを
選んび、それに UI 経由で必要な
設定を追加し、結果を保存すると
いう手順を踏みます。 新しいファ
イル名をファイル名テキスト・コント
ロールに入力し、Enter を押すこと
によって、編集内容を確定します。
次に、Save ボタンを押して、セット
アップをファイルに保存します。セッ
トアップ・ファイルを呼出すには、
ファイルの場所に移動して Open
を押します。 エラー・ディテクタの
セットアップ・ファイルのデフォル
トの場所は、C:\Users\Public\Tek-
tronix\TekScope\ErrorDetector で
す。

4. Setup タブを選択します。

5. Source Setup タブで、ドリップダウン・
リストから Serial Bus、Data Rate、信
号の Source を選択します。

6. 検出したいエラーの種類の Error
Detection オプション・ボタンをクリッ
クします。

Advanced ボタンを押すと Advanced
Settings ウィンドウが開きます。

Advanced Settings ウィンドウでは、特
殊なテストを行う場合に必要なパラメー
タを制御することができます。 多くのデ
バイスで、これらはデフォルトの設定で
適切な値となります。

7. SSC （ Spread Spectrum Clocking ）
Tracking の On または Off をクリッ
クして設定します。

SSC はデフォルトでオンです。
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8. Align プリミティブを無視するには、
Ignore Align Primitives オプション・
ボタンを選択し、キーパッドかキー
ボードを使用してプリミティブを指定
します。

Align プリミティブは、ペーシングの目
的（トランスミッタがレシーバを追い越さ
ないように保つ）で DUT により信号に
挿入されます。

9. キーパッドかキーボードを使用し
て、Maximum Consecutive ALIGNs
に入力します。

最大連続 ALIGN 数は、特定のデバイ
スの設計パラメータであり、許容される
連続 ALIGN の最大数を表します。

Test Pattern タブの設定で、テスト・パターン信号の長さおよび同期パターンの記述を制御します。 これらを
設定するには、信号についての詳しい知識が必要です。 パターン長は、信号ゼネレータまたは AWG から
DUT またはオシロスコープに送られる繰り返し信号に含まれるビット数です。 同期パターンは、信号内の
10、20、30、または 40 ビットの固有パターンで、エラー・ディテクタが取り込んだ比較パターンと信号を整列
させるために使用する信号です。 Advanced チェックボックスを使用すると、各同期パターン・シンボルの不
一致を個別に設定することができます。 X は任意を意味します。 プリセットのセットアップは、一般的なケー
スについて、これらのパラメータの設定を簡略化します。

10.Test Pattern タブで、Sync Pattern、
Sync Pattern Polarity、および Pat-
tern Length を指定します。
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11. Stop Condition タブで、Stop When
条件を選択します。 手動、指定し
たプリセット・カウント後または時間
経過後、またはエラーで停止させる
ことができます。

注： ビット・カウント・テストでは大きな
数字を使用します。 6 Gbs では 600 億
回のビット・テストに 10 秒しかかかりま
せん。

12.停止条件に一致した場合に実行す
るアクションを選択して設定します。
これらのアクションを使用して、オシ
ロスコープに取り込まれた情報を保
存することができます。 Send E-mail
を使用するには、E メール・アドレ
スと SMTP サーバの設定が必要で
す。

13.Sync ボタンを押し、Not Counting の
ステータスを待ちます（約 6 秒）。
信号品質によって、Sync ボタンを
複数回押さなければならない場合
があります。

Sync により、オシロスコープが信号と同
期します。

No Signal というステータスは、オシロス
コープが信号を検出できないことを示し
ます。 信号ゼネレータまたは AWG の
出力をオンにする必要があるかもしれ
ません。 No Sync というステータスは、
既知のパターン長、同期パターン、ま
たは Align キャラクタを必要とするビッ
ト・テストで発生することがあります。

14.Learn ボタンが表示されている場合
は押します。 Learn ボタンは、いくつ
かのビット・エラー・テストでのみ使
用できます。 フレーム、シンボル、
およびキャラクタ・テストでは学習動
作は必要ありません。 学習では、信
号内の繰り返しパターンを検出し、
システム・メモリにそれを保存し、信
号と比較して信号内のエラーを判
断します。 信号がメモリに保存され
ると、次の学習動作が行われるまで
メモリに残るので、エラー・テストを
始めるたびに Learn ボタンを使用
する必要はありません。
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15.Run ボタンを押してエラー・ディテク
タを開始します。

必要な場合はいつでも Stop ボタンま
たは Reset ボタンを押せます。 停止後
に、再び Run ボタンを押します。

Run ボタンでエラー・ディテクタのエ
ラー・テストが開始します。

16.Results タブを選択し、エラー・ディ
テクタの実行結果を確認します。

注： Reset を押すか、信号を切断して
再接続すると、シリアル・エラー・ディテ
クタは自動的に再同期し、すべてのカ
ウントをゼロにリセットします。

提供された AWG 信号パターンのいずれかを使用している場合は、AWG の Force Event ボタンを押すと、
信号にエラーを追加してエラー・ディテクタの動作を確認することができます。 これらの AWG セットアップ・
ファイルは Win7 の C:\User\Public\Tektronix\Tekscope\ErrorDetector\AWG にあります。

または、信号を切断して再接続することにより、動作を確認することもできます。 信号を切断すると大量のエ
ラーが発生しますが、信号の再接続後、エラー・ディテクタは信号と再同期し、エラー・カウントとエラー・レー
トをクリアして、テストを再開します。

17.Error Detector Off ボタンを押して、
エラーディテクタのセッションを終了
します。 トリガがエッジに変わった
ことを示すポップアップが表示され
ます。

一般的な使用方法をまとめると、a）プリセット・セットアップを選択し、b）Sync を押し、c）Learn を押し（表示さ
れている場合）、次に d）Run を押します。 同期動作でオシロスコープと信号を同期し、学習動作で信号パ
ターンをオシロスコープのメモリに取り込み、実行動作でエラー・ディテクタのエラー・テストが開始します。
学習動作は、一部のビット・エラー・テストに適用されるのみであることに注意してください。 フレーム、シン
ボル、およびキャラクタ・エラー・テストでは学習動作は必要ありません。
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シリアル・エラー・ディテクタでは、いくつかのケーブル接続が使用できます。最初のケーブル設定は、SATA、
PCIe、および汎用 8b/10b のビット・テストに特別に適用されるものです。つまり、信号テスト・パターンをエ
ラー・ディテクタのメモリに取り込むために学習動作が必要な場合です。ただし、このケーブル接続はエラー・
ディテクタの動作を確認するためにも使用できます

18.SATA、PCIe、および汎用ビット・テ
ストでの学習動作のために、図に示
すようにケーブルを接続します。

19.学習動作が終了したら、信号ゼネ
レータとエラー・ディテクタの間に
DUT を追加することができます。

前の手順で学習動作が完了している
ので、信号ゼネレータとエラー・ディテ
クタの間に DUT を追加した後で、エ
ラー・ディテクタを実行するために必要
なことは Sync ボタンと Run ボタンを押
すことだけです。 学習動作を再度行う
と、DUT により生成されるエラーを学習
してしまう危険があります。

20.学習動作後にケーブルを接続し直
さなくても済むようにするため、信号
ゼネレータの出力を分岐して、1 本
をエラー・ディテクタに、もう 1 本を
DUT に接続する場合があります。
この場合、学習動作は Ch1 で行い
ますが、実際のエラー検出は Ch2
で行います。 信号分割による損失
を考慮して、信号ゼネレータの振幅
を調整します。 この接続方法が正
常に機能するのは、エラー・ディテ
クタの学習動作では、信号テスト・
パターンがチャンネル固有ではな
いメモリに格納されるからです。
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21. ユーザ・インタフェースでエラー・
ディテクタを開始すると、バス・デ
コードが自動的に有効になり、可能
な場合は常にバス・トリガが使用さ
れます。 デコードにより、右のスク
リーン・ショットに示すように、信号
のエラー箇所のデコード値が赤で
ハイライトされます。 オシロスコープ
の他のチャンネルを使用して、他の
信号を同時にプローブすることによ
り、エラー原因のデバッグを行うこと
ができます。

マスク・テストの使用
シリアル・コミュニケーション・マスク・テスト（オプション MTM 型または MTH型）では、あらかじめ定義された
テンプレートまたはマスクと信号を比較することができます。 信号がテストに合格するには、マスクにより定義
されたセグメントの範囲外になっている必要があります。 一般的に、マスクは ANSI などの標準規格委員会
によって定義されます。 マスク・テストを実行するには、次の操作を行います。

1. Mask > Source... を選択します。

2. 信号ソースを選択します。
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3. Masks タブをクリックします。

4. Type および Standard を選択しま
す。

5. Config（設定）ボタンをクリックして、
Mask Configuration（マスク設定）コ
ントロール・ウィンドウにアクセスし
ます。このコントロール・ウィンドウで
は、マスクと違反の表示方法、およ
びマスクの Autoset（オートセット）と
Autofit（オートフィット）の設定値を
調整することができます。

6. Masks をクリックして、Mask Setup コ
ントロール・ウィンドウに戻ります。

7. Lock Mask to Wfm をクリックして On
にし、水平軸または垂直軸の設定
の変更に合わせてマスクが変更さ
れるようにします。

8. Hit Count をクリックして On にし、
マスク・テスト中に違反がハイライト
表示されるようにします。
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9. Autoset をクリックし、入力信号の特
性に基づいて、波形がマスクと自動
的に揃うようにします。

10.Autofit をクリックして On にし、各ア
クイジション後に波形位置が自動的
に変更され、ヒット数が最小限に抑
えられるようにします。

11.Tolerance タブをクリックして、公差
を設定します。

公差の設定を 0% より大きくすると、
マスク・テストに通過しづらくなりま
す。設定を 0% より小さくすると、マス
ク・テストの通過が容易になります。

標準で指定されたとおりのマスクが
必要な場合は、0% を使用してくだ
さい。パーセンテージを変更するこ
とにより、マージン・テストを実施す
ることができます。

12.Pass/Fail Setup タブをクリックして、
パス／フェイル・パラメータを設定
します （アクイジション・モードが
Waveform Database のときは、# of
Wfms ラベルが Samples になりま
す）。

13.Pass/Fail Test Notifications を選択
します。
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14. テストする波形の極性を選択しま
す。

15.Repeat をクリックして On にすると、
マスク・テストが連続的に実行され
ます。

16. テスト終了時の通知方法を選択し
ます。

17.Pass/Fail Results タブをクリックする
と、テスト結果が表示されます。

18.Pass/Fail Test をクリックし、On にす
ると、マスク・テストが開始されます。

19.合計をリセットし、すべての違反を
クリアするには、Resetをクリックしま
す。

ヒント

マスク・テストは、デジタル・チャンネル波形では使用できません。

マスク内に信号が存在しない場合、Autoset を有効にして、マスク内の中央に波形を配置します。
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リミット・テストの使用
リミット・テスト機能を使用すると、アクティブ信号とテンプレート波形を比較できます。既知の適切な信号か
らテンプレート波形を作成し、そのテンプレート波形を使用してアクティブな信号と比較し、パス／フェイル・
テストを行います。

1. Mask > Limit Test Setup を選択し
ます。

2. Source、Destination、および Tol-
erances を選択して、テンプレート
を作成します。汎用ノブを使用し
て、Tolerances を調整します。Tol-
erances は、信号がリミット・テスト
でフェイルになるまでに許容される
マージンを指定します。

3. Save をクリックします。あとで使用
できるよう、複数のテンプレートを
作成して保存することができます。

4. テンプレートと比較するソース波形
を選択します。

5. ソース波形と比較するテンプレート
を選択します。（通常、これはステッ
プ 3 で作成したテンプレートにな
ります。）
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6. Failure Notification をクリックし、エ
ラー通知をセットアップします。

7. Failure Notification(s) を選択し、
Setup をクリックして、セットアップ・
コントロール・ウィンドウに戻ります。

8. Lock Template to Waveform の On
をクリックすると、垂直軸スケール
またはテンプレート位置をソース波
形に合わせて固定されます。

9. Highlight Hits の On をクリックする
と、テンプレートから外れるポイント
が別の色で表示されます。

10.Limit Test を On に切り替えると、
テストが開始されます。

11.Reset をクリックすると、すべての違
反がクリアになりテストがリセットさ
れます。

ヒント

アクティブ波形または保存されている波形を使用して、リミット・テスト・テンプレートを作成できます。

平均アクイジション・モードを使用すると、よりスムーズなテンプレート波形が作成されます。

エンベロープ・アクイジション・モードを使用すると、時折発生するオーバーシュート対応のテンプレート
が作成されます。
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MyScope 機能

MyScope 機能では、日常的に使用するコントロールのみで構成されたカスタム・コントロール・ウィンドウを作
成できます。いくつかのコントロール・ウィンドウを切り替えるのではなく、使用するコントロールを 1 つのカス
タム・コントロール・ウィンドウに配置します。

このセクションでは、MyScope コントロール・ウィンドウを作成および使用する手順について説明します。詳
細情報はオンライン・ヘルプで参照できます。

新しい MyScope コントロール・ウィンドウの作成

1. Select MyScope > New Control
Window...を選択します。

2. +（プラス記号）をクリックしてカテゴリ
を展開します。MyScope コントロー
ル・ウィンドウに追加できるコントロー
ルが、それぞれのカテゴリ内に表
示されます。これらのカテゴリはメ
ニュー・バーと同じ配置で表示され
るため、よく使用するコントロールを
簡単に見つけることができます。
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3. ファイルに保存された波形を呼び出
すにはまず、波形が呼び出される
リファレンス保存場所（Ref 1 ～ Ref
4）を選択します。

4. コントロールをダブルクリックするか、
または+ をクリックし、コントロール・
リストを展開します（+ （プラス記号）
がない場合は、コントロールをそれ
以上カスタマイズできません）。
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5. チェック・ボックスをオフにして、コン
トロールに表示しないコンポーネン
トを削除します。

6. コントロールをクリックし、MyScope
コントロール・ウィンドウまでドラッグ
します。マウス・ボタンを離すと、最
も近いグリッド位置にコントロールが
配置されます。コントロールをクリッ
クしてドラッグすると、MyScope コン
トロール・ウィンドウ内のコントロール
の配置を変更できます。
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7. New Tab をクリックし、MyScope コン
トロール・ウィンドウにタブを追加し
ます。最大 6 つのタブを設定できま
す。

8. タブの名前を変更するには、次の
いずれかの操作を行います。

Rename Tab をクリックします。

タブをダブルクリックして、新しい
名前を入力します。

9. User Pref... をクリックし、MyScope
コントロール・ウィンドウにロードする
ユーザ設定を指定します。

10.コントロールを削除するには、次の
いずれかの操作を行います。

タブを選択し、Delete をクリックし
ます。 タブとすべてのコントロー
ルが削除されます。

コントロールを選択し、Delete を
クリックします。選択したコント
ロールだけが削除されます。

11.Save をクリックし、MyScope コント
ロール・ウィンドウの名前を入力す
るか、またはデフォルトの名前を使
用します。
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ヒント

コントロールを再設定するには、コントロールをクリックし、プレビュー・ウィンドウまでドラッグして戻しま
す。次に、チェック・ボックスをオンまたはオフにして、コントロール内のコンポーネントを選択または選択
解除します。

タブの順番を変更するには、タブをクリックして新しい位置までドラッグします。

コントロールを削除するには、コントロールをクリックして、画面の上半分（MyScope コントロール・ウィンド
ウの外側）までドラッグします。

MyScope コントロール・ウィンドウの使用
以前に定義した MyScope コントロール・ウィンドウを開くには、次の手順を実行します。

1. Select MyScope > Open Control
Window... を選択するか、または
最近使用した 5 つの MyScope ウィ
ンドウの 1 つを選択します。

2. 使用するコントロール・ウィンドウを
選択し、Open をクリックします。

アクティブな MyScope コントロール・ウィンドウを表示するには、次の手順を実行します:
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1. MyScope > Current... を選択する
か、ツールバー・モードで MyScope
をクリックします（MyScope コントロー
ル・ウィンドウは、表示されていなく
ても有効になっています）。

MyScope コントロール・ウィンドウを編集するには、次の操作を行います:

1. MyScope > Edit Control Window...
を選択します。

2. 編集するコントロール・ウィンドウを
選択し、Open をクリックします。
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Quick Tips

コントロールによっては、MyScope コントロール・ウィンドウと標準のコントロール・ウィンドウで動作が異な
る場合があります。詳細については、オンライン・ヘルプを参照してください。

MyScope コントロール・ウィンドウ（.tcw ファイル）は、MSO/DPO70000DX シリーズ、MSO/DPO70000C シ
リーズ、DPO7000C シリーズ、および MSO/DPO5000B シリーズの別の機器にコピーできます。
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情報の保存と呼び出し

このセクションでは、画面表示とセットアップの保存および呼び出し、測定の保存、クリップボードの使用、お
よび機器での印刷の手順について説明します。詳細については、オンライン・ヘルプで参照できます。

画面表示の保存

1. File > Save または Save As > Screen
Capture... を選択します。

2. Palette、View、Image、または Screen
Capture Format オプションをセット
アップする場合は Options... をク
リックします。セットアップしない場
合はステップ 3 に進みます。
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3. 画面表示を保存する場所を選択し
ます。

4. 画面表示の名前を入力するか、ま
たはデフォルトの名前を使用して、
ファイルの種類を選択します。

5. Save をクリックします。

ヒント

複数の画面表示をすばやく保存するには、Set Front Panel Print Button to Save を選択して、Save をク
リックします。これで、前面パネルの Print ボタンを押すことにより、画面表示を保存できるようになります。

波形の保存

1. 波形を保存するには、File > Save
または Save As > Waveform... を選
択します。
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2. Waveform をクリックします。

3. Waveform Data Range、FastFrame
Data Range、Waveform Detail、Data
Destination、Source、または Data
Ordering を指定する場合は Op-
tions... をクリックします。指定しな
い場合はステップ 4 に進みます。

4. Source を選択します。

5. 波形は、リファレンス波形として機器
のメモリに保存することも、wfm ファイ
ル形式で Windows ディレクトリに保
存することもできます。波形をリファ
レンスとして保存するには、Ref 1 ～
4 を選択します。 .wfm ファイル形式
で保存するには、波形を保存する
場所を選択します。

6. .wfm ファイル形式で保存する場合
は、ファイル名を入力するか、デフォ
ルトの名前を使用します。

7. Save をクリックします。

ヒント

類似する波形を複数保存する場合は、Auto-increment file name チェック・ボックスをオンにすると、同じ
ような名前を繰り返し入力する手間が省けます。

複数の波形をすばやく保存するには、Set Front Panel Print Button to Save を選択して、Save をクリック
します。これで、前面パネルの Print ボタンを押すことにより、波形を保存できるようになります。
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波形の呼び出し

1. File > Recall... を選択します。

2. Waveform をクリックします。

3. 波形の呼び出し先を、Destination
で選択します。

4. 呼び出す波形を選択します。

5. Recall をクリックします。Recall をク
リックすると、リファレンス波形がオ
ンになり、Reference Waveform コン
トロール・ウィンドウがアクティブにな
ります。

6. コントロールを使用して、リファレンス
波形を調整します。File > Reference
Waveform Controls... を選択して、
Reference Waveform コントロール・
ウィンドウにアクセスすることもでき
ます。
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ヒント

保存可能なファイルにはさまざまな種類がありますが、呼出せるのは設定（*.set）ファイルおよび波形
（*.wfm）ファイルのみです。

デジタル波形の保存
MSO シリーズの機器では、デジタル波形を .csv フォーマットのファイルに保存できます。

1. デジタル波形を保存するには、File
> Save または Save As > Digitals を
選択します。

2. Digitals をクリックします。

3. デジタル波形は、Windows のディレ
クトリ内に .csv ファイルとしてのみ保
存できます。.csv ファイルとして保
存するには、波形を保存する場所
を選択します。

4. ファイル名を入力するか、デフォル
トを使用します。

5. Save をクリックします。
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機器設定の保存

1. File > Save または Save As >
Setup... を選択します。

2. Setup をクリックします。

3. 設定を保存する場所を選択します。
設定は、10 個の設定ストレージ位
置のうちの 1 つとして機器のメモリ
に保存することも、.set ファイル形式
で Windows ディレクトリに保存する
こともできます。

4. ファイル名を入力するか、デフォル
トの名前を使用します。ポップアッ
プ・キーボードを使用して、機器の
メモリに保存された設定に対して名
前を入力します。

5. Save をクリックします。

ヒント

タッチ・スクリーンが有効な場合は、容易に識別できるようにポップアップ・キーボードを使用してその設
定にラベルを付けます。

類似するファイルを複数保存する場合は、Auto-increment file name チェック・ボックスをオンにすると、
同じような名前を繰り返し入力する手間が省けます。

複数の設定をすばやく保存するには、Set Front Panel Print Button to Save を選択して、Save をクリック
します。これで、前面パネルの Print ボタンを押すことにより、設定を保存できるようになります。
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機器設定の呼び出し

1. File > Recall... を選択します。

2. Setup をクリックします。

3. 呼び出す設定を選択します。設定
ファイルは、機器のメモリの 10 個
の位置のうちの 1 つから、または
Windows ディレクトリから呼び出す
ことができます。

現在のでスキュー設定をそのまま
使用するには、Don't recall deskew
values チェック・ボックスをオンにし
ます。

4. Recall をクリックします。

ヒント

ディスク上に保存されている設定は、呼び出して、内部設定ストレージ位置に保存すると簡単に使用で
きます。
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測定の保存

1. File > Save または Save As > Mea-
surement... を選択します。

2. Displayed Measurements、Measure-
ment Snapshot、または Measure-
ment Format を指定する場合は
Options... をクリックします。指定
しない場合はステップ 3 に進みま
す。

3. 測定を保存する場所を選択します。

4. 測定の名前を入力し、ファイルの種
類を選択します。

5. Save をクリックします。
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ユーザ・マスクの保存

1. File > Save または Save As > User
Mask を選択します。

2. User Mask をクリックします。

3. マスクを保存する場所を選択しま
す。

4. マスク名を入力し、ファイル・タイプ
を選択します。

5. Save をクリックします。
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ヒストグラム・データの保存

1. File > Save または Save As > His-
togram Data を選択します。

2. Histogram を選択します。以前の
選択によっては、Histogram の選
択肢を表示するために、More >
Histogram Data を選択する必要が
ある場合があります。

3. ヒストグラムを保存する場所を選択
します。

4. ヒストグラム名を入力し、ファイル・タ
イプを選択します。

5. Save をクリックします。
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タイムスタンプの保存

1. File > Save または Save As > Time-
stamp Table を選択します。

2. Timestamp をクリックします。以前
の選択によっては、Timestamp の
選択肢を表示するために、More >
Timestamp Table を選択する必要が
ある場合があります。

3. Source ま た は FastFrame Data
Range を指定する場合は Options...
をクリックします。指定しない場合は
ステップ 4 に進みます。

4. タイムスタンプを保存する場所を選
択します。

5. タイムスタンプ名を入力し、ファイ
ル・タイプを選択します。

6. Save をクリックします。
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クリップボードへの結果のコピー
Microsoft クリップボードにコピーする画像、波形、または測定値の出力内容およびフォーマットを設定する
には、次の手順を使用します。

1. Edit > Copy Setup... を選択します。

2. Images、Waveforms、あるいは Mea-
surements タブをクリックして、目的
のオプションを選択します。
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イメージ、波形、または測定値をコピーするには、次の手順を実行します:

1. コピーする項目を選択します。

2. Edit > Copy を選択するか、または
Ctrl + C を押します。

3. Ctrl + V を押して、Windows アプリ
ケーションにその項目を貼り付けま
す。
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ハードコピーの印刷

1. ハード・コピーを印刷するには、印
刷ボタン、またはFile > Print を押し
ます。必要であれば、Page Setup ダ
イアログ・ボックスで、ページの方向
を変更します。

Print ダイアログ・ボックスおよび Page
Setup ダイアログ・ボックスは、使用して
いるプリンタにより異なります。

2. Page Setup... をクリックします。

3. 印刷パラメータを選択します。
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アプリケーション・ソフトウェアの実行

各アプリケーションについて、本器で 10 回の無料トライアルを行うことができます。これらのアプリケーショ
ンには、アプリケーション固有の測定ソリューションが用意されています。以下にいくつかの例を示します。
追加のパッケージが入手できる場合もあります。機器によっては、使用できないアプリケーションもあります。
詳細については、当社の担当者にお問い合わせいただくか、当社の Web サイト（www.tektronix.com）にア
クセスしてください。

DDR1、LP-DDR1、LP-DDR2、LP-DDR3、DDR2、DDR3、DDR4、DDR3L、GDDR3、および GDDR5 の読
み込み／書き込みを自動識別するには、DDRA（メモリ・バス解析用ソフトウェア）を使用します。

複雑なクロック、デジタル、およびシリアルのデータ信号の測定の信頼度を高めるには、DJA DPOJET
Advanced (ジッタ／アイ・ダイアグラム解析) を使用します。DPOJET Essentials はすべてのモデルに標
準で搭載されています。

MIPI D-PHY トランスミッタのデバッグ、評価および適合性試験には、D-PHY を使用します（オプション
DJA 型が必要）。

IC、マザーボード、およびグラフィック・カードの設計を検証するには、DSPT（ディスプレイ・ポート・コン
プライアンス・ソフトウェア）を使用します。

DVI 物理層の適合性試験を実行する場合は、DVI 適合性試験ソリューション・ソフトウェアを使用します。

高速シリアル・スタンダードのエラーを検出するには、ERRDT（Frame and Bit Error Rate Detector）を使
用します（オプション ST6G 型が必要）。

10/100/1000 Base-T イーサネット適合性試験を実行する場合は、ET3 を使用します。

≥4 GHz モデルの HDMI 適合性試験には、HT3 HDMI 適合性試験ソフトウェアを使用します。

HDMI 解析には、HT3DS（HDMI Direct Synthesis for HDMI 1.4）を使用します（HT3が必要）。

取り込まれた波形と、設定した許容値限度を比較するには、LT（波形リミット・テスト用ソフトウェア）を使
用します。

MOST50 および MOST150 の電気的適合性およびデバッグ試験には、MOST Essentials を使用します。

マスク適合性試験を実行するには、MTH コミュニケーション・マスク・テスト・ソフトウェアを使用します
（≥4 GHz モデルの場合）。

<4 GHz モデルのマスク適合性試験には、MTM（Communication Mask Testing）ソフトウェアを使用します。

Gen3 には PCE3 PCI-Express 適合試験を使用します。 DPOJET と共に使用します。

Gen1 および Gen2 には PCE 適合試験を使用します。 DPOJET または RTE と共に使用します。

電源スイッチング・デバイスおよび磁気コンポーネントにおける電力損失をすばやく測定し、解析する場
合は、PWR 電力測定ソフトウェアを使用します。

シリアル・データ・チャンネルのエミュレート、フィクスチャのディエンベデッド、トランスミッタ・イコライゼー
ションの挿入または除去を行うには、SLA および SLE（シリアル・データ・リンク解析ソフトウェア）を使用し
ます。SLA を使用すると、波形の処理にイコライゼーションが追加されます。

8B10B 信号のシリアル・トリガと解析を行うには、SR-810B を使用します。

MIL-STD-1553 シリアル・トリガリングおよび解析には SR-AERO を使用します。

CAN 信号、LIN 信号、および FlexRay 信号のシリアル・トリガ、デバッグ、デコード、および解析には、
SR-AUTO を使用します。
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RS-232/422/485/UART 信号のシリアル・トリガと解析を行うには、SR-COMP を使用します。

MIPI-DSI1 および MIPI-CSI2 シリアル解析には SR-DPHY を使用します。

I2C および SPI 信号のシリアル・トリガおよび解析を行うには、SR-EMBD を使用します。

イーサネット信号の解析には、SR-ENET を使用します。

SR-PCIE シリアル・データ適合および解析を使用します（シリアル・トリガリングには ST6G が必要）。

USB2.0 信号 および USB3.0 信号のシリアル・トリガおよび解析には、SR-USB を使用します。

高速なシリアル・プロトコルまたはデータ・プロトコルで 8b10b データのトリガおよびデコードを行うには、
ST1G または ST6G（シリアル・プロトコル・トリガ・ソフトウェア）を使用します。プロトコル・トリガの上限は
6.25 GS/s です。

広帯域設計の検証および広帯域スペクトラム・イベントの評価を行うには、SVP、SVM、および SVE（スペ
クトラム解析アプリケーション）を使用します。

フレキシブル OFDM の解析には SVO を使用します（SVE が必要）。

周波数と位相のセトリング時間の測定には SVT を使用します（SVE が必要）。

マスク・テストおよびパラメトリック・テストを含む USB 2.0 信号を評価するには、USB を使用します。

USB 3.0 システムの検証、評価、デバッグ、および適合性試験を行うには、USB3 を使用します（オプショ
ン DJA 型が必要）。

ビジュアル・トリガとその検索を有効にするには、VET を使用します。

10G BASE-T イーサネットのフィジカル・メディア・アタッチメント（PMA）の物理レイヤ（PHY）の電気的適
合性試験には、XGBT を使用します。

ソフトウェアをインストールする場合は、
アプリケーション・ソフトウェアに付属の
手順書に従ってください。ソフトウェア
を実行するには、Analyze を選択して
から、アプリケーションを選択します。
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使用例

このセクションでは、一般的なトラブルシューティング作業における機器の使用例、および機器の使用範囲
を広げるための例について説明します。

間欠的に発生する異常の取り込み
設計エンジニアが直面する最も困難な作業の 1 つは、間欠的なエラーの原因をつきとめることです。異常
の種類が判明している場合は、オシロスコープの拡張トリガ機能を設定して、問題を容易に特定することが
できます。しかし、調査対象が不明な場合、間欠的な異常の調査は、非常に時間がかかり単調で退屈な作
業となる場合があります。このことは、従来のデジタル・ストレージ・オシロスコープを使用して、波形の取り込
み速度が遅い場合に、特に顕著となります。

DPX テクノロジにより実現したデジタル・フォスファ・オシロスコープは、FastAcq と呼ばれる非常に高速なア
クイジション・モードを備えており、このモードを使用すると、このような異常を数秒または数分で発見するこ
とができます。通常の DSO では、同じイベントを発見するのに何時間または何日もかかることがあります。

間欠的に発生する異常を取り込むには、次の手順を使用します。

1. プローブを入力信号ソースに接続
します。

2. Autoset を押します。

MSO/DPO70000DX シリーズ、MSO/DPO70000C シリーズ、および
DPO7000C シリーズ

MSO5000B シリーズおよび DPO5000B シリーズ
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3. Display > Display Persistence > In-
finite Persistence の順に選択しま
す。この例では、クロック信号を表
示しています。1、2 分信号を観察
したら、他の場所にある問題を検索
する前に、ステップ 4 に進みます。

4. FastAcq を押します。

MSO/DPO70000DX シリーズ、MSO/DPO70000C シリーズ、および
DPO7000C シリーズ

MSO5000B シリーズおよび DPO5000B シリーズ

5. 信号内に存在するグリッチ、過渡的
現象、あるいは他の不規則な異常
を探します。 この例では、FastAcq
により、わずか数秒後に約 300 ns
の正のグリッチが発見されました。
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6. ステップ 5 で特定したグリッチでト
リガするために、Glitch Setup... を
選択します。

7. 適切な極性を選択します。

8. Level をクリックし、ステップ 5 で見
つけた結果に基づいてレベルを設
定します。

9. Width をクリックし、ステップ 5 で見
つけた結果に基づいてパルス幅を
設定します。

トリガで、高周波バーストを 1 つの
パルスとして取り扱う場合は、HF
Filtering をオンにします。

10.E-mail on Trigger をクリックして On
にします。 (93 ページ 「イベント時
の電子メールの設定」 参照)。

11.Single を押して、単一のグリッチでト
リガします。

MSO/DPO70000DX シリーズ、MSO/DPO70000C シリーズ、および
DPO7000C シリーズ

MSO5000B シリーズおよび DPO5000B シリーズ
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拡張デスクトップおよび OpenChoice アーキテクチャを使用した効率的
なドキュメント作成

多くの場合、エンジニアは後で参照できるように研究室の作業を文書化する必要があります。OpenChoice
アーキテクチャを使用すると、スクリーン・ショットおよび波形データを CD または USB メモリ・デバイスに保
存しておいて後でレポートを作成する代わりに、リアルタイムで作業を文書化することができます。

機器を中心として設計および文書化の処理を行うには、以下の手順を使用します。

注： 64 ビットのシステムでは 64 ビットの互換ドライバとアプリケーション・ソフトウェアが必要になります。

1. Microsoft Word または Microsoft
Excel を機器に読み込みます。

2. モニタをもう 1 台接続します。
(11 ページ 「2 台めのモニタの追
加」 参照)。

3. Microsoft Word を開き、Word ウィン
ドウを拡張デスクトップ上にドラッグ
します。

4. TekScope をクリックして、機器のア
プリケーションを再び表示します。

184 MSO/DPO70000DX、MSO/DPO70000C、DPO7000C、および MSO/DPO5000B シリーズ・ユーザ・マニュアル



使用例

5. Edit > Select for Copy > Full Screen
(bitmap) を選択します。

6. Ctrl+C を押します。

7. Word 文書内でスクリーン・ショットを配置する場所をクリックして、Ctrl+V を押します。

ヒント

機器には各種 OpenChoice ソフトウェア・ツールが付属しています。これらのツールは、他の設計環境の
効率と接続性を最大限に高めるように設計されています。

バスでのトリガ
各種のバス（I2C、SPI、RS-232/422/485/UART、MIPI DSI-1、MIPI CSI-2、8B/10B、USB、CAN、およびパラ
レル）でトリガすることができます。物理層 (アナログ波形として) とプロトコル・レベルの情報 (デジタルおよび
シンボル波形として) の両方を表示できます。

注： 機器により、使用できないトリガ・タイプもあります。

バス・トリガの詳細については、次を参照してください (85 ページ 「パラレル・バスでのトリガ」 参照)。 および
(88 ページ 「シリアル・バスでのトリガ」 参照)。

バス・トリガを設定するには、次の手順を実行します。

1. Vertical > Bus Setup を選択します。
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2. バスのタイプを選択します。

3. Bus Type で Serial を選択した場合
は、さらにシリアル・バスのタイプを
選択します。

4. コンポーネントを指定します。

5. Trig > Bus Setup を選択します。

6. 設定するバスを選択します。

7. Trigger On で使用するトリガを選択
します。

8. 選択する Trigger On によっては、さ
らに追加の指定が必要になります。

ビデオ信号でのトリガ
機器は、 NTSC、SECAM、PAL、および HD 信号でのトリガをサポートしています。

ビデオ・フィールドでトリガするには、次の手順を実行します。

注： ビデオ・トリガ・タイプは DPO7000C シリーズ、MSO5000B シリーズ、および DPO5000B シリーズの機器
でのみ使用できます。
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1. Trig > A Event (Main) Trigger
Setup... を選択します。

2. A Event タブで A トリガ・タイプとソー
スを設定します。

Format > 525/NTSC を選択します。

3. Trigger On > Field を選択します。

Odd、Even、あるいは All フィールド
を選択します。

ラインでのトリガ

フィールド内のビデオ・ラインを観察するには、次の手順を実行します:
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1. Trig > A Event (Main) Trigger
Setup... を選択します。

2. A Event タブで A トリガ・タイプとソー
スを設定します。

Format > 525/NTSC を選択します。

3. Trigger On > All Lines を選択しま
す。
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当社オシロスコープとロジック・アナライザ間でのデータ相関
設計の多くは、高速なクロック・エッジとデータ・レートを使用した高速設計です。これらの設計では、高速
デジタル信号のアナログ特性を回路内の複雑なデジタル・イベントと関連付けて観察する必要があります。
iView により、デジタルおよびアナログの世界への扉が開けます。iView の機能を使用すると、当社ロジック・
アナライザとオシロスコープのデータをシームレスに統合し、自動的に時間相関を取ることができ、マウスを
クリックするだけで、アナログ波形をオシロスコープからロジック・アナライザの画面へ転送できます。時間相
関の取れたアナログ信号とデジタル信号を並べて表示し、捕捉が困難なグリッチなどの問題の原因を瞬時
に特定することができます。

iView 外部オシロスコープ・ケーブルを使用すると、ロジック・アナライザを当社オシロスコープに接続し、2
台の機器の間で通信を行うことができます。TLA アプリケーションの System（システム）メニューには、Add
External Oscilloscope（外部オシロスコープの追加）ウィザードが用意されています。このウィザードの手順に
従って、ロジック・アナライザとオシロスコープ間の iView ケーブルの接続を行うことができます。

また、オシロスコープ設定の確認、変更、およびテストに役立つセットアップ・ウィンドウも利用できます。波
形を取り込んで表示する前に、Add External Oscilloscope（外部オシロスコープの追加）ウィザードを使用し
て、当社ロジック・アナライザとオシロスコープ間の接続を確立する必要があります。

1. ロジック・アナライザの System メ
ニューから、Add iView External Os-
cilloscope... を選択します。

2. 使用するオシロスコープのモデルを
選択します。

3. 画面上の手順に従って操作を行
い、Next をクリックします。

4. ロジック・アナライザとオシロスコー
プ間のデータ相関の詳細について
は、当社ロジック・アナライザのマ
ニュアルを参照してください。
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クリーニング
本機器のクリーニングには、次の手順を使用します。特別なクリーニングが必要な場合は、資格のあるサー
ビス担当者に依頼してください。

外部のクリーニング

シャーシの外部表面のクリーニングには、乾いた柔らかい布か柔らかい毛ブラシを使用してください。汚れ
が落ちない場合は、75% のイソプロピル・アルコール溶液をしみ込ませた布または綿棒を使用してください。
コントロールやコネクタの周りの狭い部分のクリーニングには、綿棒を使用してください。研磨剤は、シャーシ
のどの部分にも使用しないでください。

On/Standby スイッチは、溶剤をしみ込ませたクリーニング・タオルを使用してクリーニングしてください。スイッ
チに溶剤を直接吹き付けたり、スイッチをぬらさないでください。

注意： 不適切な洗浄剤や洗浄方法を使用したり、力を入れすぎたりすると、フラットパネル・ディスプレイが
損傷する可能性があります。化学洗浄剤は、オシロスコープに使用されているプラスチックを損傷させる可
能性があるため、使用しないでください。フロント・パネルのボタンをクリーニングする際は、純水だけを使用
してください。洗浄剤として 75% のイソプロピル・アルコール溶剤を使用し、純水で洗い流してください。他の
種類の洗浄剤を使用する場合は、まず当社サービス・センターまたは代理店にお問い合わせください。

外部のクリーニング時に機器の内部が湿らないように、布またはアプリケータを必要以上に液体に浸さない
でください。
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付録 B

最新のオシロスコープ・アプリケーションとバージョン・リリースの入
手方法

機器と共にオプションのアプリケーションを発注された場合でも、機器にインストールされているバージョン
が最新でない場合があります。最新のソフトウェア・バージョンを入手するには、次の場所からダウンロード
するのが簡単で迅速な方法です。

最新のソフトウェア・バージョンをダウンロードするには、Tektronix ホームページ（www.tektronix.com）にアク
セスし、Downloads セクションを探します。ENTER MODEL NUMBER テキスト・ボックスにアプリケーション名
を入力し、Select Download Type プルダウン・メニューから Software を選択します。

注： ホームページから入手可能なリリース・ノート・ファイルには、ダウンロード可能な実行ファイルに含まれ
る readme.txt ファイルよりも最新の情報が含まれている場合があります。

検索条件を定義するには、ENTER MODEL NUMBER テキスト・ボックスにアプリケーションのタイトルを入力
します。たとえば、DPOJET の最新バージョンを探してダウンロードするには、キーワード「DPOJET」を入力
します。

機器と共にアプリケーションを購入された場合は、付属の Tektronix ライセンス・キーを使用してアプリケー
ションを使用します。

アップグレードする場合は、Readme.txt ファイル内の「How to Install your new Tektronix License Key」に記
載されている方法に従ってアプリケーションを有効にしてください。
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付録 C

TPP0500 型（500 MHz）および TPP1000 型（1 GHz）10X 受動プロー
ブについて

071-2809-xx

Copyright (C) Tektronix, Inc. All rights reserved.

動作情報
TPP0500B 型および TPP1000 型 の 10X 受動プローブは、Tektronix MSO/DPO4000B シリーズおよび 5000B
シリーズのオシロスコープで使用するために設計された 10X 減衰の小型受動プローブです。

これらのプローブには、お客様や当社で修理できる部品はありません。

プローブとオシロスコープの接続
以下の図に示すようにプローブを接続します。
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プローブの補正
MSO/DPO5000B: 次の手順によりプローブの補正を行います。

1. プローブをオシロスコープの 1 つのチャンネルに接続します。

2. オシロスコープのフロント・パネルにあるプローブ補正出力端子にプローブを接続します。

3. Vertical > Probe Cal を選択します。

4. プローブが取り付けられているチャンネルのタブを選択します。

5. メニューの Probe Compensation セクションで、Compensate Probe ボタンをクリックします。

警告： 感電を避けるために、オシロスコープの Probe Comp 信号への接続は、この補正を行うときのみにし
てください。

プローブ補正に失敗する場合は、オシロスコープの Probe Comp 接続で、信号の接続とグランドの接続に
問題がないことを確かめてください。また、プローブ・ヘッドのグランド接続が確実なこと、固定チップまたは
ポーゴー・チップがプローブ・ヘッドに固定されていること、そしてフック・チップがチップに確実に接続され
ていることを確認してください。

スタンダード・アクセサリ
プローブに付属しているスタンダード・アクセサリを下記に示します。

警告： プローブやアクセサリの使用時の感電を避けるために、プローブ本体やアクセサリの指ガードの先
には絶対に指を出さないようにしてください。
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項目 説明

フック・チップ

フック・チップをプローブ・チップにかぶせ、
次にフックを回路に接続します。

追加注文時の当社部品番号： 013-0362-XX

マイクロ・フック・チップ

狭い場所でテスト・ポイントに接続する場合
にこのチップを使用します。フック・チップを
プローブ・チップにかぶせ、次にフックを回
路に接続します。

追加注文時の当社部品番号： 013-0363-XX

固定チップ

このチップは事前にプローブに取り付けられ
ています。

追加注文時の当社部品番号： 206-0610-XX

ポーゴー・チップ

このスプリング付きチップは、回路基板の適
合性試験に使用します。

追加注文時の当社部品番号： 206-0611-XX

ワニ口クリップ付きグランド・リード

リードを確実にプローブ・ヘッドのグランドに
接続し、次に回路のグランドに接続します。

追加注文時の当社部品番号： 196-3521-XX

グランド・スプリング

スプリングをプローブ・チップのグランド・バ
ンドに取り付け、グランド接続が近くにあるテ
スト・ポイントの測定で使用します。（標準：
<0.75 インチ、短： XX インチ）。

追加注文時の当社部品番号：

016-2028-XX（長、2 個）

016-2034-XX（短、2 個）
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オプショナル・アクセサリ
下記のプローブ・アクセサリをご購入いただけます。

アクセサリ 当社部品番号

グランド・リード、クリップオン（6 インチ） 196-3198-xx

ワニ口付きグランド・リード（12 インチ） 196-3512-xx

MicroCKT テスト・チップ 206-0569-xx

回路基板テスト・ポイント／PCB アダプタ 016-2016-xx

小型プローブ・チップ、回路基板テスト・ポイント 131-4210-xx

ワイヤ・スプール、32 AWG 020-3045-xx

プローブ・チップの交換
固定チップの交換には当社部品番号 206-0610-xx を、またポーゴー ピンの交換には当社部品番号 206-
0611–xx をご注文下さい。

仕様

表 1: 電気仕様と機械仕様

特性 TPP0500/B TPP1000

帯域（-3 dB） 500 MHz 1 GHz

システム立上り時間（代表値） <350 ps <700 ps

システム入力容量 固定チップ：3.9 pF ±0.3 pf
ポーゴー・ピン・チップ：5.1 pf ±0.5 pf

システム減衰確度 10:1 ±2.2%

プローブ直列抵抗 @DC 9.75 MΩ ±0.5%

システム入力抵抗 @DC 10 MΩ ±2%

伝搬遅延 ～ 5.67 ns

最大入力電圧 300 VRMS CAT II

ケーブル長 1.3 m、±3 cm
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性能グラフ

フローティング測定を行う際には、上記の基準リード・ディレーティング曲線を参考にしてください。

表 2: 環境仕様

特性 説明

温度

動作時

非動作時

–15 ℃ ～ +65 ℃（+5 ℉ ～ +149 ℉）

–62 ℃ ～ +85 ℃ （–80 ℉ ～ +185 ℉）

湿度

動作時

非動作時

30 ℃以下で相対湿度 5% ～ 95%

30 ℃ ～ 50 ℃ で相対湿度 5% ～ 45%

高度

動作時

非動作時

最高 4.6 Km（15,000 フィート）

最高 12.2 Km（40,000 フィート）
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表 3: 規格と承認

特性 説明

EC 適合宣言 『Official Journal of the European Communities』に記載の以下の基準に準拠しま
す。

低電圧指令 2006/95/EC：

EN61010-031： 2002

カテゴリ このカテゴリの製品例：

CAT III 配電レベルの電源、固定設備

CAT II 局所レベルの電源、機器、携帯用機器

測定カテゴリ

CAT I AC 電源に直接接続されない機器

汚染度 2 導電性汚染物質が存在する可能性のある環境では使用しないでください（IEC
61010-1 に定義）。屋内でのみ使用してください。

追加の安全規格 UL61010B-1 第1版および UL61010B-2-031 第1版

CAN/CSA-C22.2 No. 1010.1-92 および CAN/CSA-C22.2 No. 1010.2.031-94

IEC61010-031：2002

機器のリサイクル：本製品は WEEE Directive 2002/96/EC （廃棄電気・電子機器に関する指令）
に基づく EU の諸要件に準拠しています。リサイクル方法の詳細については、当社 Web サイト
（www.tektronix.com）の「Support/Service」を参照してください。

安全にご使用いただくために
人体への損傷を避け、本製品や本製品に接続されている製品の破損を防止するために、安全性に関する
次の注意事項をよくお読みください。安全のために、指示に従って本製品を使用してください。プローブや
アクセサリを指定外の方法で使用すると感電または出火の危険があります。

出火や人体への損傷を避けるには

グランド基準のオシロスコープの使用: グランド基準のオシロスコープで使用する場合、本プローブの
基準リードを浮かせないでください（たとえば DPO シリーズ、MSO シリーズ、および TDS シリーズのオシロ
スコープ）。基準リードは接地電位（0 V）に接続しなければなりません。

接続と切断の手順を守ってください: 測定対象の回路にプローブを接続する前に、プローブ出力を計
測機器に接続してください。プローブ入力とプローブの基準リードを被測定回路から切断した後で、プロー
ブを測定機器から切断してください。

感電を避けてください: けがや死亡事故を避けるために、プローブと検査リードが電圧源に接続されたま
まの状態で、それらを接続したり取り外したりしないでください。

すべての端子の定格を守ってください: 火災や感電の危険を避けるために、本製品のすべての定格と
マーキングに従ってください。本製品に電源を接続する前に、定格の詳細について、製品マニュアルを参
照してください。

感電を避けてください: プローブのアクセサリを使用する際、測定カテゴリおよび電圧定格を含め、プロー
ブやアクセサリの最も低い定格を超えないようにしてください。
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電気的過負荷を避けてください: けがや火災を避けるために、あらゆる入力（基準入力を含む）に、グラ
ンドからの差がその入力の最大定格を超えるような電圧をかけないでください。

回路の露出を避け、カバーなしでは使用しないでください: 電源が投入されているときに、露出した
接続部分や部品に触れないでください。

プローブとアクセサリを検査してください: 使用前には必ずプローブとアクセサリに損傷がないことを確
認してください（プローブ本体、アクセサリ、ケーブル被覆などの断線、裂け目、欠陥)。損傷がある場合に
は使用しないでください。

湿気の多いところでは使用しないでください:

爆発しやすい環境では動作させないでください:

製品の表面を清潔で乾燥した状態に保ってください:

安全に関する用語と記号

このマニュアルでは次の用語を使用します。

警告： 人体や生命に危害をおよぼすおそれのある状態や行為を示します。

注意： 本製品やその他の接続機器に損害を与えるおそれのある状態や行為を示します。

本製品の記号: 本製品は以下の記号に注意してご使用ください。

Tektronix 連絡先

Web サイト： http://www.tektronix.com

電話番号： 1-800-833-9200

住所： Tektronix, Inc.
部署名または個人名（わかる場合）
14200 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
USA

電子メール・アドレス： techsupport@tektronix.com
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保証について

保証の詳細については、http://www.tektronix.com/warranty にアクセスしてください。
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付録 D

P6616 型汎用ロジック・プローブ
071-2831-00

Copyright (C) Tektronix, Inc. All rights reserved.

製品の説明
P6616 型汎用ロジック・プローブは、当社 MSO/DPO5000B シリーズおよび MSO4000B シリーズのミックスドシ
グナル・オシロスコープをターゲット・システムのデジタル・バスおよび信号に接続するために使用します。 プ
ローブは、16 のデータ・チャンネルが 2 つのリード・セットに分割されています（GROUP 1 および GROUP 2）。

両セットの最初のリードは青色の絶縁体で示され、他の ７ 本のリードは灰色です。すべてのリードのチップ
にはグランド接続があります。プローブ・リードは、ターゲット・システムに個別に接続したり、プローブのチッ
プ・ホルダを使用してグループ化したりすることができます。
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プローブとオシロスコープの接続
以下の図に示すようにプローブを接続します。

1. ラベル面を上にして、プローブをオシロスコープのコネクタに挿入します。

2. プローブを取り外すには、両サイドのボタンを押してプローブを引き抜きます。
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プローブと測定回路の接続
プローブを回路に接続するには、本書の末尾に記載されているコネクタとアダプタを使用します。最適な方
法を選んで、次の「プローブのセットアップ」に記載された指示に従ってください。

プローブのセットアップ

デジタル・チャンネルのパラメータを設定したり表示するには、次のようにします。

MSO/DPO5000B シリーズの機器では、Vertical>Digital Setup を選択するか、D15-D0 ボタンを押します。

MSO4000B シリーズの機器では、D15–D0 ボタンを押します。

各デジタル・チャンネルについて、下記のパラメータを設定できます。

スレッショルド電圧および垂直位置（デフォルトのスレッショルド電圧は 1.4 V)

信号の高さおよび位置（全 16 チャンネルを一括設定）

チャンネル・ラベル

バス特性を設定したり表示するには、次のようにします。

MSO/DPO5000B シリーズの機器では、Bus Setup メニューのコントロールを使用します。

MSO4000B シリーズの機器では、B1 ～ B4 のボタンを押します。

セットアップ画面で、次のバス特性を設定したり表示したりできます。

クロックの種類

バスの種類（シリアルまたはパラレル）

バス幅

表示形式（16 進、2 進、または ASCII シンボル）

一部のオシロスコープ・モデルにはパラレル・バスの設定情報が格納されています。しかし SPI や I2C など、
その他のバスについては適切なオプションが必要です。名称と発注情報については、ご使用のオシロスコー
プのマニュアルまたは製品データ･シートを参照してください。

機能チェック
接続されたすべてのアクティブなチャンネルについて、ロジック動作が直ちに表示されます。アクティブな信
号が表示されない場合は、次の操作を行ってください。

1. Trigger ボタンを押します。

2. トリガのタイプとして Edge を選択します。

3. ソースとしてセットアップするチャンネルを選択します。

4. MSO4000B シリーズの機器では Autoset ボタンを押します。

アクティブな信号が表示されない場合は、他のプローブ･チャンネル（またはアナログ･プローブ）を使用し
て、テスト・ポイントの回路動作を確認してください。
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主な用途
1. P6616 型プローブは、システム･バスのデジタル信号の観測に使用します。

2. アナログ波形情報を観測するには、TPP0500/B 型または TPP1000 型受動プローブなどのアナログ・プ
ローブを使用します。

アクセサリ
本プローブには下記の表に示すスタンダード･アクセサリが付属しています。後の図を参照してください。

項目 説明 数量 部品番号

— ロジック・プローブ・アクセサリ・キット 項目 1–6 020-2662-XX

1 延長グランド・チップ 20 本入りセット 020-2711-XX

2 プローブ・チップ 10 本入りセット 131-5638-11

3 IC グラバ 20 本入りセット 020-2733-XX

4 プローブ・チップ・ホルダ 2 個 352-1115-XX

5 8 インチ・グランド・リード 2 本入りセット 020-2713-XX

6 3 インチ・グランド・リード 8 本入りセット 020-2712-XX

取扱説明書 1 1 個 071-2831-XX

1 取扱説明書はプローブに付属しています。アクセサリ・キットにはありません。取扱説明書は www.tektronix.com/manuals からダ
ウンロードすることができます。

下記のオプショナル・アクセサリをご購入いただけます。

説明 部品番号

P6960 型プローブ D-MAX フットプリント用スクエア・ピン・ヘッダ・
アダプタ

NEX-P6960PIN
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仕様

表 4: 電気仕様と機械仕様

特性 説明

入力チャンネル デジタル 16 チャンネル

入力抵抗 100 kΩ ±1.0%

入力キャパシタンス 3.0 pF

入力信号スイング

最小値 400 mVp-p

最大値 30 V p-p、≤200 MHz (プローブ・チップで DC スレッショルド電圧
を中心に）

10 V p-p、≥200 MHz (プローブ・チップで DC スレッショルド電圧
を中心に）

最大非破壊入力信号 ±42 V

ユーザ定義のスレッショルド・レンジ ±40 V

検出可能な最小パルス幅 1 ns

デジタル・チャンネル間スキュー 200 ps

プローブ長 1.3 m（4.27 フィート）

表 5: 環境仕様

特性 説明

温度

動作時 0 ～ +50 ℃

非動作時 –55 ℃ ～ +75 ℃（–67 ℉ ～ +167 ℉）

湿度

動作時 相対湿度 5 ～ 95%

非動作時 相対湿度 10 ～ 95%

高度

動作時 最高 4.6 Km（15,092 フィート）

非動作時 最高 15 Km（50,000 フィート）

機器のリサイクル：本製品は WEEE Directive 2002/96/EC （廃棄電気・電子機器に関する指令）
に基づく EU の諸要件に準拠しています。リサイクル方法の詳細については、当社 Web サイト
（www.tektronix.com）の「Support/Service」を参照してください。
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安全にご使用いただくために
安全のために、指示に従って本プローブを使用してください。

接続と切断の手順を守ってください: 測定対象の回路にプローブを接続する前に、プローブ出力を計
測機器に接続してください。計測機器からプローブを外す前に、測定対象の回路からプローブの入力とグ
ランドを外してください。

すべての端子の定格に従ってください: 火災や感電の危険を避けるために、本製品のすべての定格と
マーキングに従ってください。本製品に電源を接続する前に、定格の詳細について、製品マニュアルを参
照してください。

カバーを外した状態では使用しないでください: 電源が投入されているときに、露出した接続部分や部
品に触れないでください。

回路の露出を避けてください: 電源が投入されているときに、露出した接続部分や部品に触れないで
ください。

故障の疑いがあるときは使用しないでください: 本製品に故障の疑いがある場合、資格のあるサー ビ
ス担当者に検査してもらってください。

湿気の多いところでは使用しないでください: 爆発性ガスが充満している場所では使用しないでくだ
さい。

製品の表面を清潔で乾燥した状態に保ってください:

安全に関する用語と記号
このマニュアルでは次の用語を使用します。

警告： 人体や生命に危害をおよぼすおそれのある状態や行為を示します。

注意： 本製品やその他の接続機器に損害を与えるおそれのある状態や行為を示します。

本製品の記号: 本製品は以下の記号に注意してご使用ください。
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Tektronix 連絡先

Web サイト： http://www.tektronix.com

電話番号： 1-800-833-9200

住所： Tektronix, Inc.
部署名または個人名（わかる場合）
14200 SW Karl Braun
Drive P.O. Box 500
Beaverton, OR 97077
USA

電子メール・アドレス： techsupport@tektronix.com

保証について
保証の詳細については、http://www.tektronix.com/warranty にアクセスしてください。
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プローブと測定回路の接続
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索引

記号と番号
ENOB, 41
拡張有効ビット数, 41
有効ビット数

拡張, 41

ENGLISH TERMS
Action on event

設定, 91
Arm ステータス・ライト, 78
Autoset Undo（オートセットを元

に戻す）, 37
B イベント・スキャン, 82
CAN, 185
CAN トリガ

定義された, 77
Color Palette, 103
Cross Hair 目盛スタイル, 101
D15 - D0（D15 - D0）ボタン, 60
DDR 解析, 121
Display Remote（リモート表

示）, 10
ESD

防止, 5
ESD の防止, 5
FastAcq/WfmDB パレット, 103
FastFrame, 47, 62

フレーム・ファインダ, 66
Frame（フレーム）目盛スタイ

ル, 101
Full 目盛スタイル, 101
Grid 目盛スタイル, 101
H Bar カーソル, 136
I2C, 185
iView, 189
Label, 100
MagniVu, 60
MIPI CSI-2, 185
MIPI DSI-1, 185
Monochrome Gray カラー・パ

レット, 103
Monochrome Green カラー・パ

レット, 103
MultiScope トリガ, 68
MultiView ズーム, 104

MyScope
使用, 162
編集, 163
新しいコントロール・ウィン

ドウ, 158
Normal カラー・パレット, 103
Objects

表示, 102
OpenChoice

example, 184
Probe（プローブ）

校正, 37
デスキュー, 37
補正, 37

Ready ステータス・ライト, 78
RS-232 トリガ

定義された, 77
Screen カーソル, 136
Set/Clear Mark ボタン, 113
Sin(x)/x 補間法, 99
Spectral Grading カラー・パレッ

ト, 103
SPI, 185
TekLink, 68
Temperature Grading カラー・パ

レット, 103
Trig'd ステータス・ライト, 78
Undo Last Autoset（直前のオー

トセットを元に戻す）, 37
V Bar カーソル, 136
Wave Inspector, 110
X-Y-Z 表示フォーマット, 98
X-Y 表示フォーマット, 98
Y-T 表示フォーマット, 98

あ
アクイジション

サンプリング, 37
入力チャンネルとデジタイ

ザ, 37
アクイジションの停止, 43
アクイジションの開始, 43
アクイジション・モード

定義, 40
変更, 42

アクセサリ, 1
アプリケーション・ソフトウェ

ア, 179

い
イベント時の電子メール

設定, 93
印刷, 178
インタフェース・マップ, 22

う
ウィンドウ・トリガ

定義, 76

え
エクスポート を参照 保存
エッジ・トリガ

定義, 76
エラー・ディテクタ, 146
演算

色, 104
エディタ, 140
任意フィルタ, 141
波形, 140

エンベロープ・アクイジション・
モード, 40

お
オブジェクト

表示, 102
オペレーティング・システムのリ

ストア, 14
オンライン・ヘルプ, 28
オートスクロール, 107, 109
オートセット, 36
オート・トリガ・モード, 72
オーバーレイ・フレーム, 64

か
外部のクリーニング, 190
拡張デスクトップ, 11, 184
カップリング

トリガ, 73
可変パーシスタンス, 97
関連マニュアル, xvi
カーソル測定, 136
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き
機器設定

保存, 170
呼び出し, 171

基準レベル, 135

く
グリッチ

トリガ, 73
取り込み, 40, 46, 181

グリッチ・トリガ
定義, 76

クリーニング, 190

け
検索, 112, 113, 115
ゲート, 132
ゲート幅と分解能帯域幅, 145

こ
高輝度サンプル

波形の表示, 96
校正, 31
高速アクイジション, 46, 181
後部パネル・マップ, 19
コピー, 176
コミュニケーション

測定, 131
トリガ、定義, 77

コントロール・パネル, 16
コントロール・パネル・マップ, 24

さ
再生, 111
再生／停止ボタン, 111
再生／停止モード, 111
サンプリング

等価時間, 38
補間リアルタイム, 38
リアルタイム, 38

サンプリング処理
定義, 37

サンプル取り込みモード, 40

し
時間測定, 129
仕様

電源, 6
動作時, 3

詳細測定, 130
使用例, 181
ショートカット・メニュー, 29
シリアル, 185
シリアル・エラー・ディテク

タ, 146
シリアル・マスク・テスト, 152
シングル・シーケンス, 43
信号入力, 33
診断, 30
振幅測定, 129
シーケンス・トリガ, 79

す
垂直位置, 34
垂直位置とオートセット, 37
水平位置

演算波形, 142
定義, 34

水平スケール
演算波形, 142

水平遅延, 95
水平マーカ, 106
水平モード

選択, 43
スクリーン・ショット

保存, 165
スクリーン・テキスト, 100
ステート・トリガ

定義, 76
スナップショット, 133, 134
スペクトラム演算式

高度, 144
スペクトラム解析, 143
ズーム, 104, 110

ノブ, 110
目盛サイズ, 111

ズームされた波形のスクロー
ル, 109

ズームされた波形のロック, 109
ズームした波形のスクロー

ル, 107
ズームした波形のロック, 107
ズーム目盛のサイズ, 105

せ
セキュリティ・ロック, 10
セグメント化されるメモリ, 47, 62
設置 , 1
セットアップ / ホールド・トリガ

定義, 77

前面パネル・マップ, 16

そ
測定, 127

確度, 37
カスタマイズ, 132
カーソル, 136
基準レベル, 135
コメント, 134
スナップショット, 133, 134
定義, 129
統計, 133
保存, 172

側面パネル・マップ, 19
ソフトウェア

オプショナル, 179
最新のリリース, 191
バージョン, 191

た
帯域幅拡張, 47
帯域幅制限, 49
タイムアウト・トリガ

定義, 76
タイムスタンプ

保存, 175
タイム・スタンプ, 64

定義, 62
ターミネーション電圧, 49

ち
遅延トリガ, 73, 79
直線補間法, 99

て
定義済み演算式, 140
定義済みスペクトラム演算

式, 143
停止, 111
ディスプレイ・マップ, 22
デジタル波形

保存, 169
デジタル波形の保存, 169
デジタル・チャンネル

アナログ特性, 61
信号入力, 51
セットアップ, 52

デフォルト設定, 35
デュアル・モニタ, 11
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電源, 6
取り外し, 9

電源の遮断, 8
電源の投入, 6
電源の取り外し, 9

と
統計, 133
動作仕様, 3
ドット

波形レコード・ポイントの表
示, 96

トランジション・トリガ
定義, 76

トリガ
強制, 72
概念, 72
B イベント・スキャン, 82
MultiScope トリガ, 68
カップリング, 73
シリアル・バス, 185
シリアル・バス, 88
ステータス, 78
スロープ, 73
トリガ時の電子メール, 92
パラレル・バス, 85, 185
ビジュアル・トリガ, 89
プリトリガ, 72, 73
ポストトリガ, 72, 73
ホールドオフ, 72
モード, 72
リードアウト, 78
レベル, 73

トリガ位置, 81
トリガ時の電子メール, 92
トリガの強制, 72
トリガ・イベント

定義, 72
トリガ

タイプ, 76
トリガ・タイプの選択, 74
トリガ・レベル・マーカ, 102

な
長いレコード長

管理, 110

に
日時, 102
入力検査, 30

ね
ネットワーク接続, 10

の
ノブ

ズーム, 110
パン, 111

ノーマル・トリガ・モード, 72

は
ハイレゾ・アクイジション・モー

ド, 40
波形

解析, 127
カーソル, 136
検索とマーク, 112
再生, 111
再生／停止, 111
ズーム, 110
停止, 111
パン, 110, 111
表示スタイル, 96
保存, 166
ユーザ・マーク, 112
呼び出し, 168

波形データベース・アクイジショ
ン・モード, 40

波形の解析, 127
波形レコード

定義, 39
バス, 185

シリアル・バスのセットアッ
プ, 54

設定, 57
バスのセットアップ, 53
パラレル・バスのセットアッ

プ, 56
パターン・トリガ

定義, 76
パターン・ロック・トリガ, 76
幅トリガ

定義, 76
パラレル, 185
パン, 110, 111

ノブ, 111
パーシスタンス

表示, 97
ハード・コピー, 178

ひ
ビジュアル・トリガ, 89
ヒストグラム

保存, 174
ヒストグラムの測定値, 130
ヒストグラムの設定, 138
ビデオ

ライン, 187
ビデオ・トリガ, 186

定義, 76
定義された, 77

表示
colors, 104
オブジェクト, 102
スタイル, 96
パーシスタンス, 97

ピンポイント・トリガ, 72
トリガ

選択, 76
ピーク検出アクイジション・モー

ド, 40

ふ
フィルタの追加

ユーザが定義可能な, 141
不規則ノイズ, 40
複数ズーム・エリア, 106
プリトリガ, 72, 73
プローブ

P6616 型, 200
TPP0500, 192
TPP1000, 192

へ
平均アクイジション・モード, 40
ベクトル

波形の表示, 96
ヘルプ, 28

ほ
方法

管理、長いレコード長の波
形, 110

検索およびマーク追加、波
形, 112

使用、MagniVu, 60
使用、Wave Inspector, 110

補間, 39, 99
ポストトリガ, 72, 73
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保存
画面表示, 165
設定, 170
測定, 172
タイムスタンプ, 175
波形, 166
ヒストグラム・データ, 174
マスク, 173

ボタン
D15 - D0, 60
再生／停止, 111
マークの設定／クリア, 113

ま
マスク

オートセット, 153, 155
オートフィット, 153
パス／フェイル・テスト, 154
保存, 173
マージン公差, 154

マスク・テスト, 152
マニュアル, xvi
マーク, 112, 113, 115

み
右クリック・メニュー, 29

む
無限パーシスタンス, 97

め
メイン・トリガ, 73, 79
メニュー, 29
目盛スタイル, 101

ゆ
ユーザ設定, 37
ユーザ定義のカラー・パレッ

ト, 103
ユーザ・マーク, 112

よ
呼び出し

設定, 171
波形, 168

ら
ラベル

スクリーン・テキスト, 100
デジタル・チャンネル, 52
バス, 53

ラント・トリガ
定義, 76

り
リファレンス波形のカラー, 104
リミット・テスト, 156
リモート表示, 10
リードアウト

トリガ, 78

れ
例, 181
レコードの表示パレット, 103

ろ
ロジック・アナライザ

データの相関, 189
ロック、標準ラップトップ, 10
ロール・モード, 50
ロール・モードの相互操作, 50
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